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INTRODUCTION

Thank you for choosing this Icom product. This product is designed and built with Icom’s state of the art technology
and craftsmanship. With proper care, this product should provide you with years of trouble-free operation.
This product combines traditional analog technologies with Digital Smart Technologies for Amateur Radio
(D-STAR), for a balanced package.

ABOUT THE CONSTRUCTION OF THE MANUAL

(As of November 2021)

You can use the following manuals to understand and operate this transceiver.

LLIf necessary, you can download a glossary of HAM radio terms from the Icom website.

TIP: You can download each manual and guide from the Icom website:
https://www.icomjapan.com/support/
Enter “ID-52A” or “ID-52E” into the Search box on the site.
Basic manual (Comes with the transceiver)

CI-V Reference Guide (PDF type)

Instructions for the basic operations and precautions.
D-STAR GUIDE that explains registering your call sign
to a gateway repeater and D-STAR’s basic operations
is also included.

Describes the control commands used in remote
control operation (serial communication using CI-V).
About the DV Gateway function (PDF type)
Instructions for the system requirements or operations
to use the DV Gateway function.

Advanced manual (This manual)
•• Attaching accessories
•• Using a microSD card
•• Battery charging
•• FM Radio operation
•• D-STAR operation (ADVANCED)
•• GPS operation (ADVANCED)
•• VOICE TX function
•• Recorder function
•• Memory operation
•• Scan operation
•• Repeater and duplex operations
•• SET mode
•• Bluetooth® operation
•• Share Pictures function
•• Other functions
•• Updating the firmware
•• Options

Updating the repeater list (PDF type)
Instructions for the steps to update the repeater list.
Using the GPS Logger function (PDF type)
Instructions for operating the GPS Logger function
that saves location data from a GPS receiver onto a
microSD card as a log.

TRADEMARKS
Icom, Icom Inc. and the Icom logo are registered trademarks of Icom Incorporated (Japan) in Japan, the United States, the
United Kingdom, Germany, France, Spain, Russia, Australia, New Zealand, and/or other countries.
The Bluetooth word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and any use of such marks by
Icom Inc. is under license. Other trademarks and trade names are those of their respective owners.
Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.
APRS® is a registered trademark of Mr. Bob Bruninga in the U.S.A. and other countries.
Microsoft and Windows are trademarks of the Microsoft group of companies.
Google, the Google Logo, Google Play, the Google Play logo, Android, and the Android logo are trademarks of Google, LLC.
IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.
iPadOS is a trademark of Apple Inc.
App Store is a service mark of Apple Inc.
All other products or brands are registered trademarks or trademarks of their respective holders.
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FUNCTIONS AND FEATURES OF ADOBE® ACROBAT® READER®
The following functions and features can be used with Adobe Acrobat Reader.
•• Keyword search
Click “Find” (Ctrl+F) or “Advanced
Search” (Shift+Ctrl+F) in the Edit
menu to open the search screen.
This is convenient when searching
for a particular word or phrase in this
manual.

•• Find screen

•• Advanced search screen

LLThe menu screen may differ,
depending on the Adobe Acrobat
Reader version.

Click to open the find or
search screen or advanced
search screen.

•• Read Out Loud feature.
The Read Out Loud feature reads aloud the text in
this PDF.
Refer to the Adobe Acrobat Reader Help for the
details.
(This feature may not be usable, depending on your
PC environment, including the operating system.)

•• Printing out the desired pages.
Click “Find (Ctrl+F)” or “Advanced Search
(Shift+Ctrl+F)” in the Edit menu to open the search
screen.
This is convenient when searching for a particular
word or phrase in this manual.

LLThe menu screen may differ, depending on the Adobe
Acrobat Reader version.
LLSelect the “A4” size to print out the page in the original
manual size.

LLThe screen may differ, depending on the Adobe Acrobat Reader version.
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ENTERING AND EDITING TEXT
Controls used for text entry

To change the character type
1. When not selecting text, or an entered text is
selected, push [QUICK].
2. Rotate [DIAL] to select the character type, and
then push [ENT].

[DIAL] (Rotate)

Selects a character

Selects the character
Cancels

Clears

Moves the cursor
to the left

Moves the cursor to
the right
[ENT] Opens the
Sets character

Opens the Entry
Select window

•• To insert a text, move the cursor to a place to enter,
and then rotate [DIAL] or push D-pad().
•• To clear a character, push [CLR].
•• To consecutively clear characters, continuously
hold down [CLR].

Character
type

Selectable characters and
symbols

Character
conversion

ABC

A to Z, 0 to 9, (space)

A/a

abc

a to z, 0 to 9, (space)

A/a

123

0 to 9, (space)

–

!”#

!“#$%&’()*+,-./:;<=>
? @ [ \ ] ^ _ ` { | } ˜ (space)

–

TIP: When the character type is “ABC” or “abc,” and
while entering a character, push [QUICK] to select
upper case or lower case letters.

Push [QUICK]
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USABLE CHARACTERS
The usable characters and symbols and the maximum characters differ, depending on the item.
See the following list for details.
LLThe usable characters and symbols for each character type are described at the bottom of the page.
Category
FM Radio Memory
Memory CH
Call CH
Your Call Sign

Repeater List

GPS TX Mode

GPS Memory

Item

Character type

Group Name

[ABC] [abc] [123] [!”#]

Maximum
characters
16

Name

[ABC] [abc] [123] [!”#]

16

–

Group name

[ABC] [abc] [123] [!”#]

16

–

Name

[ABC] [abc] [123] [!”#]

16

–

Information
–

Name

[ABC] [abc] [123] [!”#]

16

Name

[ABC] [abc] [123] [!”#]

16

–

Call Sign

A to Z, 0 to 9, /, (space)

8

–

Group Name

[ABC] [abc] [123] [!”#]

16

–

Name

[ABC] [abc] [123] [!”#]

16

–

Sub Name

[ABC] [abc] [123] [!”#]

8

–

Call Sign

A to Z, 0 to 9, /, (space)

8

–

GW Call Sign

A to Z, 0 to 9, /, (space)

8

–

Unproto Address

[ABC] [abc] [123] [!”#]

56

Normally 12 characters
(API52,DSTAR*)

Comment

[ABC] [abc] [123] [!”#]

43

The number of characters you can
enter differs, depending on the data
extension and altitude settings.

Object Name/
Item name

[ABC] [abc] [123] [!”#]

9

–

GPS Message

[ABC] [abc] [123] [!”#]

20

–

Group Name

[ABC] [abc] [123] [!”#]

16

–

Name

[ABC] [abc] [123] [!”#]

16

–

P-Scan Edge

Name

[ABC] [abc] [123] [!”#]

16

–

Program Link

Program Link name

[ABC] [abc] [123] [!”#]

16

–

UR

A to Z, 0 to 9, /, (space)

8

–

R1

A to Z, 0 to 9, /, (space)

8

–

R2

A to Z, 0 to 9, /, (space)

8

–

My Call Sign

Call Sign

A to Z, 0 to 9, /, (space)

12 (+1)

My Station

TX Message

[ABC] [abc] [123] [!”#]

20

–

DTMF Memory

DTMF code

0 to 9, A, B, C, D, *, #

24

–

Save Setting

[ABC] [abc] [123] [!”#]

23

Illegal characters:
/:;*<>

Export

[ABC] [abc] [123] [!”#]

23

Illegal characters:
/:;*<>
Excluding “ICOM BT”

CS screen

SD Card
Bluetooth
DR screen

Includes “/” between the Call sign
and Memo field.

Device Name

[ABC] [abc] [123] [!”#]

9

Direct Input (UR)

A to Z, 0 to 9, /, (space)

8

–

Direct Input (RPT)

A to Z, 0 to 9, /, (space)

8

–

[ABC]: A to Z, 0 to 9, (space)
[abc]: a to z, 0 to 9, (space)
[123]: 0 to 9, (space)
[!”#]: ! “ # $ % & ’ ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (space)
iv
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HOW TO ENTER TEXT
Example: Entering “Calling” as a Memory name.
[MENU] > MEMORY > Memory CH
1. Push [MENU].
2. Select “MEMORY” on the second page of the
MENU screen.
3. Select “Memory CH.”
4. Select a channel group where the memory
channel you want to edit is listed.
5. Rotate [DIAL] to select a Memory channel.

11. Rotate [DIAL] to select a character, then push [ENT].

LLInformation

•• To move the cursor forward, push D-pad().
•• To move the cursor backward, push D-pad().
•• To insert a character, move the cursor to a place to
enter, then rotate [DIAL].
•• To clear a character, push [CLR].
•• To consecutively clear characters, continuously hold
down [CLR].
•• When the character type is “ABC” or “abc,” and while
entering a character, push [QUICK] to select upper
case or lower case letters.

6. Push [QUICK].
7. Select “Edit.”

12. Repeat steps 9 ~ 11 to enter a name, and push [ENT].

•• The Edit screen is displayed.

•• Returns to the Edit screen, and the entered name is
displayed.

8. Select “NAME.”

13. Select “<<OverWrite>>.”

•• A confirmation dialog is displayed.

14. Select “YES.”

9. Push [QUICK].
10. Select the character type.

•• The Memory name is overwritten.

LLTo enter symbols, select “!"#.”
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ATTACHING ACCESSORIES
Attaching the antenna����������������������������������������������������������������������������1-2
Attaching and detaching the battery�������������������������������������������������������1-2
Attaching and detaching the belt clip������������������������������������������������������1-3
Attaching the hand strap������������������������������������������������������������������������1-3
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ATTACHING ACCESSORIES

Attaching the antenna

Attaching and detaching the battery

Insert the antenna into the base of the SMA antenna
connector and tighten the antenna.

To attach or detach the battery pack or battery case,
see the illustrations below. See page 3-8 for battery
case details.

LLWhen attaching the battery case, slide it, and press firmly
until it is fixed with both latches.
LLWhen detaching the battery case, turn OFF the
transceiver.

TIP: Third-party high gain antennas may increase
transceiver performance. The optional AD-92SMA
antenna connector adapter enables you to use
antennas with a BNC connector. (p. 17-2)

To attach

To detach

Antenna

2

1

1

1
2

Battery pack or
battery case
NOTE:
•• Even when the transceiver is turned OFF, a small
current still flows in the transceiver. When not
using the transceiver for a long time, remove the
battery pack or case to prevent the batteries from
becoming exhausted.
•• The battery protection function automatically
reduces power to Low1 power (0.5 W) when the
temperature is around 0°C (32°F) or below. In
addition, High, Mid, and Low2 power selections
are disabled.
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ATTACHING ACCESSORIES

Attaching and detaching the belt clip

Attaching the hand strap

To attach or detach the belt clip, first remove the
battery pack or case, if it is attached. (p. 1-2) See
the illustration below.
To attach the belt clip, slide the belt clip in the
direction of the arrow until the belt clip locks in place,
and makes a ‘click’ sound.
To detach the belt clip, lift the tab up (1) and slide the
belt clip in the direction of the arrow (2).

Slide the hand strap through the loop on the top of the
rear panel, as illustrated below.

To attach

To detach

Hand strap

q
w

Tab
Belt clip
Battery pack or
battery case

RRWARNING! NEVER swing the transceiver by
holding the hand strap. This could cause injury to
yourself or others.
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Section 2

USING a microSD CARD

NOTE: See the Basic manual
Section 6 for details on how to
insert or remove a microSD card
and precautions.

About data saved on a microSD card�����������������������������������������������������2-2
Saving settings onto a microSD card�����������������������������������������������������2-2
DD Saving as a new file�����������������������������������������������������������������������������������2-2

Saving with a different file name�������������������������������������������������������������2-3
Loading the saved files on the microSD card�����������������������������������������2-4
Backing up data saved on the microSD card onto a PC������������������������2-5
DD About the microSD card’s folder�����������������������������������������������������������������2-5
DD Making a backup file on your PC����������������������������������������������������������������2-6

Importing or exporting a CSV format file������������������������������������������������2-7

DD Importing����������������������������������������������������������������������������������������������������2-7
DD Exporting����������������������������������������������������������������������������������������������������2-8

About the SD Card mode�����������������������������������������������������������������������2-9
Check the free space and the recording time on the microSD card�����2-10
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USING a microSD CARD

About data saved on a microSD card
The following data can be saved onto the card:
•• The transceiver’s settings
•• Communication/receive log and contents
•• Automatic answering voice audio in the DV mode
•• Voice audio for the Voice TX function
•• Voice recorder
•• Captured screens
•• Memory channel contents
•• FM Radio memory

•• Your (UR) call sign memory
•• Repeater List
•• GPS memory
•• Position data from the GPS receiver
•• Pictures for the Share Pictures function
•• Transmitted and received log of Share Picture
•• Pictures for the Opening Picture setting

Saving settings onto a microSD card
The Memory channels, settings on the MENU screen,
and the Repeater List can be saved on a microSD
card.
Saving data on the card enables you to easily restore
the transceiver to its previous configuration, even if
you perform an All Reset.
You can save settings data as a new file, or you can
overwrite a current file.

5.	 Push [ENT].

DSaving
D
as a new file

6.	 Select “YES.”

•• The confirmation screen is displayed.

[MENU] > SET > SD Card > Save Setting
1.	 Push [MENU].
2.	 Select “SD Card” in the “SET” menu.
•• While saving, a progress bar is displayed. When saving
is completed, the SD CARD screen is displayed.
LLTo exit the MENU screen, push [MENU].

Overwriting a current file:
To overwrite data in a current file, select the file you
want to overwrite in step 4 to the left.

3.	 Select “Save Setting.”

4.	 Select “<<New File>>.”
TIP:

•• Data is saved in the “icf” file format. You can copy the icf
data on a PC and edit it using the CS-52 programming
software.
•• If “Save Form” is set to the earlier firmware version, the
confirmation window is displayed after step 4. To save
the data in the earlier firmware version, select “YES.”

•• The file is named in the following format:
Setyyyymmdd_xx
(yyyy: Year, mm: month, dd: day, xx: file number).
LLTo change the file name, see page 2-3.
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USING a microSD CARD

Saving with a different file name
[MENU] > SET > SD Card > Save Setting
1.	 Push [MENU].
2.	 Select “SD Card” in the “SET” menu.

3.	 Select “Save Setting.”

4.	 Select “<<New File>>.”

5.	 Hold down [CLR] to delete the characters.

6.	 Enter a file name, and then push [ENT].

LLSee page iii on how to enter characters.

7.	 Select “YES.”

•• While saving, a progress bar is displayed. When saving
is completed, the SD CARD screen is displayed.
LLTo exit the MENU screen, push [MENU].
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Loading the saved files on the microSD card
The saved Memory channels, settings on the MENU
screen, and Repeater List can be copied to the
transceiver.
This makes it easy to copy Memory channels or the
Repeater List, to another ID-52A/ID-52E and operate
with the same data.

6.	 Select “YES” or “NO.”

NOTE: Saving the current data is recommended
before loading other data into the transceiver.

•• YES:
The skip settings of the Repeater List are
retained.
•• NO:
The skip settings of the Repeater List are
cleared.
7.	 Select “YES.”

Example: L
 oading all the data in the
“Set20211101_01” file
[MENU] > SET > SD Card > Load Setting
1.	 Push [MENU].
2.	 Select “SD Card” in the “SET” menu.

3.	 Select “Load Setting.”

•• Starts checking and loading the data file.
•• After loading, “COMPLETED!” is displayed.

4.	 Select a data file to load into the transceiver.
8.	 Restart the transceiver to operate with the new
setting.

5.	 Select the loading content.

•• ALL:
Loads all Memory channels, settings on the
MENU screen, and the Repeater List into the
transceiver.
•• Except My Station:
Loads all Memory channels, setting on the
MENU screen except MY call signs, and the
Repeater List into the transceiver.
•• Repeater List Only:
Loads only the Repeater List into the transceiver.
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USING a microSD CARD

Backing up data saved on the microSD card onto a PC
A backup file enables easy restoration, even if the
data on the microSD card is accidentally deleted.

•• GpsMemory folder
The GPS Memory in the “csv” format.

DAbout
D
the microSD card’s folder

•• MemoryCh folder
The Memory channel contents in the “csv” format.

The folder in the microSD card contains the following:

ID-52

•• RadioMemory folder
The FM Radio memory contents in the “csv” format.

Capture

GpsMemory

•• RptList folder
The Repeater List in the “csv” format.

Csv

MemoryCh

•• YourMemory folder
The Your (UR) call sign memory in the “csv” format.
•• Gps folder
The GPS logging data in the “log” format.

RadioMemory

•• OpeningPicture folder
The pictures in the “bmp” format that are used for
the Opening Picture setting.

RptList

Gps

YourMemory

•• Picture folder
The pictures in the “jpg” format that are used with
the Share Pictures function.

OpeningPicture

Picture

Private

QsoLog

Rx

•• Private folder
The RX Picture History and TX Picture History.

Tx

•• Rx folder
The RX Picture History in the “dat” format.

LLThe RX Picture History contents are not displayed on
the PC.

Reply

•• Tx folder
The TX Picture History in the “dat” format.

LLThe TX Picture History contents are not displayed on
the PC.

RxLog

•• QsoLog folder
The QSO log data in the “csv” format.

Setting

Voice

•• Reply folder
The automatic reply data in the “wav” format.

yyyymmdd

yyyymmdd

•• RxLog folder
The RX record log data in the “csv” format.

VoiceRec

yyyymmdd

•• Setting folder
The transceiver’s setting data in the “icf” format.

VoiceTx

yyyymmdd

•• Voice folder
The recorded QSO audio date folders.
•• VoiceRec folder
The recorded Voice recorder audio date folders.

•• ID-52 folder
The folders created in the transceiver are contained
in this folder.
•• Capture folder
The captured screen data in the “png” or “bmp”
format.

•• yyyymmdd folder
The recorded QSO audio data and the recorded
Voice recorder audio data is saved in the “wav”
format.

•• Csv folder
The Repeater List, Your (UR) call sign memory,
GPS Memory folders, and so on.

•• VoiceTx folder
The recorded voice audio data for the Voice TX
function in the “wav” format.
2-5
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Backing up data saved on the microSD card onto a PC

DMaking
D
a backup file on your PC
Windows® 10 is used for these instructions.

5.	 Open a folder to copy a backup file, then rightclick, and then click “Paste.”

1.	 Insert the microSD card into the microSD card
drive or a memory card reader on your PC.
2.	 Click the “Open folder to view files” option to
access the card.

		(Example: Copying into the “Backup” folder on the
C drive)
		

•• Copies the card data onto your PC.

Click
Click
•• ‘ID-52’ folder is displayed.

3.	 Right-click “Removable disk.”
4.	 Click “Copy.”
6.	 To remove the card, click the remove media icon
(“ ” in the screenshot shown below) in the
taskbar. Then, click “Eject Removable Disk.”
Right-Click

Click

7.	 When “Safe To Remove Hardware” is displayed,
remove the card.
Click

TIP: When “USB Connect” is set to “SD Card Mode,”
and the transceiver is connected to the PC through a
USB data cable, you can directly access the microSD
card that is set in the transceiver from the PC.
([MENU] > SET > Function > USB Connect)
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Importing or exporting a CSV format file
Read this section before importing or exporting a
Comma Separated Values (CSV) format file from the
microSD card.
You can import or export the following data:

6.	 Select the CSV file to import.

•• Memory CH
•• FM Radio Memory
•• Your Call Sign
•• Repeater List
•• GPS Memory

•• The confirmation dialog is displayed.

DImporting
D

TIP: When importing a Repeater List, “Keep
‛SKIP’ settings in Repeater List?” is displayed.
See step 6 on page 2-4 for details.

NOTE:

•• Before importing, make a backup file of all the
transceiver’s data to the card in case of data loss.
•• The transceiver cannot display files that have a file
name 24 or more characters. If necessary, rename
them using 23 characters or less. When exporting CSV
format files using the CS-52, BE SURE the names are
23 characters or less.

7.	 Select “YES.”

Example: Importing the Your Call sign memory.
[MENU] > SET > SD Card > Import/Export > Import
•• Starts importing.
•• After importing ends, “COMPLETED!” is displayed.

1.	 Push [MENU].
2.	 Select “SD Card” in the “SET” menu.

8.	 To complete importing, restart the transceiver.
3.	 Select “Import/Export.”

4.	 Select “Import.”

5.	 Select “Your Call Sign.”
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USING a microSD CARD

Importing or exporting a CSV format file

DExporting
D

6.	 Select “<<New File>>.”

Saving as a new file:
Example: Exporting the Your Call sign memory.
[MENU] > SET > SD Card > Import/Export > Export
1.	 Push [MENU].
2.	 Select “SD Card” in the “SET” menu.
•• Displays the FILE NAME screen.
LLThe file is named in the following format:
Your*yyyymmdd_xx
(yyyy: Year, mm: month, dd: day, xx: file number).
* When you select the other items, each file is named
as shown below.
Memory CH:
“Mch”
FM Radio Memory: “Radio”
Repeater List:
“Rpt”
GPS Memory:
“Gps”

3.	 Select “Import/Export.”

LLSee page iii on how to enter characters.

7.	 Push [ENT].
4.	 Select “Export.”

•• The confirmation dialog is displayed.

8.	 Select “YES.”
5.	 Select “Your Call Sign.”

•• Exports the setting data.
LLTo exit the MENU screen, push [MENU].

Overwriting the current file:
When you overwrite data in a current file, select the
file you want to overwrite in step 6 to the left.
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USING a microSD CARD

About the SD Card mode
When “USB connect” is set to “SD Card Mode,” and
the transceiver is connected to the PC through a USB
data cable, you can transfer the files between the
micoSD card set in the transceiver and a PC.
You can back up the setting data and recording data
saved on the microSD card to a PC, and save the
image data for the Share Pictures function and the
firmware data to the microSD card without inserting or
removing it.

NOTE: Before connecting the transceiver in the SD
Card mode to a PC with a USB cable, a microSD
card must be inserted.
LLIf the microSD card is not inserted, insert it with the
transceiver turned OFF, and then reconnect the USB
cable.

TIP: In the SD Card mode, the transceiver works
not as a transceiver but as a data storage device. It
temporarily stops some functions as follows:
•• Stops recording
•• Pauses the GPS Logger function and the RX History
Log function
•• Disconnects a Bluetooth device
•• Disables the Auto Power OFF function

[MENU] > SET > Function > USB Connect
1.	 Connect the transceiver to a PC using a USB
cable.
2.	 Push [MENU].
3.	 Select “Function” in the “SET” menu.
4.	 Select “USB Connect.”

To exit the SD Card mode

LLThis instruction manual is based on Windows 10.

1.	 Click “ ” in the task tray.
2.	 Click “Eject Device.”
3.	 After “Safe to Remove Hardware” is displayed,
remove the USB cable from the PC.

5.	 Select “SD Card Mode.”

•• The confirmation dialog is displayed.

6.	 Select “Yes.”
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USING a microSD CARD

Check the free space and the recording time on the microSD card
[MENU] > SET > SD Card > SD Card Info
1.	 Push [MENU].
2.	 Select “SD Card” in the “SET” menu.
3.	 Select “SD Card Info.”

•• The free space and the recording time on the
microSD card are displayed.
LLTo exit the MENU screen, push [MENU].
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BATTERY CHARGING
Battery information���������������������������������������������������������������������������������3-2
DD Battery life��������������������������������������������������������������������������������������������������3-2
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Battery information
DBattery
D
life

DBattery
D
icon

The approximate battery life (operating time) as
shown below is calculated under the following
assumptions:
•• Power save setting: Auto (Short)
•• Duty cycle: TX : RX : Standby = 1 : 1 : 8
(based on operating style)

The “
” battery icon is displayed when the battery
pack is attached to the transceiver.
Icon

Battery status
The battery is being charged.
The battery has sufficient capacity.

The approximate battery life:
Battery pack

FM mode

BP-271

4.25 hours

BP-272

7.25 hours

BP-307

12 hours

The battery is exhausted a little.
(green)

The battery is nearing exhaustion.
The battery is almost fully exhausted.

LLSee page 3-8 for the optional BP-273 battery
case battery life.

(red)

NOTE: BE SURE to replace the battery pack with
a new one approximately five years after purchase,
even if it still holds a charge. The material inside the
battery cells will become weak after a period of time,
even with little use.
The estimated number of times you can charge the
pack is between 300 and 500. Even when the pack
appears to be fully charged, the operating time of the
transceiver may become short when:
•• Approximately five years have passed since the
pack was manufactured.
•• The pack has been repeatedly charged.

No icon

LLImmediately charge the battery pack.
Otherwise, the icon will soon start
blinking, “LOW BATTERY” will be
displayed, and the transceiver will
automatically turn OFF.

When an external DC power supply (12
V DC) is connected, the battery is not
being charged because:
•• The battery is completely charged.
•• “Charging (Power ON)” is set to “OFF.”

LLThe battery icon for the BP-273 cannot display the
capacity of the alkaline batteries. The battery icon always
displays “
,” and it does not reflect with the true battery
capacity.

To display the correct battery status
Select the attached battery pack in the following
item. (Default: BP-271/BP-272)

TIP: Keep the battery terminals clean. It’s a good
idea to clean them occasionally.

([MENU] > SET > Function > Battery Pack Select)

To display the Battery Pack Select dialog every time you
attach the battery pack, set the following item to “ON.”
([MENU] > SET > Function > Battery Pack Confirmation)
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Charging information
NOTE:
•• Prior to using the transceiver for the first time, the
battery pack must be fully charged for optimum
life and operation.
•• BE SURE to turn OFF the transceiver while
charging with the supplied battery charger.
Otherwise, the battery pack will not charge.
” and
LLWhile charging, the charging icon “
“Charging....” are displayed.
LLThe icon and “Charging....” disappear when the
battery pack is fully charged.

DCharging
D
through the [DC IN] jack

To charge the battery pack:

The approximate battery life (operating time) as
shown below is calculated under the following
assumptions:
•• When using the optional CP-12L or OPC-254L, the
battery pack can be charged with the power ON.
(p. 3-7)

•• Use the supplied battery charger or optional cable.
•• Use a USB cable (User supplied). (p. 3-4)
•• Use the optional rapid charger. (p. 3-6)

Charging note
•• CAUTION: BE SURE to attach the battery pack
before connecting the DC cable.
•• Turn OFF the transceiver when using the BC-167S.
•• DO NOT charge the fully charged battery pack.
This may cause a shorter battery life.

LLTo connect, see the illustration below.

•• The BP-273 battery case has no charging capability
or socket.
Approximate charging time
•• BP-271: 3 hours
•• BP-272: 5 hours
•• BP-307: 8 hours
BC-167S*1

To an AC outlet
CP-12L

To [DC IN]
Turn OFF*2

To a cigarette
lighter socket
(12 V DC)
OPC-254L

To a 12 V DC
power source
*1 The shape is different, depending on the version.
*2 When using the BC-167S, turn OFF the transceiver.

Black:		_
White: +
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Charging information

DCharging
D
with a USB cable

You can charge the battery pack with a USB cable (micro B type) while operating the transceiver.

Power adapter
or external battery
(User supplied)

USB cable
To the [USB] port

To a USB port
PC,
Mobile device

TIP:

NOTE:
•• BE SURE to attach the battery pack to the transceiver.
•• To use a mobile device or a PC as an external power
source, set the following item to “ON” (default).
([MENU] > SET > Function
> USB Power Input (Phone, Tablet, PC))
•• The battery pack is used as a power source while
transmitting, even when an external power source is
connected.
Therefore, you cannot transmit if the battery pack is
exhausted.
•• You may not be able to charge:
- Depending on your USB cable or power adapter.
- When using a USB hub or connecting to a low output
USB port.
•• Charging time may differ, depending on the USB port.
•• The S-meter may appear, or the noise may occur, due
to the influence of the USB power supply’s noise.
In that case, unplug the USB cable to disconnect the
transceiver from the USB power supply.
•• When operating the transceiver while charging, the
charging may not be sufficient, and the battery pack
may be consumed, depending on the power adapter.

•• When a USB cable is connected, the charging is
stopped when the battery is fully charged.
After that, the charging will resume when a certain
amount of capacity is consumed while connecting the
USB cable.
•• You can change the operation when the transceiver is
connected to a PC through a USB cable.
([MENU] > SET > Function > USB Connect)
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Charging with the BC-202IP2 optional rapid charger
The optional BC-202IP2 rapidly charges a battery
pack.
LLWhen about 90% of the battery capacity is charged,
the BC-202IP2 stops charging and the charging
indicator lights green. Therefore, the battery life
will be a little shorter than when charging with the
transceiver.

Charging note
RRDANGER! NEVER use a battery pack that is not
manufactured or approved by Icom.
•• CAUTION: DO NOT connect anything to the
[DC IN] jack or the [USB] port on the side of the
transceiver when placing the transceiver to the
rapid charger. This may cause the charger’s
malfunction. If the charging indicator blinks
orange, disconnect the power adapter from the
charger, and then reconnect it.
•• BE SURE to turn OFF the transceiver. When the
transceiver power cannot be turned OFF because
of the battery exhaustion, detach the battery pack
from the transceiver. Then charge the battery pack
by itself.
•• The BC-202IP2 rapid charger can only charge
the BP-271, BP-272, or BP-307 Li-ion battery
pack. Other types of rechargeable batteries, NiCd, or Ni-MH cannot be charged.
•• If the charging indicator blinks orange, there may
be a problem with the battery pack or charger.
Contact your dealer if you have problems charging
a new battery pack.

Approximate charging time
•• BP-271: 1.5 hours
•• BP-272: 2.5 hours
•• BP-307: 4 hours

LLThese are the time when the battery is exhausted, and
charging with the transceiver power off.

The following item is required.
•• BC-123S (L-shaped type plug)
(A different type, or no power adapter is supplied,
depending on the charger versions.)

Transceiver + battery pack
Battery pack
BP-271, BP-272, or BP-307

AC outlet

Guide
rail

Turn OFF

Tabs

Screws
(Self-tapping screws: 3.5 × at least 30 mm)
Purchase separately. Using screws is
recommended to secure the charger.

BC-123S
(L-shaped type plug)
The CP-23L or OPC-515L
can also be used instead
of the power adapter.

BC-202IP2

Charging indicator

•• Lights orange: While charging
•• Lights green: Charging is completed.
•• Blinks orange: A charging error has occurred.
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Charging with the BC-202IP3L optional rapid charger
The optional BC-202IP3L rapidly charges a battery
pack.
LLWhen about 90% of the battery capacity is charged,
the BC-202IP3L stops charging and the charging
indicator lights green. Therefore, the battery life
will be a little shorter than when charging with the
transceiver.

Charging note
RRDANGER! NEVER use a battery pack that is not
manufactured or approved by Icom.
•• CAUTION: DO NOT connect anything to the
[DC IN] jack or the [USB] port on the side of the
transceiver when placing the transceiver to the
rapid charger. This may cause the charger’s
malfunction. If the charging indicator blinks
orange, disconnect the power adapter from the
charger, and then reconnect it.
•• BE SURE to turn OFF the transceiver. When the
transceiver power cannot be turned OFF because
of the battery exhaustion, detach the battery pack
from the transceiver. Then charge the battery pack
by itself.
•• The BC-202IP3L rapid charger can only charge
the BP-271, BP-272, or BP-307 Li-ion battery
pack. Other types of rechargeable batteries, NiCd, or Ni-MH cannot be charged.
•• If the charging indicator blinks orange, there may
be a problem with the battery pack or charger.
Contact your dealer if you have problems charging
a new battery pack.

Approximate charging time
•• BP-271: 2 hours
•• BP-272: 3 hours
•• BP-307: 5 hours

LLThese are the time when the battery is exhausted, and
charging with the transceiver power off.

The following item is required.
•• BC-123S (straight type plug)

AC outlet

Battery pack
BP-271, BP-272,
or BP-307

Transceiver + battery pack

Turn OFF

BC-123S
(straight type plug)
LLThe CP-25H can also be
used instead of the power
adapter.

BC-202IP3L

Charging indicator

LLTo connect the power adapter to the
charger, remove the charger’s left cover.
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Connecting BC-202IP3L together
You can connect up to 6 BC-202IP3L together.
1.	 Remove the charger’s right cover. (1)
2.	 Snap the DC power plug to the another charger’s
DC power jack. (2)

2

RRWARNING! NEVER connect more than 6
chargers together. It may result in an electric shock,
cause a fire, overheating, or damage the chargers.
RRWARNING! NEVER use other than the BC-228
AC adapter when connecting multiple BC-202IP3L
units. It may result in an electric shock, cause a fire,
overheating, or damage the chargers.

1

External DC power operation
Operating note
•• DO NOT connect over 16 V DC directly into the
[DC IN] jack of the transceiver. The power source
voltage must be between 10.0 V ~ 16.0 V DC.
•• DO NOT transmit at high power for a long period
of time. The transceiver becomes hot, and it may
cause a burn.
•• Use the optional CP-12L or OPC-254L when using
the external DC power.
•• Confirm the correct polarity of the OPC-254L
supply connection. Connect the OPC-254L to an
external power source (user supplied).
•• Use an external DC-DC converter to connect the
transceiver through the optional CP-12L or OPC254L to a 24 V DC power source. Ask your dealer
for details.
•• When the external power is used, the Power Save
function (p. 12-18) is automatically turned OFF.
•• Depending on the external power voltage,
the battery pack may be used to operate the
transceiver, and the battery pack capacity is
consumed.

CP-12L

To a cigarette
lighter socket
(12 V DC)
To [DC IN]

OPC-254L

To a 12 V DC
power source
Black:		_
White: +

CAUTION: BE SURE to attach the battery pack
before connecting the DC cable.

TIP: The battery pack can be charged even if the
transceiver is ON when “Charging (Power ON)” is
set to “ON” (default).
This operation may generate certain spurious
signals, and the S-meter may appear, or noise may
be heard.
When you operate the transceiver while charging,
and if you cannot receive signals correctly, set
“Charging (Power ON)” to “OFF.”
([MENU] > SET > Function > Charging (Power ON))

LLThe BC-167S cannot be used for external DC
power operation.
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About the optional battery case
DBattery
D
life

The BP-273 uses three AA (LR6) size alkaline
batteries.
1.	 Remove the battery case top, as shown below.
2.	 Install three AA (LR6) size alkaline batteries.

The approximate battery life (operating time), as
shown below, is calculated under the following
assumptions:
•• Power save setting: Auto (Short)
•• Duty cycle: TX : RX : Stand-by = 1 : 1 : 8
(based on operating style)

LLInstall only alkaline batteries.
LLBE SURE to observe the correct polarity.

3.	 Attach the battery case. (p. 1-2)

The approximate battery life:
FM mode
4.5 hours
LLThe battery life may differ, depending on your
operating style, or the installed alkaline batteries.
BP-273

DAbout
D
the battery replacement

Alkaline battery

When the alkaline batteries are almost exhausted,
“LOW BATTERY” is displayed, and the battery icon
starts to blink. After 10 seconds, the transceiver power
is automatically turned OFF. In that case, replace all 3
batteries with new alkaline batteries.

Batteries cautions
•• When installing batteries, confirm that they are all
the same brand, type, and capacity. Do not mix
new and old batteries together.
•• DO NOT incinerate used battery cells since the
internal battery gas may cause them to rupture.
•• DO NOT expose a detached battery case to
water. If the battery case gets wet, BE SURE to
wipe it dry before using it.
•• DO NOT use batteries whose insulated covering
is damaged.
•• Keep the battery terminals clean. It’s a good idea
to clean them occasionally.
•• Remove the alkaline batteries when the battery
case is not used. Otherwise, the installed alkaline
batteries will be exhausted due to the built-in stepup converter.

LLThe battery icon for the BP-273 cannot display the
capacity of the alkaline batteries. The battery icon always
displays “
,” and it does not reflect with the true battery
capacity.

TIP:
•• A built-in step-up converter in the BP-273
increases the voltage to 5.5 V DC. Approximately
100 mW of output power is possible using the
case. Also, the transmit output power selection is
disabled.
•• The transceiver meets IPX4 requirements
for waterproof protection when the BP-273 is
attached.
•• The batteries may seem to have low capacity
when used in low temperatures, such as –10°C
(+14°F) or below. Keep the batteries warm in this
case.
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Specifications for the battery charger and battery packs
DBP-271
D
Li-ion battery pack (optional)

•• Voltage:			7.4V
•• Discharge Capacity:		
1150 mAh (minimum)
•• Usable temperature range: –20°C ~ +60°C, –4°F ~ +140°F
•• Charging temperature range: 0°C ~ 40°C, 32°F ~ 104°F
•• Storage temperature range:	–20°C ~ +50°C, –4°F ~ +122°F (within a month)
–20°C ~ +35°C, –4°F ~ +95°F (within 3 months)
–20°C ~ +20°C, –4°F ~ +68°F (within a year)
•• Dimensions:			58 (W) × 86.9 (H) × 9.1 (D) mm, 2.3 (W) × 3.4 (H) × 0.4 (D) inches
(projections are not included)

DBP-272
D
Li-ion battery pack (supplied)

•• Voltage:			7.4V
•• Discharge Capacity:		
1880 mAh (minimum)
•• Usable temperature range: –20°C ~ +60°C, –4°F ~ +140°F
•• Charging temperature range: 0°C ~ 40°C, 32°F ~ 104°F
•• Storage temperature range:	–20°C ~ +50°C, –4°F ~ +122°F (within a month)
–20°C ~ +35°C, –4°F ~ +95°F (within 3 months)
–20°C ~ +20°C, –4°F ~ +68°F (within a year)
•• Dimensions:			58 (W) × 86.9 (H) × 14.2 (D) mm, 2.3 (W) × 3.4 (H) × 0.6 (D) inches
(projections are not included)

DBP-307
D
Li-ion battery pack (optional)

•• Voltage:			7.2V
•• Discharge Capacity:		
3050 mAh (minimum)
•• Usable temperature range: –20°C ~ +60°C, –4°F ~ +140°F
•• Charging temperature range: 0°C ~ 40°C, 32°F ~ 104°F
•• Storage temperature range:	–20°C ~ +50°C, –4°F ~ +122°F (within a month)
–20°C ~ +40°C, –4°F ~ +104°F (within 3 months)
–20°C ~ +20°C, –4°F ~ +68°F (within a year)
•• Dimensions:			58 (W) × 86.9 (H) × 22.4 (D) mm, 2.3 (W) × 3.4 (H) × 0.9 (D) inches
(projections are not included)

DBC-202IP2
D
rapid charger (optional)

•• Power source requirement: 12 V ~ 16 V DC or the specified Icom power adapter
•• Charging temperature range: 10°C ~ 40°C, 50°F ~ 104°F
•• Weight:			Approximately 105 g, 3.7 oz (without power adapter)
•• Dimensions:			88.0 (W) × 47.5 (H) × 72.5 (D) mm, 3.5 (W) × 1.9 (H) × 2.9 (D) inches
(projections are not included)

DBC-202IP3L
D
rapid charger (optional)

•• Power source requirement: 12 V ~ 15 V DC or the specified Icom power adapter
•• Charging temperature range: 10°C ~ 40°C, 50°F ~ 104°F
•• Weight:			Approximately 120 g, 4.2 oz (without power adapter)
•• Dimensions:			106.5 (W) × 52.5 (H) × 78.0 (D) mm, 4.2 (W) × 2.1 (H) × 3.1 (D) inches
(projections are not included)
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Basic operation
DDescription
D

TIP:
To turn OFF the FM Radio
Push [QUICK], and then select “<<FM Radio OFF>>.”

You can listen to FM Radio broadcasts.
While using the Dualwatch function, you can still listen
to the FM Radio on the pop up window.
Up to 500 FM Radio Memory channels can be
separately stored in the 26 groups for easy memory
management.
You can standby listening to FM Radio. Also, the
transceiver has the exclusive FM Radio mode, where
only the FM Radio functions. In this mode, the other
functions are disabled.

To listen to the FM Radio while monitoring the
A/B bands
Push [CLR] to close the FM RADIO window.
•• You can standby listening to FM Radio.

TIP: The FM Radio Memory channel contents,
described in this manual, may differ from your
transceiver’s preloaded contents.

LLTo open the FM RADIO window again, push [QUICK],
and select “<<FM Radio>>.”

The frequency range for the FM Radio
FM: 76.0 MHz* to 108.0 MHz

* The usable frequency range differs, depending on the
transceiver’s version.

DTurning
D
ON the FM Radio
1.	 Push [QUICK].
2.	 Select “<<FM Radio ON>>.”

NOTE: If you turn ON the Band Scope function while
using the Dualwatch function, the FM Radio audio
output may be interrupted due to the AF Output
(DUAL/AIR Band) function.
In that case, set “Auto Mute” to OFF, or set “AF
Output (DUAL/AIR Band)” to OFF.

•• Returns to the standby screen, and the FM RADIO
window is displayed.
•• “ ” is displayed.

LLWhen “AF Output (DUAL/AIR Band)” is set to ON, the
received audio is momentarily heard during a sweep,
and you will know that a signal is received without
looking at the display.
([MENU] > FM RADIO > FM Radio Set > Auto Mute)
([MENU] > SET > Scope > AF Output (DUAL/AIR Band))

Displayed when the FM
Radio is ON.
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Basic operation

DSelecting
D
the FM Radio mode

DSelecting
D
the group in the Memory
mode

1.	 When the FM RADIO window is displayed,
push [MR] to select between the Tuning and the
Memory modes.
2.	 Rotate [DIAL] to select a frequency or a memory
channel.

Up to 50 FM Radio Memory channels can be assigned
to each group for easy memory management.
If you change the group, other area channels can be
selected.
1.	 Push [MR] to select the Memory mode.

•• Tuning mode
The FM Radio Tuning mode is used to set the desired
FM Radio frequency.
When the Tuning mode is selected, “
” is
displayed.
To save the selected frequency, hold down [MR] for 1
second.

•• “
” and the selected memory channel number is
displayed.

•• Enters it into the lowest memory channel of the selected
group.

2.	 Push [QUICK].
3.	 Select “Group Select.”

Tuning mode
4.	 Select the desired group.
•• Memory mode
The FM Radio Memory mode is very useful to quickly
select often-used frequency settings.
When the Memory mode is selected, “
” and the
selected memory channel group (A ~ Z) and number
are displayed.

Memory mode

•• Returns to the standby screen, and the memory
channel in the selected group is displayed.

5.	 Rotate [DIAL] to select a memory channel.

TIP: Push [QUICK], and select “VFO” to select the
Tuning mode, or select “MR” to select the Memory
mode.
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Basic operation

DSearching
D
for an FM Radio signal

DUsing
D
the Attenuator function

While in the Tuning mode, hold down D-pad() to
start searching the broadcast signal.

The Attenuator prevents a desired signal from
becoming distorted when a very strong FM Radio
signal is near the frequency, or when a very strong
electric field, such as from a broadcasting station, is
near your location.

While searching, the frequencies are
sequentially displayed.

1.	 Push [QUICK].
2.	 Select “ATT.”

3.	 Select “ON.”

When a signal is received
•• When you hold down D-pad(), a down scan starts, and
when you hold down D-pad(), an up scan starts.
•• When a signal is received, the scan stops on the
frequency.
•• To cancel the scan, push D-pad() or [CLR].

Displayed when
the Attenuator is ON.

•• “ATT” is displayed.
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Basic operation

DSetting
D
a squelch level

DUsing
D
the Monitor function

The squelch enables the audio to be heard only while
receiving a signal that is stronger than the set level. A
higher level blocks weak signals, which enables you
to receive only stronger signals. A lower level enables
you to hear weak signals.
The squelch level that is set on the FM RADIO
window is only for the FM Radio.

The Monitor function is used to listen to weak FM
Radio signals without changing the squelch setting.
While holding down [SQL], the transceiver monitors
weak signals on the frequency.
•• The squelch opens.

While holding down [SQL], rotate [DIAL] to select the
squelch level.

The first segment blinks.

Automatic squelch

TIP: You can set the Monitor Hold function on the
MENU screen. The transceiver opens or closes the
squelch each time you push [SQL].
([MENU] > SET > Function > Monitor)

Maximum squelch level

LLInformation

•• Options: “OPEN,” “AUTO” (default), and “LEVEL 1” ~
“LEVEL 3”
•• “LEVEL 1” is loose squelch (for weak signals), and
“LEVEL 3” is tight squelch (for strong signals).
•• “AUTO” is an automatic level adjustment using a noise
pulse counting system.
•• “OPEN” is the continuously open setting.
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FM Radio memory
DUsing
D
the FM Radio Memory

DAdd
D
an FM Radio memory

A total of 26 groups are selectable for FM Radio
memory.
You can assign up to 50 FM Radio memory channels
to each group, for easy memory management. (A
maximum of 500 memories can be assigned to the FM
Radio memory.)
Some area stations are preloaded into the FM Radio
memory for easy memory management.

Step 1. Adding an FM Radio memory and entering
the edit mode
[MENU] > FM RADIO > FM Radio Memory
1.	 Push [MENU].
2.	 Select “FM Radio Memory” in the “FM RADIO” menu.

TIP: The FM Radio memory contents, described
in this manual, may differ from your transceiver’s
programmed memory.
3.	 Select a desired group.

LLIf there is no memory, “-- Blank --” is displayed.

4.	 Push [QUICK].
5.	 Select “Add.”

•• The FM RADIO MEM EDIT screen is displayed.
TIP: To change the group name, push [QUICK], and
then select “Edit Name” in step 4.
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FM Radio memory
DDAdd an FM Radio memory
Step 2. Entering an FM Radio Memory name
1.	 Select “NAME.”

Step 4. Selecting the skip setting
1.	 Select “SKIP.”

2.	 Select “OFF” or “SKIP.”
2.	 Enter a name.
•• OFF:	You can select the memory in the Memory mode.
•• SKIP:	The memory is not displayed in the Memory
mode.

Step 5. Saving the FM Radio Memory
1.	 Select “<<Add Write>>.”
LLSee page iii on how to enter characters.

3.	 After entering, push [ENT].

TIP: To change the FM Radio memory group, select
“GROUP,” then select the desired group.

2.	 Select “YES.”

Step 3. Entering a frequency
1.	 Select “FREQUENCY.”

2.	 Rotate [DIAL] to enter the frequency.

•• The entered contents are saved in the FM Radio
memory, and the display returns to the selected
group screen.

LLPush D-pad() to move the cursor.
LLThe usable frequency range differs, depending on the
transceiver’s version.

TIP: How to cancel the entered data:
1.	 Push [CLR].
2.	 Select “YES.”

3.	 After entering, push [ENT].

•• Cancels the entry, and returns to the selected group
screen.
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FM Radio memory

DEditing
D
an FM radio memory

This function edits FM Radio memory contents. This
is useful when already-entered data is incorrect, has
changed, or new data should be added to the list.
[MENU] > FM RADIO > FM Radio Memory
1.	 Push [MENU].
2.	 Select “FM Radio Memory” in the “FM RADIO” menu.

8.	 After editing, select “<<Overwrite>>.”

9.	 Select “YES.”

3.	 Select a group that includes the memory you want
to edit.

•• The memory contents are overwritten, and returns to
the selected group screen.

4.	 Select the memory to be edited.

LLDO NOT push [ENT].

5.	 Push [QUICK].
6.	 Select “Edit.”

7.	 Select an item, then edit it.
LLSee page 4-7 for details.
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FM Radio memory

DDeleting
D
an FM Radio memory

All the contents of an FM Radio memory can be
deleted.
NOTE: Deleted memories cannot be restored.
[MENU] > FM RADIO > FM Radio Memory
7.	 Select “YES.”

1.	 Push [MENU].
2.	 Select “FM Radio Memory” in the “FM RADIO” menu.

3.	 Select a group that includes the memory you want
to delete.

•• The selected FM Radio memory is deleted.

4.	 Select the memory to be deleted.

LLDO NOT push [ENT].

5.	 Push [QUICK].
6.	 Select “Delete.”
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FM Radio memory

DRearranging
D
the display order of the
FM Radio memories

You can move the entered FM Radio memories to
rearrange their display order in the selected FM Radio
memory group.
[MENU] > FM RADIO > FM Radio Memory
7.	 Select a memory to insert the repeater you want to
move above it.

1.	 Push [MENU].
2.	 Select “FM Radio Memory” in the “FM RADIO” menu.

3.	 Select a group that includes the memory you want
to move.

•• The selected memory is inserted above the
destination memory.
LLIf you select “<<Move End>>,” the memory is moved
to the bottom of the group.

4.	 Select the memory to be moved.

LLDO NOT push [ENT].

5.	 Push [QUICK].
6.	 Select “Move.”
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FM Radio memory

DSkip
D
setting for the FM Radio
memory

You can set memories as skip memories. The
selected memories are not displayed in the Memory
mode.
[MENU] > FM RADIO > FM Radio Memory
7.	 Select “SKIP.”

1.	 Push [MENU].
2.	 Select “FM RADIO.”
3.	 Select “FM Radio Memory.”

4.	 Select a group that includes the memory you want
to set the skip setting on.

•• “SKIP” is displayed on the selected memory.
LLPush [QUICK], and then select “SKIP” again to
cancel the skip setting.

5.	 Select the memory to be skipped.

TIP: When displaying the FM RADIO window in the
Memory mode, push [QUICK], and selecting “SKIP”
also sets the skip setting.

LLDO NOT push [ENT].

6.	 Push [QUICK].
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Using the FM Radio mode
The transceiver has an exclusive FM Radio mode
where only the FM Radio functions.
1.	 Push [QUICK].
2.	 Select “<<FM Radio Mode>>.”

•• The FM Radio mode screen is displayed.

TIP: To cancel the FM Radio mode
1.	 Push [QUICK].
2.	 Select “<<Normal Mode>>.”

LLIn the exclusive FM Radio mode, the other modes
are in a sleep state. To operate the transceiver in a
normal way, cancel the FM Radio mode.
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FM RADIO items
FM Radio Memory

Earphone Antenna

[MENU] > FM RADIO > FM Radio Memory

[MENU] > FM RADIO > FM Radio Set >
Earphone Antenna

A total of 26 groups are selectable for FM radio
Memories.
You can assign up to 50 memories to each group,
for easy memory management. (A maximum of 500
memories can be assigned to the FM Radio Memory.)

Selects whether or not to use the earphone antenna
for FM radio.
•• Not Used: An earphone antenna is not used.
•• Use:
An earphone antenna is used.

FM Radio memory contents
NAME

The name of an FM Radio memory
channel
LLEnter a name of up to 16 alphanumeric
characters for each memory.

GROUP

The group letter and the name of the group

FREQUENCY

Entered frequency
LLThe usable frequency range differs,
depending on the transceiver’s version.

SKIP

Shows the skip status.
LLThe Skip channels are not displayed in
the Memory mode.

Auto Mute

(Default: Not Used)

Power Save (FM Radio)

(Default: ON)

[MENU] > FM RADIO > FM Radio Set >
Power Save (FM Radio)
Sets the power save function to reduce the current
drain and conserve battery power when the FM Radio
is ON.
•• OFF: The power save function is OFF.
•• ON:	When the FM Radio is ON, and no signal is
received for 5 seconds, this function is activated in
a 1:3 ratio (300 : 900 milliseconds).

NOTE: This function is disabled when an external
power source is used.

(Default: 2sec)

<<FM Radio ON>>

[MENU] > FM RADIO > FM Radio Set > Auto Mute

[MENU] > FM RADIO > <<FM Radio ON>>

Selects whether or not to mute the FM Radio audio in
the background* while receiving a signal on the A or B
band.

Turns ON the FM Radio.
When the transceiver receives on the MAIN band and
SUB band, you can still listen to the FM Radio.
When the FM Radio is ON, <<FM Radio OFF>> is
displayed on the FM RADIO screen. To turn OFF the
FM Radio, select <<FM Radio OFF>>.

LLThe FM Radio audio is muted while transmitting,
regardless of this setting.
* See “To listen to the FM Radio while monitoring the A/B
bands” on page 4-2 for details.

LLIn the Quick Menu window, selecting <<FM Radio OFF>>
also turns OFF the FM Radio.

•• OFF:	The Auto Mute function is OFF. The FM Radio
audio is not muted even if the transceiver
receives a signal on the A or B band. The FM
Radio audio is muted when the transceiver
transmits.
•• 0 to 10sec:	The FM Radio audio is automatically muted
when the transceiver transmits or receives
on the A or B band. After transmitting or
receiving, the Auto Mute timer starts. After the
timer period ends, you can listen to FM Radio
again.
The FM Radio audio is muted when a
signal is received during a sweep by the
Band Scope function.

<<FM Radio Mode>>
[MENU] > FM RADIO > <<FM Radio Mode>>
The transceiver enters an exclusive FM Radio mode
where only the FM Radio functions.
While in the FM Radio Mode, <<Normal Mode>> is
displayed on the FM RADIO screen. To exit from the
FM Radio mode, select <<Normal Mode>>.

LLIn the Quick Menu window, selecting <<Normal Mode>>
also exits from the FM Radio mode.
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NOTE: See D-STAR GUIDE on the
Basic manual for details on how to
register your call sign to a gateway
repeater and the basic operations.
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IMPORTANT!
•• The repeater list, described in this manual, may differ from your transceiver’s preloaded contents.
•• Although Japanese repeaters are used in the setting examples, the Japanese repeater node (port) letters
are different from other country’s. BE SURE to add the repeater node letter in the 8th digit of the call sign,
according to the frequency band shown below.
1200 MHz: A (B in Japan)
430 MHz: B (A in Japan)
144 MHz: C (no repeaters in Japan)
To begin the Digital mode communication using other than the D-STAR Repeater (DR) function
For a Local area call or Gateway call:
1.	 Set the access repeater’s frequency. (p. 11-2)
2.	 Set the Duplex direction and frequency offset.
(p. 11-4)
3.	 Set the call signs (UR/R1/R2). (p. 12-8)

To begin Digital mode communication using other
than the DR function, you can use the VFO mode,
Memory mode, or Call Channel mode.
This manual description focuses on the DR function
operation, which can be easily set up. If you want to
use other than the DR function, see the procedures
as described to the right, or select the repeater in a
Memory channel.

For a Simplex call:
1.	 Set the operating frequency.
2.	 Set the call signs (UR/R1/R2). (p. 12-8)
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“FROM” (access repeater) setting
Your access repeater must be set in “FROM” when you make a call on the DR screen.
You have 5 ways to select the access repeater.
By rotating [DIAL]
Select the preset repeater on the DR screen by rotating [DIAL].

Displayed while
rotating [DIAL]

•• When you know your access repeater
From the repeater list (p. 5-4)
When your access repeater is in your transceiver’s repeater list, you can
select it by selecting the repeater area and name, if entered, or call sign.

•• When you do not know which repeaters you can access
Search for a repeater using the DR scan (p. 5-5)
The Normal DR scan searches for output repeater frequencies of nearby
repeaters. The scan stops when a signal is detected. The scan also stops
on Simplex signals.
The Near Repeater scan searches for output repeater frequencies of
nearby repeaters by using your location and the repeater’s location, if it
is entered in the Repeater List. The DR scan starts scanning and stops
when a signal is detected.
You can also find only FM repeaters using the Near Repeater (FM) scan.
Search for near repeaters (p. 5-6)
The transceiver scan searches for near repeaters by using your location
and the repeater’s location, if it is entered in the Repeater List.
The nearest repeaters in your transceiver’s repeater list are displayed as
selectable options.
You can select the nearby DV or FM repeater type.

•• When “FROM” data is saved in the TX History.
Select from the TX History (p. 5-7)
Select a repeater that you have accessed before from the TX History
record.
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“FROM” (access repeater) setting

DUsing
D
your transceiver’s repeater list
When your access repeater is in your transceiver’s
repeater list, you can select it from the list. By just
selecting the repeater from the list, the repeater call
sign, its frequency, duplex setting, and frequency
offset are automatically set, for easy operation.
Example: S
 electing the “Kirkland (IA)” repeater in
Washington state in the USA from the
repeater list.
5.	 Select your access repeater.

1.	 Hold down [DR] for 1 second to display the DR
screen.
2.	 Push D-pad() to select “FROM,” and then push
[ENT].

•• Returns to the DR screen, and the selected repeater
name is displayed in “FROM.”
LLThe repeater list, described in this manual, may differ
from your transceiver’s preloaded contents.

3.	 Select “Repeater List.”

TIP:
When you select an FM repeater:
When an FM repeater is in your transceiver’s
repeater list, you can select it from the list.
When selecting an FM repeater, the “TO” setting is
not necessary, and a “––––” is displayed in “TO.”

4.	 Select the repeater group where your access
repeater is listed.

When selecting an FM repeater.

How to change the repeater group:
To change the repeater group on the DR screen,
push [QUICK], then select “Group Select.”
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“FROM” (access repeater) setting

DUsing
D
the DR scan

Example: Selecting an active repeater using the DR
scan.
1.	 Hold down [DR] for 1 second to display the DR
screen.
2.	 Hold down [SCAN] for 1 second.

The DR scan scans frequencies to find a signal on a
repeater, or on a simplex frequency.
You can use 2 kinds of DR scans, Normal scan and
Near Repeater scan.
Normal scan
To quickly find a repeater, the Normal scan skips
repeaters that are not set as an access repeater.

LLThe “USE (FROM)” setting (p. 5-33) is set to “NO” on the
repeater list.
([MENU] > MEMORY > Repeater List)

Near Repeater scan
The Near Repeater scan searches for up to 20 nearby
repeaters within 160 kilometers (100 miles) by using
your location and the repeater’s entered position data,
and then lists the repeaters.

•• The DR scan setting window is displayed.

3.	 Select the scan type.

•• Normal:
Searches for repeaters whose “USE (FROM)” setting
is set to “YES.”
•• Near Repeater (ALL):
Searches for up to 20 each of nearby DV or FM
repeaters. (Total 40 repeaters)
•• Near Repeater (DV):
Searches for up to 20 nearby DV repeaters.
•• Near Repeater (FM):
Searches for up to 20 nearby FM repeaters.

LLThe Near Repeater scan continues, even if you turn OFF
the transceiver, and then turn it ON again during the scan.
LLIf your own position data is not being received from GPS
satellites, the last received position data is used.

NOTE: Even if your transceiver receives a repeater
signal, the repeater may not receive your signal,
because the repeater’s output power is higher than
your transceiver’s, and your signal does not reach
the repeater.

•• The selected scan starts.
•• In the DR scan, the repeaters are sequentially
displayed by distance, in descending order.
LLThe scan resumes the same as other scans. (p. 12-5)

TIP: The DR scan scans the simplex frequencies in
the repeater list, in addition to D-STAR repeaters.

		

The repeaters are
sequentially displayed.

4.	 When the transceiver receives a signal from a
repeater, the scan stops. Push [SCAN].

•• The DR scan is canceled, and the repeater is set to
“FROM.”
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“FROM” (access repeater) setting

DUsing
D
the Near Repeater Search function
The transceiver searches for the nearest repeaters by
using your location and the repeater’s entered position
data.
The nearest repeaters in your transceiver’s repeater
list are displayed as selectable options.

4.	 Select the type of nearby repeater to display.

NOTE:

•• When using the Near Repeater Search function, BE
SURE first to receive your own GPS position data, or
manually enter your position data.
•• If no repeater is found within a 160 kilometers
(100 miles) range, “No Repeater Found” is displayed.
•• If the last received position data can be used, “GPS is
invalid. Search by last valid position” is displayed.

•• Near Repeater (ALL):
Displays up to 20 nearby DV and FM repeaters.
(A total 40 repeaters)
•• Near Repeater (DV):
Displays up to 20 nearby DV repeaters.
•• Near Repeater (FM):
Displays up to 20 nearby FM repeaters.

Example: S
 electing a nearby repeater from the Near
Repeater list.

5.	 Select the repeater to use as your access
repeater, considering the distance from your
location to the repeater.

Step 1: Receiving your own location from the GPS
satellite
Confirm the GPS receiver is receiving the satellite
signals.

“FM” is displayed for the FM
repeaters.

•• The GPS icon blinks when searching for satellites.

→

→

→

•• The GPS icon stops blinking when the minimum needed
number of satellites is found.

Repeater call sign
Distance and direction from
your location to the repeater*

LLIt may take only a few seconds to receive, or it may take
a few minutes, depending on your operating environment.
If you have difficulties receiving, we recommend that you
try a different location.
LLIf your own location is not being received, the last
received position is used for your location.

* When the “POSITION” setting (p. 5-34) is set to
“Approximate” on the repeater list, the direction data
is not displayed if the distance to the repeater is less
than 5 kilometers.
•• Returns to the DR screen and the selected repeater
is set in “FROM.”

Step 2: Selecting the access repeater from the
Near Repeater list
1.	 Hold down [DR] for 1 second to display the DR
screen.
2.	 Push D-pad() to select “FROM,” and then push
[ENT].

3.	 Select “Near Repeater.”
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“FROM” (access repeater) setting

DUsing
D
TX History

The TX History saves up to 10 of the latest access
(From) repeaters you transmitted on. You can select a
repeater from TX History as your access repeater.

TIP: When you push [QUICK] in step 5, you can
display the REPEATER DETAIL screen or delete the
TX HISTORY screen’s repeater information.

Example: S
 electing the “Hirano” repeater from TX
History.
1.	 Hold down [DR] for 1 second to display the DR
screen.
2.	 Push D-pad() to select “FROM,” and then push
[ENT].

3.	 Select “TX History.”

4.	 Select the TX History (DV) or TX History (FM).

•• TX History (DV): D
 isplays the TX History of the DV
repeaters.
•• TX History (FM): D
 isplays the TX History of the FM
repeaters.

5.	 Select the repeater to use it as your access repeater.

•• Returns to the DR screen and the selected repeater
is set in “FROM.”
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“TO” (Destination) setting
“CQCQCQ,” the destination repeater, or station call
sign must be set in “TO” when you make a DV mode
call. You have 9 ways to set the destination.

TIP: After you receive the individual station or
repeater’s signal, the call sign can be captured by
holding down the Call Sign Capture key ([RX→CS]),
and you can quickly and easily reply to a call.

By rotating [DIAL]
Rotate [DIAL] to select the repeater or Your Call
Sign displayed on the DR screen. (This operation is
disabled when “CQCQCQ” is set.)

To make a Local Area CQ call
Set “CQCQCQ” in “TO” (Destination). (p. 5-9)

To make a Gateway CQ call
Select a repeater from the Repeater List, if you
want to make a Gateway call. (p. 5-9)

To make a call to a specific station
Select the station call sign in the Your Call Sign list.
(p. 5-10)
TIP: How to change the repeater group:
When “Local CQ” or “Gateway CQ” is
selected, you can change the repeater
group.
To change the repeater group on the DR
screen, push [QUICK], then select “Group
Select.”

To make a call through a Reflector
Select a reflector you want to call through. (p. 5-14)

To select from RX History
When you receive a call, repeater or caller station
data is saved in RX History.
Select the destination from the record. (p. 5-10)

To select from TX History
When you make a call, the destination repeater or
called station data is saved in TX History.
Select the destination from the record. (p. 5-11)

To directly enter the destination station call sign
Directly enter the destination station’s call sign.
(p. 5-11)

To directly enter the destination repeater call sign
Directly enter the destination repeater’s call sign.
(p. 5-12)
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“TO” (Destination) setting

DMaking
D
the “Local CQ” (Local Area
call)

DDMaking a “Gateway CQ” (Gateway call)

When “Local CQ” is selected on the TO SELECT
screen, “CQCQCQ” is set in “TO.”

When “Gateway CQ” is selected on the TO SELECT
screen, you can select the repeater to make a
gateway call to.

Example: M
 aking a Local area call by accessing the
“Kirkland (IA)” repeater.

Example: Making a Gateway CQ call to the “Hirano”
repeater from the “Kirkland (IA)” repeater.

1.	 Hold down [DR] for 1 second to display the DR
screen.
2.	 Push D-pad() to select “TO,” and then push [ENT].

1.	 Hold down [DR] for 1 second to display the DR
screen.
2.	 Push D-pad() to select “TO,” and then push [ENT].

3.	 Select “Gateway CQ.”
3.	 Select “Local CQ.”

4.	 Select the repeater group where your destination
repeater is listed.

•• Returns to the DR screen, and “CQCQCQ” is
displayed in “TO.”

5.	 Select the destination repeater.

LLEach repeater has a correct node (A, B, or C band)
that you want to transmit on. See page 5-2,
“IMPORTANT” for band letter details.
•• Returns to the DR screen, and the selected repeater
name is displayed in “TO.”

TIP: After selecting a destination repeater, you can
select another repeater preset in your repeater List
by rotating [DIAL].
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“TO” (Destination) setting

DUsing
D
“Your Call Sign”

DUsing
D
RX History

The “Your Call Sign” memory saves individual or
repeater station call signs. When you select the call
sign for the “TO” (Destination) setting, you can make
a Gateway call. When you call an individual station
through a gateway, the signal is automatically sent to
the last repeater that the individual station accessed.
Therefore, even if you do not know where the
individual station is located, you can make a call.

When a call is received in the DV mode, the call data
is saved in the RX History.
Up to 50 callers, and only the last called call signs, a
total of 51 histories can be saved.
Example: Selecting “Rick” in the RX History.
1.	 Hold down [DR] for 1 second to display the DR
screen.
2.	 Push D-pad() to select “TO,” and then push [ENT].

NOTE: If the repeater, set in “FROM” (access
repeater), has no Gateway call sign, you cannot
make a gateway call.
Example: Selecting “Rick” from “Your Call Sign.”
1.	 Hold down [DR] for 1 second to display the DR
screen.
2.	 Push D-pad() to select “TO,” and then push [ENT].

3.	 Select “RX History.”

3.	 Select “Your Call Sign.”

4.	 Select a destination name or call sign.

4.	 Select a destination name or call sign.

•• Returns to the DR screen, and the selected name is
displayed in “TO.”
LLThe “*” (asterisk) is displayed at the beginning of the
called station’s call sign. (p. 5-19)

TIP: To add an RX HISTORY data to the “Your Call
Sign” memory, push [QUICK], then select “Add To
Your Memory.”

•• Returns to the DR screen, and the selected name is
displayed in “TO.”

TIP: After selecting a destination, you can select
another station preset in your transceiver by rotating
[DIAL].
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“TO” (Destination) setting

DUsing
D
TX History

DDirectly
D
entering (UR)

TX History saves the repeater and station name and
call sign of up to 20 “TO” (Destination) settings used
when you made the calls.

The destination station call sign can be directly entered.
Example: Directly entering the call sign “JM1ZLK.”

NOTE: Until you make a call in the DV mode, you
cannot select “TO” (destination) from the TX History.

1.	 Hold down [DR] for 1 second to display the DR
screen.
2.	 Push D-pad() to select “TO,” and then push [ENT].

Example: S
 electing the “Kirkland (IA)” repeater in the
TX History.
1.	 Hold down [DR] for 1 second to display the DR
screen.
2.	 Push D-pad() to select “TO,” and then push [ENT].

3.	 Select “Direct Input (UR).”

3.	 Select “TX History.”
4.	 Enter a call sign of up to 8 characters, including
spaces.

4.	 Select a destination repeater.
LLSee page iii on how to enter characters.

5.	 After entering, push [ENT].

The Sub name is
displayed when a
repeater is selected.

•• Returns to the DR screen and the entered call sign is
displayed in “TO.”
LLAfter entry, you can edit the call sign in the DIRECT
INPUT (UR) screen.
LLThe entered call sign remains on the DIRECT INPUT
(UR) screen until you enter a new call sign.

•• Returns to the DR screen, and the selected repeater
name is displayed in “TO.”

TIP: You can add the TX HISTORY data to memory,
or delete it from the TX HISTORY screen.
Push [QUICK], then select the option.

TIP: If the entered call sign is duplicated in the “Your
Call Sign” memory, the name is displayed.
(Only when the name has been entered.)
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“TO” (Destination) setting

DDirectly
D
entering (RPT)

The destination repeater call sign can be directly
entered.
NOTE: BE SURE to include a node letter as the 8th
digit. See page 5-2 “IMPORTANT” about the node
letters.

Example: Directly entering the call sign “JP3YDH A.”
1.	 Hold down [DR] for 1 second to display the DR
screen.
2.	 Push D-pad() to select “TO,” and then push [ENT].

3.	 Select “Direct Input (RPT).”

4.	 Enter a call sign of up to 8 characters, including
spaces.

LLSee page iii on how to enter characters.

5.	 After entering, push [ENT].

•• Returns to the DR screen and “JP3YDH A” is
displayed in “TO.”
LLAfter entry, you can edit the call sign in the DIRECT
INPUT (RPT) screen.
LLThe entered call sign remains on the DIRECT INPUT
(RPT) screen until you enter a new call sign.

TIP:

•• If the entered call sign is duplicated in the repeater list,
the name is displayed in “TO” (Only when the name has
been entered).
•• When directly entering the repeater call sign, including a
“/” at the beginning is also correct.
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REPEATER DETAIL screen
The REPEATER DETAIL screen

Depending on the content, such as position data or
UTC offset, the distance between your location and
the repeater, or the repeater time can be displayed on
the REPEATER DETAIL screen.
The detail screen can also be entered from the FROM
SELECT screen.
Example: D
 isplaying the “Hirano/Icom” repeater detail
screen
1.	 Hold down [DR] for 1 second to display the DR
screen.
2.	 Push D-pad() to select “TO” then push [ENT].

Repeater frequency
Repeater
type

Repeater name
Sub name
Call sign
Group number

Duplex
setting

Direction from
your position*
Repeater time

Distance from
your position

* When the “POSITION” setting (p. 5-34) is set to
“Approximate” on the repeater list, the direction data
is not displayed if the distance to the repeater is less
than 5 kilometers.
LLIf there is no position data, the distance and direction
from your position are not displayed. See page 6-3 to
confirm your position.
LLWhen selecting an FM repeater, either of “FM” or “FM-N”
and the tone setting are displayed.

3.	 Select “Gateway CQ.”

TIP: You can display the REPEATER DETAIL screen
when the DR screen is displayed.
When you set the repeater as shown below, push
[QUICK], then select “Repeater Detail.”

4.	 Select “13: Japan.”

5.	 Select “Hirano/Icom.”

LLDO NOT push [ENT].

•• The REPEATER DETAIL screen is displayed.

6.	 Push [QUICK].
7.	 Select “Detail.”

8.	 Push [ENT].

•• Returns to the previous screen.
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Connecting to a reflector
DWhat
D
is a reflector?

A reflector is a special server connected to the Internet and running a version of the D-Plus software. If the D-Plus
software is installed on your access repeater, it provides various functions including gateway and reflector linking
capabilities (It is known as the D-STAR reflector system). The D-STAR reflector system enables a number of
D-STAR repeaters anywhere to link to a reflector. This means that when you transmit through a D-STAR repeater
linked to a reflector, your voice can be heard on other repeaters linked to the reflector, and you can hear other
stations that are connected to the reflector.
D-STAR reflector system
Reflector
Access
repeater
CAN
UK

USA

AUS

DUnlinking
D
a reflector

Before trying to link to another reflector, BE SURE to
unlink the currently connected to the repeater.
NOTE: If a reflector is already connected, ask on the
air whether or not you can change reflectors and wait
for responses. BE SURE to reconnect back to the
same reflector when you finish your conversation.
4.	 Select “Unlink Reflector.”

1.	 Hold down [DR] for 1 second to display the DR
screen.
2.	 Push D-pad() to select “TO,” and then push [ENT].
•• Displays the TO SELECT screen.

3.	 Select “Reflector.”

•• Returns to the DR screen, and “Unlink Reflector” and
“U” are displayed in “TO.”

•• Displays the REFLECTOR screen.

5.	 Hold down [PTT] to unlink the reflector.
•• The TX/RX indicator lights red.
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Connecting to a reflector

DLinking
D
to a reflector

6.	 Push [ENT].

If your repeater is not currently linked to a reflector, or
if you want to change it to another reflector, follow the
steps below. Before linking to another reflector, BE
SURE to unlink the current reflector. (p. 5-14)
Direct inputting a reflector
Example: Directly enter “REF030CL.”
•• Returns to the DR screen, and “Link to Reflector” and
“REF030CL” are displayed in “TO.”

1.	 Push D-pad() to select “TO,” and then push [ENT].

7.	 Hold down [PTT] to link to the Reflector.

Using TX History
TX History saves up to 5 reflectors that your access
repeater linked to before.
Example: Select “REF030CL” in TX History.
1.	 Push D-pad() to select “TO” then push [ENT].
2.	 Select “Reflector.”

•• The TO SELECT screen is displayed.

2.	 Select “Reflector.”

3.	 Select “Link to Reflector.”

The REFLECTOR screen is displayed.

3.	 Select “Link to Reflector.”

The Link to Reflector screen is displayed.

4.	 Select the Reflector that you want to link to.

4.	 Select “Direct Input.”

•• Returns to the DR screen, and “Link to Reflector” and
“REF030CL” are displayed in “TO.”

5.	 Push D-pad to move the cursor, and select the
reflector type, reflector number, or module letter.

5.	 Hold down [PTT] to link to the Reflector.
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Connecting to a reflector

DUsing
D
a reflector

DRequesting
D
repeater information

1.	 Push D-pad() to select “TO,” and then push [ENT].
•• The TO SELECT screen is displayed.

When you send the repeater information command,
an ID message is sent back.

The REFLETOR screen is displayed.

1.	 Push D-pad() to select “TO,” and then push [ENT].

2.	 Select “Reflector.”

3.	 Select “Use Reflector.”

•• The TO SELECT screen is displayed.

2.	 Select “Reflector.”

•• The REFLECTOR screen is displayed.

3.	 Select “Repeater Information.”

•• Returns to the DR screen, and “Use Reflector” and
“CQCQCQ” are displayed in “TO.”
•• Returns to the DR screen, and “Repeater
Information” and “I” are displayed in “TO.”

4.	 Hold down [PTT] to transmit.

DReflector
D
Echo testing

4.	 Hold down [PTT] to transmit the repeater
Information command.
5.	 Release [PTT] to hear the repeater ID message.

To confirm that your signal is correctly getting into the
repeater, you can transmit a short message as a trial.
After releasing [PTT], your message will be played back.
1.	 Push D-pad() to select “TO,” and then push [ENT].
•• The TO SELECT screen is displayed.

2.	 Select “Reflector.”

The REFLECTOR screen is displayed.

3.	 Select “Echo Test.”

•• Returns to the DR screen, and “Echo Test” and “E”
are displayed in “TO.”

4.	 Hold down [PTT] and speak into the microphone.
5.	 Release [PTT] to hear your message.
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Message operation
DTransmitting
D
a message

You can save up to 5 short messages in the
transceiver’s memory to transmit in the DV mode.
Each message can be up to 20 characters.

You can transmit a preset TX message by pushing
[PTT] in the DV mode. First, select a TX message which
also turns ON the Message Transmission function.

DEntering
D
a TX message

[MENU] > SET > My Station > TX Message

[MENU] > SET > My Station > TX Message

1.	 Push [MENU].
2.	 Select “My Station” in the “SET” menu.

Example: E
 ntering “JAPAN TOM” into TX message
memory number 1.
1.	 Push [MENU].
2.	 Select “My Station” in the “SET” menu.

3.	 Select “TX Message.”
3.	 Select “TX Message.”

4.	 Select a TX Message memory number.
4.	 Select a TX Message memory number.

LLTo not transmit any message, select “OFF.”
LLTo exit the MENU screen, push [MENU].
LLDO NOT push [ENT].

LLInformation

5.	 Push [QUICK].
6.	 Select “Edit.”

•• The message is transmitted with your voice signal.
•• The message is transmitted each time you push [PTT].
•• When continuously transmitting, the selected TX
message is transmitted every 30 seconds.

TIP: RX call sign and message display
As the default, the received call sign and message
are automatically displayed and scrolled.
To not display and scroll them, set RX Call Sign to
“OFF.”
([MENU] > SET > Display > RX Call Sign)

7.	 Enter a message of up to 20 characters.

LLSee page iii on how to enter characters.

8.	 After entering, push [ENT].

•• Returns to the TX MESSAGE screen.
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Message operation

DDeleting
D
a TX message
[MENU] > SET > My Station > TX Message
Example: D
 eleting the entered TX message “JAPAN
TOM” from TX message memory number 1.
1.	 Push [MENU].
2.	 Select “My Station” in the “SET” menu.

3.	 Select “TX Message.”

4.	 Select a TX Message memory number.

LLDO NOT push [ENT].

5.	 Push [QUICK].
6.	 Select “Clear.”

•• The confirmation dialog is displayed.

7.	 Select “YES.”

•• The entered message is cleared.
LLTo exit the MENU screen, push [MENU].
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Viewing received call signs
When you receive a DV call, the calling station and the repeater call signs are saved. Up to 50 calls can be saved.
When you receive the 51st call, the oldest call history is deleted.
LLEven if the transceiver is turned OFF, the RX records are not deleted.

DViewing
D
the call signs on the RX History screen
1.	 Hold down [CD] for 1 second.
2.	 Select an RX history memory to view the details.

3.	 Push [ENT].

•• Displays the RX history detail screen.
LLPush D-pad() to view the content.

LLInformation

•• The first page of the “RX HISTORY” screen displays the
latest RX record of the MAIN band. The second page or later
displays the record according to the received date and time,
regardless of the band it was received on.

<1st page>
•• CALLER:	Displays the caller station’s call
sign*2, and any note entered after
the call sign.
•• CALLED:	Displays the called station’s call
sign*2.

•• The RX history number, the caller’s name (or call
sign), destination, RX message, RX date and time,
“GW,” and “GPS” are displayed.
•• “GW” is displayed when the Gateway call is received.
•• “GPS” is displayed when the received call includes
position data.
•• “UP” is displayed when the repeater uplink signal is
received.
•• In the Quick Menu window, you can select the
following options.
RX>CS:		Temporarily enters the received
call sign into “TO.”
Call Sign Display:	The received data is displayed in
the Call Sign Display mode.
Name Display:	The received data is displayed in
the Name Display mode.
Delete:		
Deletes the selected RX history.
Delete All:		
Deletes all RX history.

LL“CQCQCQ” is displayed when receiving
a Local Area call or Gateway call.

<2nd page>
•• RX RPT1:	Displays the repeater’s call sign*2
that was accessed by the caller
station.
If the received call was a Gateway
call, this item displays the gateway
call sign of the repeater you
received the call from.
•• RX RPT2:	Displays the repeater’s call sign*2
you received the call from.

RX HISTORY screen (RX01)
Displayed when
a Gateway call is
received.

D-PRS TX
format icon*1

History
number

LLThe operating frequency is displayed instead of the
above items when the call was not through a repeater
(Simplex call).

Called station
(“CQCQCQ” is
displayed if you
received a CQ call.)

				

RX message

Caller station*2
Received date
LLA note may be
and time
displayed after “/.”

*1 The displayed icon differs, depending on the D-PRS
TX format.
GPS: Position
OBJ: Object
ITEM: Item
WX: Weather
*2 When a name is entered in the MEMORY, the name
is also displayed.
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Viewing the received call signs
DDView the call signs on the RX History screen

TIP: To delete RX HISTORY data
On the RX HISTORY or the detail screen, push
[QUICK], then select “Delete” or “Delete All.”

<3rd page>
•• RX MESSAGE:	Displays any message
included in the received call if
entered.
•• RX TIME: 	Displays the date and time
the call was received.

TIP: “RX RPT1” setting may differ, depending on the
way the call was made.
Example 1: When a Local area call is received.

<4 ~ 6th page>
Displays position data of the caller station. If a
received signal has no data, then no position data
is displayed.
					

JM1ZLK
calling you...

JM
1
call ZLK
ing
you
...

RXRPT2
CALLED

RXRPT1

CALLER

ZLK
.
JM1 g you..
callin

YOUR STATION

Example 2: When a Gateway call is received.

					

JM
JP 1ZLK
1Y
IU callin
por
g
t A from
...

GW
RXRPT1

CALLED
m
g fro
callin ...
A
ZLK
JM1 IU port
Y
JP1

					

YOUR STATION

LLTo exit the MENU screen, push [MENU].

5-20

JM1ZLK calling from
JP1YIU port A...

RXRPT2

INTERNET

CALLER

5

D-STAR OPERATION (ADVANCED)

BK mode communication
4.	 Select “BK.”

The Break-in (BK) function enables you to break into a
conversation, where the 2 stations are communicating
with Digital Call Sign squelch (DSQL) enabled.
LLThe BK function is automatically turned OFF when you
turn OFF the transceiver.

[MENU] > SET > DV Set > BK
1.	 While 2 stations are communicating in the DV
mode, hold down [RX→CS] for 1 second.

5.	 Select “ON.”

•• After releasing [RX→CS], the calling station’s
call sign or the repeater’s call sign is set to “TO”
(Destination).
•• Beeps sound, and the calling station’s call sign is
announced.
LLWhen a call sign is not received correctly, error beeps
sound, and no call sign is set.

2.	 Push [MENU].
3.	 Select “DV Set” in the SET menu.

6.	 Push [MENU].

•• Returns to the Standby screen and “BK” is displayed.

7.	 When both stations are in standby, push [PTT] to
transmit.
LL“BK” blinks when receiving a Break-in call.
LLTo cancel the BK mode, select “OFF” in step 5, or
turn OFF the transceiver.

How to use Break-in?
While using the Digital Call Sign squelch (DSQL), the squelch never opens (no audio is heard) even if a call is
received, unless the call is addressed to your call sign.
However, when a call including the “BK ON” signal (break-in call) is received, the squelch opens, and audio is
heard even if the call is addressed to another station.
Station C calling to Station A with “BK OFF”
Station A and B are communicating using the Digital
Call Sign squelch.

Station A

Station C calling to Station A with “BK ON”
Station A and B are communicating using the Digital
Call Sign squelch.

Station B

Station A

Station B

Station C

Station C

Station B does not hear that
Station C is calling Station A.

Station B also hears that
Station C is calling Station A.
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EMR communication
DAdjusting
D
the EMR AF level

The Enhanced Monitor Request (EMR) communication
function can be used in only the DV mode. Using the
EMR function, no call sign setting is necessary.

The audio output level when an EMR signal is
received is adjustable between 0 and 39.
When an EMR signal is received, the audio is heard at
the preset level, or the [VOL] control level, whichever
is higher.
To turn OFF the setting, set to “0.”

LLInformation

•• All transceivers that can receive an EMR signal
automatically receive the signal. DO NOT use this function
except in the case of an emergency.
•• When an EMR signal is received, the audio (voice) is
heard at the set level, even if the volume setting level is
set to the minimum level.
•• The EMR communication function is automatically turned
OFF when you turn OFF the transceiver.

[MENU] > SET > DV Set > EMR AF Level
1.	 Push [MENU].
2.	 Select “DV Set” in the “SET” menu.

[MENU] > SET > DV Set > EMR
Example: Transmitting from the “Hirano” repeater
using the EMR function.
1.	 Push [MENU].
2.	 Select “DV Set” in the “SET” menu.
3.	 Select “EMR AF Level.”

3.	 Select “EMR.”
4.	 Rotate [DIAL] to adjust the EMR audio output level
between 0 (OFF) and 39 (maximum). (Default: 19)

4.	 Select “ON.”

LLTo exit the MENU screen, push [MENU].

5.	 Push [MENU].

•• Returns to the Standby screen and “EMR” is displayed.

Push [PTT].

•• The TX/RX indicator lights red while transmitting.
LL“EMR” blinks on a station that receives the EMR
signal. The audio (voice) is heard at the set level, or
the [VOL] level, whichever is higher.
LLTo cancel the EMR mode, select “OFF” in step 4, or
turn OFF the transceiver.
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Automatic DV detection
If you receive an FM signal while in the DV mode, the
“DV” and “FM” icons alternately blink to indicate the
received signal is FM.
When the DV Auto Detect function is ON, the
transceiver automatically selects the FM mode to
monitor it temporarily. (Default: OFF)

[MENU] > SET > DV Set > DV Auto Detect
1.	 Push [MENU].
2.	 Select “DV Set” in the “SET” menu.

LLRegardless of this setting, the “DV” and “FM” icons
alternately blink if you receive an FM signal while in the
DV mode.

NOTE: When Digital Call Sign squelch (DSQL),
or Digital Code squelch (CSQL) is selected, the
transceiver does not receive FM signals, even if this
function is ON. You can silently wait for calls from
others.

3.	 Select “DV Auto Detect.”

4.	 Select “ON.”

LLTo exit the MENU screen, push [MENU].
LLWhen an FM signal is received while in the DV mode,
the “DV” and “FM” icons sequentially blink, and the
transceiver receives the signal in the FM mode.

When an FM signal is received while in the DV mode
DV Auto Detect function: OFF
The “DV” and “FM” icons alternately blink, but the
audio cannot be heard.

DV Auto Detect function: ON
The “DV” and “FM” icons alternately blink, and the
audio can be heard.

Thanks for
the nice QSO!

● ● ●

The icons
alternately blink.

The icons
alternately blink.

You cannot hear
the audio.
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Automatic Reply function
When a call addressed to your call sign is received,
the Automatic Reply function sounds beeps and
automatically replies with your call sign.
(Default: OFF)
Depending on the setting, a recorded message may
be transmitted with the call sign.
NOTE: The Automatic Reply function temporarily
sets the received call sign to “TO” (destination).
TIP: To record the Auto Reply message
You can record the Auto Reply message. See page
5-25 for details.
([MENU] > RECORD > DV Auto Replay)
[MENU] > SET > DV Set > Auto Reply
1.	 Push [MENU].
2.	 Select “DV Set” in the “SET” menu.

5.	 Push [MENU].

•• Returns to the Standby screen, and displays “
.”
LLWhen “ON” or “Voice” is selected, the Automatic
Reply function is automatically turned OFF when you
push [PTT].
When “Position” is selected, the Automatic Reply
function remains ON, when you push [PTT].

Example: After receiving a call from “JM1ZLK,” beeps
sound, and the transceiver automatically
sends a reply call.

3.	 Select “Auto Reply.”

4.	 Select an option.

The “TO” setting does not change, but “UR:
JM1ZLK (Caller’s call sign)” is displayed.

•• ON:	Automatically replies with your own
call sign. (No audio reply is sent)
•• Voice:	Automatically replies with your own
call sign and an Auto Reply message
recorded on the microSD card (up to
10 seconds).

LLIf no SD card is inserted, or no message
is recorded, replies with only your own
call sign (No audio reply is sent).

•• Position:	Automatically replies with your call
sign and your position data using the
internal GPS receiver.
LLWhen “GPS Select” is set to “OFF” or
“Manual,” the internal GPS receiver is
temporarily turned ON.
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Automatic Reply function

DRecording
D
an Auto Reply message

The DV AUTO REPLY screen
		

You can record the Auto Reply message that is saved
on a microSD card to reply to the call with your voice.
NOTE: Confirm a microSD card is in the card slot.
[MENU] > RECORD > DV Auto Reply

1.	 Push [MENU].
2.	 Select “DV Auto Reply” in the RECORD menu.

Audio level is
displayed

Adjust the Mic gain so that the REC
Level does not reach to this range
([MENU] > SET > Function > MIC Gain
(Internal), MIC Gain (External))

TIP: To delete the recorded message, push [QUICK]
on the DV AUTO REPLY screen, then select “Clear.”
		
3.	 Hold down [PTT] to start a recording, release it to
stop recording.

LLInformation

•• The maximum recording time is 10 seconds.
•• Hold the microphone 5 ~ 10 cm (2 ~ 4 inches) from your
mouth, then speak at your normal voice level.
•• Only 1 message can be recorded. The current contents are
overwritten if you record again.

4.	 To exit the MENU screen, push [MENU] twice.

5-25

5

D-STAR OPERATION (ADVANCED)

Automatic Reply function

DAuto
D
Position Reply function

1.	 A call addressed to your
call sign.

When you receive a call addressed to your call sign,
but are in a situation that makes it difficult to operate
the transceiver, this function sounds beeps and
automatically replies with your call sign and transmits
your position data.

JA3YUA
2.	 Your position data
is automatically
Your station
transmitted.

After receiving the Auto Position Reply call, the
caller’s position data is displayed in a window.

LLIcom transceivers* display the position after receiving a
call.
LLYou can turn OFF the caller’s position display. (p. 12-26)
([MENU] > SET > Display > Reply Position Display)
* Except for the ID-31A/E, IC-9100, ID-880H/E880, IC80AD/E80D, IC-92AD/E92D, IC-2820H/E2820, ID-800H,
IC-91AD/E91, IC-V82, IC-U82

Destination
(ID-52A/E)

3.	 After receiving, the position data
is displayed on the
destination’s transceiver.

Scrolls your call sign or the TX message.
LLYour status message may be displayed.

When no valid position data is received
After receiving a call addressed to your call sign,
the internal GPS receiver is temporarily turned ON
for approximately 5 minutes to receive your position
data, even if “GPS Select” is set to “OFF” or “Manual.”
Then, the transceiver automatically replies with a
message, as described below.
([MENU] > GPS > GPS Set > GPS Select)
LLWhen the internal GPS receiver is temporarily ON, and
valid position data is received, the transceiver transmits
your position data if a call addressed to your call sign is
received again.

TIP:
•• The position data is transmitted according to the
“GPS TX Mode.” (p. 6-12)
•• When the “GPS TX Mode” settings are incorrect
for the Automatic Reply function, the transceiver
automatically corrects them to reply to a call.
•• When “GPS TX Mode” is set to “OFF,” “D-PRS” is
automatically selected.

Reply message list when no valid position data is
received
Message

Status

No Position

When no position data is
received.

Old Position

2 minutes or more has passed
since receiving position data.

No Posi & GPS Start

The internal GPS receiver is
temporarily turned ON but has
not received your position data
yet.

Old Posi & GPS Start

The internal GPS receiver is
temporarily turned ON, and 2
minutes or more have passed
since receiving position data.
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Data communication
DData
D
communication application
setting

In addition to digital voice communication, you can
send and receive data. Also, you can use the DV Fast
Data function for data communication (p. 5-28)
To send and receive data, a USB cable (purchase
separately or user supplied), and a data
communication software (user supplied) are required.

Set the communication software, as shown below.
•• Port:	The COM port number that is used by the
ID-52A/E *
•• Baud rate: Your desired speed
•• Data:
8 bit
•• Parity:
none
•• Stop:
1 bit
•• Flow control: Xon/Xoff
* Depending on the PC environment, the COM port number
used by the ID-52A/E may be higher than 5. In that case,
use an application that can set it to higher than 5.

NOTE: “DV Data TX” is set to “Auto” as the
default setting. When you enter text data into your
communication software, the transceiver may
automatically transmit it, depending on the software
and the software settings.

DConnection
D

Connect the transceiver to your PC using a USB
cable, as shown below.

DSending
D
data

1.	 Set your call sign, the destination call sign, and
the repeater call sign.
2.	 Follow the instructions of your data communication
application software.
3.	 When you enter text data into your communication
software, the transceiver may automatically
transmit it, depending on the software and its
settings.

Tranceiver

To the
[USB] port

PC
To the
USB port

LLWhen “DV Data TX” is set to “PTT,” pushing [PTT]
transmits the text data and a voice signal. (p. 12-10)
([MENU] > SET > DV Set > DV Data TX)
LLBefore transmitting the data, the transceiver sends a
carrier sense signal approximately 500 milliseconds.

USB cable
NOTE: Before you start sending data, BE SURE to
set the following items.

NOTE:
•• Only ASCII code can be used for data
communication.
•• The transceiver also has the Message
Transmission function that transmits up to 20
characters. (p. 5-17)
•• Depending on the combination of your PC and
your communication software, some data may be
lost.
•• While receiving voice or data through the Internet,
some packets may be lost due to network error
(poor data throughput performance) In such a
case, an “L” is displayed on the screen to indicate
that packet loss has occurred.

•• Set “GPS Out (USB Port)” to “OFF ”
([MENU] > GPS > GPS Set > GPS Out (USB Port))
•• Set “USB Connect” to “Serialport,”
([MENU] > SET > Function > USB Connect)
•• Set “USB Serialport Function” to “DV Data.”
([MENU] > SET > Function > USB Serialport Function)
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Data communication

About the display type

DDV
D Fast Data function

You can enlarge the characters, such as the repeater
name displayed by the DR function.

To send data using the DV Fast Data function, follow
the instructions below.

LLThis setting can be used only when the Single band
display is selected.

LLDV Fast Data communication can be made by only the
following Icom transceivers:
(As of November 2021)
•• IC-705
•• IC-9700
•• ID-31A/E PLUS
•• ID-4100A/E
•• ID-5100A/E*
•• ID-51A/E (PLUS, PLUS2, 50th Anniversary model)
•• ID-52A/E
* Usable only when firmware versions CPU M 1.10,
S 1.00, C 1.10, and DSP 1.10 or later are installed.

1.	 Display the Main screen that you want to change
in the Single band display.

2.	 Push [QUICK].
3.	 Select “Display Type.”

NOTE: If you want to send GPS data to other
transceivers that can receive only slow-speed data,
set “GPS Data Speed” to “Slow.” (p. 6-4)

([MENU] > SET > DV Set > DV Fast Data > GPS Data Speed)

[MENU] > SET > DV Set > DV Fast Data > Fast Data
1.	 Push [MENU]
2.	 Select “DV Set” in the “SET” menu.
4.	 Select “Large.”

3.	 Select “DV Fast Data.”

4.	 Select “Fast Data.”

•• The characters, such as the repeater name, are
displayed larger.

5.	 Select “ON.”

•• To exit the MENU screen, push [MENU].
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Digital squelch functions
DThe
D
Digital Code Squelch setting

The digital squelch opens only when you receive a
signal addressed to your own call sign or a signal that
includes a matching digital code.
You can silently wait for calls from others.
You can independently set the Digital squelch function
in the VFO mode, Memory mode, Call channel mode,
or DR function.

1.	 Push [QUICK].
2.	 Select “D.SQL.”

DThe
D
Digital Call Sign squelch setting
1.	 Push [QUICK].
2.	 Select “D.SQL.”

3.	 Select “CSQL.”

3.	 Select “DSQL.”
“DSQL” is displayed.

4.	 Push [MENU].
5.	 Select “DUP/TONE...” in the “SET” menu.
6.	 Select “Digital Code.”

“DSQL” is displayed.

•• When the received signal includes a matching call
sign, the squelch opens, and you can hear the audio.
LLWhen the received signal does not include a
matching call sign, the digital call sign squelch does
not open. However, the S/RF meter displays the
received signal level.

7.	 Rotate [DIAL] to select a digital code.

NOTE:
•• DO NOT use the Digital Call Sign Squelch
function when communicating with 2 or more
stations, because it opens only when receiving a
signal addressed to your call sign. Therefore the
function can be used when communicating with
only 1 station.
•• Even if the squelch is closed by the Digital Call
Sign Squelch function, you can receive data in the
DV mode.

•• When the received signal includes a matching code,
the squelch opens, and you can hear the audio.
LLWhen the received signal does not include a matching
code, the digital code squelch does not open.
However, the S/RF meter displays the signal level.
LLTo exit the MENU screen, push [MENU].

NOTE: Even if the squelch is closed by the Digital
Code Squelch function, you can receive data in the
DV mode.
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Repeater list
Example: “Hirano” repeater information

You can save repeater information for quick and
simple communication in up to 2500 repeaters
(repeater list) in up to 50 Groups.
Data must be in the repeater list to use the DR
function.
You can add and edit repeater content and groups in
the repeater list.
You can enter 4 types of frequencies into the repeater
list, as shown below:
•• DV Repeater
•• DV Simplex
•• FM Repeater
•• FM Simplex

TIP:
•• For easy operation, the repeater list is preloaded
into your transceiver. However, if you do an
All Reset, the CPU deletes all setting data, the
Memory channels, and the repeater list. We
recommend that you back up the memory data to
a microSD card or save it to a PC using the CS-52
programming software.
•• The repeater list can be downloaded from the Icom
website. See “Updating the repeater list” that can
be downloaded from the Icom website about how
to update the repeater list using a microSD card.
https://www.icomjapan.com/support/

DRepeater
D
list contents

The following contents are included in the repeater list:

•• TYPE:
Communication type (p. 5-32)
•• NAME:
Repeater name (p. 5-32)
•• SUB NAME:
Repeater sub name (p. 5-32)
•• CALL SIGN:	Repeater call sign and port letter
(p. 5-32)
•• GW CALL SIGN:	Gateway repeater’s call sign and port “G”
(p. 5-32)
•• GROUP:
Repeater group (p. 5-33)
•• USE (FROM):
access repeater use (p. 5-33)
•• FREQUENCY:
access repeater’s frequency (p. 5-33)
•• DUP:
Duplex direction (p. 5-33)
•• OFFSET FREQ: Frequency offset (p. 5-33)
•• MODE:
Operating mode (p. 5-34)
•• TONE:
Tone setting (p. 5-34)
•• REPEATER TONE: Repeater tone (p. 5-34)
•• POSITION:
Position data accuracy level (p. 5-34)
•• LATITUDE:
Latitude of the repeater (p. 5-34)
•• LONGITUDE:
Longitude of the repeater (p. 5-35)
•• UTC OFFSET:
UTC Offset (p. 5-35)
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Entering new information into the repeater list
This section describes how to manually enter new
repeater information into the repeater list.
The required setting items differ, depending on your
communication usage. Confirm the required items, as
shown below.
NOTE: To enter repeater information into the
repeater list, the repeater’s call sign must be entered
first.

DRequired
D
items for the communication cases
Repeater list
contents

TYPE

Used as an access
Used as a
repeater
destination repeater

DV Repeater

NAME
SUB NAME
CALL SIGN
GW CALL SIGN

○
○
●
●

(For a Gateway call)

DV Repeater

Used as an FM
repeater

FM Repeater

○
○
●

DV Simplex

FM Simplex

N/A

N/A

N/A

N/A

N/A

○
●
●

○
●
●

N/A

N/A

N/A

N/A

N/A

○
○

○
○
○

●

Simplex (FROM)

○
○

○
○

○
●
●
●
●

○
○
○
○
○

MODE

N/A

N/A

TONE

N/A

N/A

○
●
●
●
●
○
○

REPEATER
TONE

N/A

N/A

○

N/A

○

○
○
○
○

○
○
○
○

○
○
○
○

○
○
○
○

○
○
○
○

GROUP
USE(FROM)
FREQUENCY
DUP
OFFSET FREQ

POSITION
LATITUDE
LONGITUDE
UTC OFFSET

●:		
○:		

Must be entered
Possible to enter
N/A: Not Applicable

5-31

N/A

5

D-STAR OPERATION (ADVANCED)

Entering new information into the repeater list

DEntering
D
new information into the repeater list
Step 4. Entering the repeater sub name
1.	 Select “SUB NAME.”
2.	 Enter a sub name of up to 8 characters.

Step 1. Selecting the repeater group
[MENU] > MEMORY > Repeater List
1.	 Push [MENU].
2.	 Select “MEMORY” on the second page of the
MENU screen.
3.	 Select “Repeater List.”

LLSee page iii on how to enter characters.

3.	 After entering, push [ENT].

Step 5. Entering the repeater call sign
LLWhen Step 2. Selecting the communication type
is set to “DV Simplex” or “FM Simplex,” go to Step
7. Changing the repeater group.
1.	 Select “CALL SIGN.”
2.	 Enter the repeater call sign of up to 8 characters,
including spaces and the node letter.

4.	 Select a repeater group to add a repeater to.

NOTE: BE SURE to add the repeater node letter
in the 8th digit of the call sign, according to the
frequency band shown below. Note that there
are almost always different node letters between
Japanese D-STAR repeaters and repeaters in
other countries.
Cross band operation between different nodes at
the same repeater site can be made.

•• Displays the repeater list of the selected repeater group.

•• 1200 MHz: A (B in Japan)
•• 430 MHz: B (A in Japan)
•• 144 MHz: C (no repeaters in Japan)

5.	 Push [QUICK].
6.	 Select “Add.”

3.	 After entering, push [ENT].
Step 6. Entering the gateway repeater call sign
LLThis item is displayed when Step 2. Selecting the
communication type is set to “DV Repeater.”
LLThe 8th digit in the call sign entered in Step 5.
Entering the repeater call sign is automatically
set to “G” as the gateway port, so you can skip this
setting and go to the next item.
1.	 Select “GW CALL SIGN.”
2.	 Enter a gateway repeater call sign of up to 8
characters, including spaces.

•• The REPEATER LIST EDIT screen is displayed.

Step 2. Selecting the communication type
1.	 Select “TYPE.”
2.	 Select the communication type.
•• DV Repeater:
•• DV Simplex:
•• FM Repeater:
•• FM Simplex:

LLOnly a space or “G” can be entered in the 8th digit.

Repeater operation in the DV mode.
Simplex operation in the DV mode.
Repeater operation in the FM mode.
Simplex operation in the FM mode.

Step 3. Entering the repeater name
1.	 Select “NAME.”
2.	 Enter a name of up to 16 characters.

LLSee page iii on how to enter characters.

3.	After entering, push [ENT].

3.	 After entering, push [ENT].
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Entering new information into the repeater list
DDEntering new information into the repeater list
Step 10. Selecting the Duplex direction
LLWhen Step 2. Selecting the communication type
is set to “DV Simplex” or “FM Simplex,” this item is
not displayed.
LL“DUP–” is automatically set when the access
repeater frequency is entered in Step 9. Entering
the access repeater frequency. If necessary, you
can change the Duplex direction.
1.	 Select “DUP.”
2.	 Select a Duplex direction.

Step 7. Changing the repeater group
LLThe repeater group that is selected in Step 1.
Selecting the repeater group is displayed. You can
skip this setting and go to the next item. To change
the group, follow the steps described below.
1.	 Select “GROUP.”
2.	 Select the repeater group. (01 ~ 50)

Step 8. S
 etting “USE(FROM)” to be used as an
access repeater
LLYou can use the entered repeater as an access
repeater when using the DR function. When not
using as an access repeater, select “NO,” and go
to Step 15. Selecting the position data accuracy
level. In that case, the entered repeater is not
displayed in “FROM” on the DR screen.
1.	 Select “USE(FROM).”
2.	 Select “YES” to use the repeater as an access
repeater.

•• OFF: Turn the duplex function OFF.
•• DUP–:	The transmit frequency shifts down from the
receive frequency by the offset amount.
•• DUP+:	The transmit frequency shifts up from the
receive frequency by the offset amount.

Step 11. Entering the frequency offset
LLWhen Step 2. Selecting the communication type
is set to “DV Simplex” or “FM Simplex,” this item is
not displayed.
LLThe offset value* is automatically set when the
access repeater frequency is entered in Step
9. Entering the access repeater frequency. If
necessary, you can change the frequency offset.
* The default value differs, depending on the transceiver
version.

1.	 Select “OFFSET FREQ.”
2.	 Rotate [DIAL] to enter the frequency offset
(0.000.00 ~ 59.995.00 MHz).

Step 9. Entering the access repeater frequency
1.	 Select “FREQUENCY.”
2.	 Rotate [DIAL] to enter the repeater frequency.

LLPush D-pad() to move the cursor.

3.	 After entering, push [ENT].

LLPush D-pad() to move the cursor.

3.	 After entering, push [ENT].
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Entering new information into the repeater list
DDEntering new information into the repeater list
Step 15. Selecting the position data accuracy level
LLWhen the Near Repeater Search function is not
used, or the distance between your location and
a repeater is not needed, select “OFF,” and go to
Step 18. Setting the UTC offset.
1.	 Select “POSITION.”
2.	 Select the position data accuracy level.

Step 12. Setting the FM mode
LLWhen Step 2. Selecting the communication type
is set to “DV Repeater” or “DV Simplex,” this item is
not displayed.
1.	 Select “MODE.”
2.	 Select “FM” or “FM-N.”

Step 13. Setting the tone
LLWhen Step 2. Selecting the communication type
is set to “DV Repeater” or “DV Simplex,” this item is
not displayed.
1.	 Select “TONE.”
2.	 Select an option.

•• None:		Select when the repeater has no
position data.
•• Approximate:	Select when the entered position data
is approximate.
•• Exact:	Select when the entered position data
is exactly correct.

Step 16. Entering the latitude
LLThis item is displayed only when Step 15.
Selecting the position data accuracy level is set
to “Approximate” or “Exact.”
1.	 Select “LATITUDE.”
2.	 Rotate [DIAL] to enter the latitude.
•• OFF: Turn OFF the Tone function.
•• TONE:	Select when the repeater requires an access
tone.
•• TSQL:	Select when you want to use the tone
squelch in simplex operation.

Step 14. Selecting the repeater tone frequency
LLWhen Step 2. Selecting the communication type
is set to “DV Repeater” or “DV Simplex,” this item is
not displayed.
LLThis setting is required when Step 13. Setting the
tone is set to “TONE” or “TSQL.”
1.	 Select “REPEATER TONE.”
2.	 Rotate [DIAL] to select the repeater tone
frequency, and then push [ENT].

LLPush D-pad() to move the cursor.
LLTo enter a north latitude, select “N,” and to enter a
south latitude, select “S.”

3.	 After entering, push [ENT].
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Entering new information into the repeater list
DDEntering new information into the repeater list
Step 19. Saving the repeater list

Step 17. Entering the longitude
LLThis item is displayed only when Step 15.
Selecting the position data accuracy level is set
to “Approximate” or “Exact.”
1.	 Select “LONGITUDE.”
2.	 Rotate [DIAL] to enter the longitude.

1.	 Select “<<Add Write>>.”

•• The confirmation dialog is displayed.

2.	 Select “YES.”

•• The entered contents are saved to the repeater list,
and the display returns to the selected repeater group
screen.

LLPush D-pad() to move the cursor.
LLTo enter an east longitude, select “E,” and to enter a
west longitude, select “W.”

TIP: To cancel the entered data
1.	 Push [CLR] to display the “Cancel edit?” window.
2.	 Select “YES.”

3.	 After entering, push [ENT].

Step 18. Setting the UTC offset
LLUniversal Time Coordinated (UTC) offset is the time
difference between UTC and repeater local time.
This is a useful function to know the repeater’s local
time before you make a call. (p. 5-13)
1.	 Select “UTC OFFSET.”
2.	 Rotate [DIAL] to set the time difference between
UTC and the local time, then push [ENT].

•• Cancels the entry and returns to the selected
repeater group screen.
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Repeater list operation
DEditing
D
repeater data

DDeleting
D
repeater data

You can edit repeater data. This is useful when
already-entered data is incorrect, has changed, or
some data needs to be added to the list.

[MENU] > MEMORY > Repeater List
1.	 Push [MENU].
2.	 Select “MEMORY” on the second page of the
MENU screen.
3.	 Select “Repeater List.”

[MENU] > MEMORY > Repeater List
1.	 Push [MENU].
2.	 Select “MEMORY” on the second page of the
MENU screen.
3.	 Select “Repeater List.”

4.	 Select a repeater group where the repeater you
want to delete is listed.
4.	 Select a repeater group where the repeater you
want to edit is listed.

5.	 Select the repeater to be deleted, and then push
[QUICK].
6.	 Select “Delete.”

5.	 Select a repeater you want to edit, and then push
[QUICK].
6.	 Select “Edit.”

•• The confirmation dialog is displayed.

7.	 Select “YES.”
7.	 Select an item, and then edit it.

LLSee pages 5-32 ~ 5-35 for details.

8.	 After editing, select “<<Overwrite>>.”

•• The selected repeater contents are deleted from the
repeater list and return to the selected repeater group
screen.
LLTo exit the MENU screen, push [MENU].

•• The confirmation dialog is displayed.

NOTE: The currently selected repeater on the DR
screen cannot be edited or deleted. To edit or delete
the repeater, select another repeater on the DR screen.

9.	 Select “YES.”

•• The edited contents are saved to the repeater list and
return to the selected repeater group screen.
LLTo exit the MENU screen, push [MENU].
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Repeater list operation

DRearranging
D
the display order of the repeaters
You can move the entered repeaters to rearrange their
display order in the selected repeater group.
[MENU] > MEMORY > Repeater List
1.	 Push [MENU].
2.	 Select “MEMORY” on the second page of the
MENU screen.
3.	 Select “Repeater List.”

8.	 Select the position to insert the repeater you want
to move the repeater above.

LLWhile moving, “DESTINATION” blinks at the top left
of the screen.

4.	 Select a repeater group where the repeater you
want to move is listed.

5.	 Select the repeater to be moved.

•• The selected repeater is inserted above the
destination repeater name.
LLIf “<<Move End>>” is selected, the repeater is moved
to the bottom of the group.
LLTo exit the MENU screen, push [MENU].

LLDO NOT push [ENT].

6.	 Push [QUICK].
7.	 Select “Move.”
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Repeater list operation

DAdding
D
new repeater information from RX History
1.	 Hold down [CD] for 1 second.

8.	 Select “YES.”

•• The RX HISTORY screen is displayed.

2.	 Push D-pad() to display the repeater you want to
add to the repeater list, then push [ENT].

•• The repeater contents are added to the repeater list,
and the display returns to the RX HISTORY screen.
LLTo exit the RX HISTORY screen, push [MENU].
•• Displays the RX history detail screen.

3.	 Push D-pad() to display “RXRPT1” and “RXRPT2.”

4.	 Push [QUICK].
5.	 Select “Add To RPT List.”

6.	 Select the repeater call sign that you want to add
to the repeater list.

•• Displays the REPEATER LIST EDIT screen. The
selected repeater call sign is automatically entered.
LLIf the selected repeater is already in the repeater list,
“Duplicate Call Sign” is displayed.
LLSee pages 5-32 ~ 5-35 to edit the contents.

7.	 Select “<<Add Write>>.”

•• The confirmation dialog is displayed.
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Repeater list operation

DSkip
D
setting for the DR scan

You can set repeaters as scan skip repeaters. The
selected repeaters are skipped for faster scanning.
You can set the skip setting to all repeaters in the
selected repeater group or individual repeaters.

LLWhen a repeater is set as a skip repeater, its “USE
(FROM)” setting is automatically set to “NO.” In that
case, the repeater cannot be selected in “FROM” (access
repeater) on the DR screen.

<Group skip setting>
1.	 On the REPEATER GROUP screen, select a
repeater group, as described to the left.
2.	 Push [QUICK], then select “SKIP All ON” to skip
the group’s repeaters during the DR scan.

<Individual skip setting>
[MENU] > MEMORY > Repeater List
1.	 Push [MENU].
2.	 Select “MEMORY” on the second page of the
MENU screen.
3.	 Select “Repeater List.”

LLTo cancel the skip settings in the group, select “SKIP
All OFF.”

TIP:

•• When you select “Repeater List” on the FROM SELECT
screen, you can set the skip setting as described to the
left.
•• When “FROM” is selected on the DR screen, push
[QUICK] to set the skip setting, as shown below.

4.	 Select a repeater group where the repeater you
set the skip setting is listed.

5.	 Select the repeater to be skipped, and then push
[QUICK].
6.	 Select “SKIP.”

LLDisplays “SKIP” in the “FROM” field.

LLDisplays “SKIP” by the selected repeater.

LLSelect “SKIP” again to cancel the skip setting.
LLSelect “SKIP All ON” to set the skip setting to all
repeaters in the group.
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Repeater list operation

DEntering
D
or editing a repeater group name
[MENU] > MEMORY > Repeater List

8.	 After entering [ENT].

1.	 Push [MENU].
2.	 Select “MEMORY” on the second page of the
MENU screen.
3.	 Select “Repeater List.”

•• Sets the entered name.
LLTo exit the MENU screen, push [MENU].

4.	 Select a Repeater group that you edit the name.

LLDO NOT push [ENT].
LLIf you select an already named group, the name is
overwritten.

5.	 Push [QUICK].
6.	 Select “Edit Name.”

7.	 Enter a group name of up to 16 characters.

Selectable characters and symbols
A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * + , - . / : ; < = > ?
@ [ \ ] ^ _ ` { | } ˜ (space)
LLSee page iii on how to enter characters.
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Your Call Sign
DEntering
D
Your Call Sign

9.	 Select “CALL SIGN.”

You can manually enter a Your (destination) Call Sign.
When a Your Call Sign is entered into “TO,” you can
make a call to the station, even if you do not know
where the station is currently located.
Up to 300 “Your Call Signs” can be entered.
[MENU] > MEMORY > Your Call Sign

10.	Enter a call sign of up to 8 characters, including
spaces.

Example: E
 ntering “Rick/JM1ZLK” to the Your Call
Sign memory.
1.	 Push [MENU].
2.	 Select “MEMORY” on the second page of the
MENU screen.
3.	 Select “Your Call Sign.”

11.	 After entering, push [ENT].
12.	Select “<<Add Write>>.”

4.	 Push [QUICK] on the YOUR CALL SIGN screen.
5.	 Select “Add.”
•• The confirmation dialog is displayed.

13.	Select “YES.”

6.	 Select “NAME.”

7.	 Enter a station name of up to 16 characters.

•• “Rick JM1ZLK” is entered into the Your Call Sign
memory.
LLTo exit the MENU screen, push [MENU].

LLSee page iii on how to enter characters.

8.	 After entering, push [ENT].
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Your Call Sign

DDeleting
D
Your Call Sign

DDEntering Your Call Sign
TIP:
To cancel the entered call sign
1.	 Push [CLR] to display the “Cancel edit?” window.
2.	 Select “YES” to cancel the entry and return to
the YOUR CALL SIGN screen.

[MENU] > MEMORY > Your Call Sign
1.	 Push [MENU].
2.	 Select “MEMORY” on the second page of the
MENU screen.
3.	 Select “Your Call Sign.”

4.	 Select a call sign you want to delete.
To edit the entered call sign
To edit the entered call sign, select “Edit” in step 5.
This is useful when already-entered data is incorrect,
has changed, or some data needs to be added to the
list.
		

LLDO NOT push [ENT].

5.	 Push [QUICK].
6.	 Select “Delete.”

•• A confirmation dialog is displayed.

7.	 Select “YES.”

•• The selected call sign is deleted from the Your Call Sign
list and the returns to the YOUR CALL SIGN screen.
LLTo exit the MENU screen, push [MENU].

NOTE: The currently selected Your Call Sign on the
DR screen cannot be edited or deleted. To edit or
delete the Your Call Sign, select another Your Call
Sign on the DR screen
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Your Call Sign

DRearranging
D
the display order of
Your Call Signs

You can move Your Call Signs to rearrange their
display order.
If the stations you often communicate with are moved
to the top of the list, it is easy to find them.
[MENU] > MEMORY > Your Call Sign
Example: Moving “Rick” above “Eddy.”
1.	 Push [MENU].
2.	 Select “MEMORY” on the second page of the
MENU screen.
3.	 Select “Your Call Sign.”

7.	 Select the position to insert the Your Call Sign you
want to move the call sign above.

LLWhile moving, “DESTINATION” blinks at the top left
of the screen.

4.	 Select a Your Call Sign to be moved.

LLDO NOT push [ENT].

•• The selected call sign is inserted above the
destination call sign.
LLIf “<<Move End>>” is selected, the Your Call Sign is
moved to the bottom of the group.
LLTo exit the MENU screen, push [MENU].

5.	 Push [QUICK].
6.	 Select “Move.”
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Are your settings correct?
If you make a Local Area call with a gateway repeater
still selected in “TO,” the destination repeater will be
busy while you transmit.
The stations that want to use the repeater as their
access repeater cannot access it, as shown below.
BE SURE to set CQCQCQ in “TO” on the DR screen
when you intend to make a Local Area call or finish a
Gateway call.
Example: JA3YUA wants to make a Local Area call.

CQ D-STAR Hirano, this is JA3YUA
through JP3YHH port A for a local call���

Caller
(JA3YUA)

His setting is wrong!
I can’t access the repeater!
INTERNET

A
s
is i
ort
, th H p
ano 3YH
r
i
JP
RH
TA ugh
D-S A thro ll���
Q
C YU l ca
3
a
JA a loc
for

Called

Hirano area

CQ
D
JA3 -STAR
Y
for a UA thr Hirano
, this
loca ough
is
l ca
ll��� JP3YH
Hp
ort

A

Hamacho area

JA3YUA’s setting

NOTE: With this setting, you can make a Local Area
call, but the destination Repeater, selected in “TO,”
is also busy while you transmit.
The stations that want to use the repeater as their
Access Repeater cannot access it.

The destination (“TO”) setting is incorrect.
Correct setting

To make a Local Area call, set the destination (“TO”)
to “CQCQCQ.” See page 5-9 for details.
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GPS operation features
D-PRS Extension function (p. 6-4)
The D-PRS Extension function enables you to transmit or receive Object, Item, and Weather information in addition
to Position data. With this extension, you can simultaneously transmit or receive earthquake information, traffic
accident information, emergency information, or weather information, and so on, along with voice audio in the DV
mode.
GPS Memory (p. 6-22)
You can enter up to 300 GPS Memories in the transceiver. By adding destination position information in a GPS
Memory, you can effectively use the GPS Alarm function. The position information that you acquired can also be
entered in a GPS Memory.

I can enter the location information
of the mountain I’m going to hike!

Editing GPS Memories using
a PC is easier than using
the transceiver!

GPS Alarm function (p. 6-27)
When a target station comes into the set alarm area, or when you approach an entered GPS Memory position, the
function can sound an alarm. With this function, you can know that you are approaching the destination.
GOAL!

I’m almost there!

GPS Logger function
The GPS Logger function enables you to save the position data from a GPS receiver into a microSD card as a log.
If you use this GPS Logger while driving, you can check your driving history on a mapping software program.
I can track my GPS log in a
mapping software program.
This is how I traveled...interesting!

See “Using the GPS Logger function” that can be downloaded from the Icom website about using the function.
https://www.icomjapan.com/support/
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Before starting GPS operation
NOTE: Before using the GPS function, read “IMPORTANT NOTES” about the GPS receiver in the Basic manual.

The transceiver has a built-in internal GPS receiver.
The GPS receiver’s position data can be received in
any mode.

NOTE: Continuously using the Internal GPS mode
causes the transceiver’s battery to be exhausted
quickly. Turn ON the Power Save mode if needed.
See page 6-30 for details.
([MENU] > GPS > GPS Set > GPS Option
> Power Save)

NOTE: Transmit or receive position data that can be
transmitted in only the DV mode.

DConfirming
D
the GPS signal receiving

TIP: To prolong the battery life in the GPS mode
Manually update your location with the received GPS
data.

Confirm the GPS receiver is receiving satellite signals.
The GPS icon blinks when searching for satellites.
→
→
→
	The GPS icon stops blinking when the minimum
number of satellites needed is found.

1.	 Set “GPS Select” to “ON,” and receive your
position from the internal GPS receiver.
([MENU] > GPS > GPS Set > GPS Select)
2.	 Open the MANUAL POSITION screen, and then
push [QUICK].
([MENU] > GPS > GPS Set> Manual Position)
3.	 Select “Capture From GPS.”

LLInformation

•• It may take only a few seconds to receive, or it may take
a few minutes, depending on your operating environment.
If you have difficulties receiving, we recommend that you
try a different position.
•• When “GPS Select” is set to “Manual,” the icon is not
displayed.
([MENU] > GPS > GPS Set > GPS Select)

•• Your current position is now memorized and
displayed on the MANUAL POSITION screen.

4.	 Set “GPS Select” to “Manual.”
([MENU] > GPS > GPS Set > GPS Select)
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GPS TX mode and TX format types
Example: When the caller’s TX format is D-PRS
Position (Mobile)
([MENU] > GPS > GPS Position)

GPS position data has 2 TX modes, D-PRS, and
NMEA. Moreover, with the D-PRS mode data, 5
position formats, Position (Mobile station/Base
station), Object, Item, and Weather, are selectable.

D-PRS

D-PRS is a function that simultaneously sends position data received from the
internal GPS receiver, using the slow speed data packet space, along with voice.

Position (Mobile)

A station operating from a vehicle, or other position, away from its normal base
position.

Position (Base)

A station operating at home or in a building.

Object

Transmitting Object data such as earthquake information, satellite tracking
information, and so on.
An Object contains a time stamp.

Item

Transmitting Item data such as a traffic accident, lighthouse, antenna, or DV
access point position, and so on.
An Item does not contain a time stamp.

Weather

A station transmitting weather information received from a weather device.

NMEA

A station transmitting position data (NMEA0183) received from the internal GPS
receiver.

Difference between older models


(As of November 2021)
•• The GPS TX mode, “GPS (DV-G)” and “GPS-A (DV-A),” are now called as “NMEA (DV-G)” and “D-PRS (DVA).”
GPS (DV-G) → NMEA (DV-G)
GPS-A (DV-A) → D-PRS (DV-A)
•• For users who have one of the following models:
ID-800H, IC-91AD/E91, IC-U82, IC-V82, IC-7100, ID-51A/E, ID-31A/E, IC-9100, IC-80AD/E80D, ID-880H/E880,
IC-92AD/E92D, IC-2820H/E2820
When you receive a D-PRS position (Base), Object, Item, or Weather information, their data is not displayed.
•• Only the ID-51A/E PLUS, ID-51A/E PLUS2, ID-31A/E PLUS, ID-5100A/E, ID-4100A/E, IC-R30, IC-9700, IC-705,
and ID-52A/E can receive Power, Height, Gain, and Directivity data.
•• For users who have one of the following models:
IC-9100, IC-80AD/E80D, ID-880H/E880, IC-92AD/E92D, IC-U82, IC-V82
If you transmit with the Altitude setting ON, the character string is included in a comment on the products that
cannot display the altitude.
•• Set the GSV sentence to OFF when sending the GPS message to conventional digital transceivers (IC-2820H/
E2820, ID-800H, IC-91AD/E91, IC-V82, IC-U82, IC-2200H). The GSV sentence is incompatible with them.
They will not display GPS messages properly if sent as a GSV sentence from the ID-52A/E.
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When a received signal
contains position data

Checking your location
You can check your current location.
This section is described using received position data.

When a received signal contains position data, the
caller’s position data is displayed on the RX position
screen.
See to the right for details.

LLThe screens are just examples.

DDisplaying
D
Position Data

1.	 Push [QUICK].
2.	 Select “GPS Position.”

Example: W
 hen the signal from JM1ZLK contains
position data.

•• Opens the GPS POSITION screen.

3.	 Rotate [DIAL].

•• Changes between the MY (My position), RX
(Received position), MEM (GPS Memory position), or
ALM (GPS Alarm position) screen.

When you receive the signal, the RX
position data is displayed in the RX position
window.
The displayed icon depends on the type of
screen (MY, RX, MEM, or ALM).

After a few seconds, the window
disappears.

4.	 To close the GPS POSITION screen, push
[MENU].
NOTE: Latitude, longitude, and altitude data may
differ, depending on your received GPS signal.

RX position icon

TIP:

•• If you transmit with the GPS POSITION screen open,
the screen closes. To check the location, push [QUICK],
and then select “GPS Position” while transmitting.
•• On the MY screen or RX screen, you can enter the
displayed position information in a GPS Memory by
pushing [QUICK] and select “GPS Memory.”
•• See page 6-22 about the GPS Memory function and
see page 6-27 about the GPS Alarm function.

When the received signal contains position
data, the RX position icon is displayed, as
shown above.
LLYou can turn OFF the caller’s position data display.
([MENU] > SET > Display > RX Position Display)
LLYou can turn OFF the RX position icon indication.
([MENU] > SET > Display > RX Position Indicator)

6-5

6

GPS OPERATION (ADVANCED)

Checking your location

DGPS
D
POSITION screens and their meanings
Example for the GPS POSITION screens:

LLInformation

•• Pushing to [QUICK], change the compass direction.
(p. 6-10)
•• About the Course (p. 6-8)
•• About the Grid Locator (p. 6-9)

GPS Memory:
Tokyo Skytree
251 mi
248 mi

GPS Alarm:
Tokyo Big Sight

107 mi
Your station
Course: 0 degrees
Speed: 2.3 mph

MY screen (Your position information)
When “GPS Select” is set to “Manual,” the compass
heading and course direction are not displayed.
(p. 6-30) ([MENU] > GPS > GPS Set > GPS Select)

MEM screen (GPS Memory’s information)

Latitude
Longitude
Grid Locator
Altitude
Speed
Received
time

Your course
heading
Course direction

Call station
(D-PRS: mobile)
Course: 95 degrees
Speed: 5.6 mph

Direction from your
location

*

RX screen (Callerʼs position information)
Depending on the callerʼs GPS TX Mode and TX
format, the displayed itemʼs meanings may differ, and
some data may not be displayed. (p. 6-7)
Example: The caller stationʼs GPS TX Mode is “D-PRS,”
and its TX format is “Position (Mobile).”

ALM screen (GPS Alarm’s information)

Distance from your
position

Direction from
your location
D-PRS symbol

*

Distance from
your location
Caller’s call sign with SSID

Caller’s Course
direction
Time the caller
acquired the
position data

* When a name is not entered in the GPS Memory
channel, date and time are displayed instead of the
name. You can change the GPS Memory or GPS
Alarm in the GPS POSITION screen in the Quick
Menu window. (p. 6-9)

Caller’s speed
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Checking your location

DAbout
D
the RX screen
TX format:
D-PRS
Position (Mobile)

Moving symbol

Position (Base)

Base station symbol

For a mobile station,
Course and Speed
are displayed.

Object

For a base station, Output
power, Antenna height,
Antenna gain, and Antenna
direction are displayed.

Item

Time that the caller
sent the Object’s data.

LLFor an Item station, Time is not displayed.

Weather

Time that the caller
acquired the weather data.
LLCall sign is displayed with an SSID.
LLWhen the Object or Item is disabled, “KILLED” is displayed.

TX format:
NMEA
		

LLA symbol or SSID is not displayed when the TX format is NMEA.
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Checking your location

DSetting
D
the display type (MAIN/SUB)

DAbout
D
the Course

You can select the display type of the RX screen.

The course displayed on the GPS POSITION screens
is indicated in degrees.

1.	 Push [QUICK] when the RX screen is displayed.
2.	 Select “Display Select (MAIN/SUB).”

0°
315°

270°

3.	 Select the item you want to switch.

N

W

225°

E

S
180°

•• Latest (MAIN/SUB):	Displays the target station’s
latest location information
regardless of the MAIN band or
the SUB band.
•• MAIN:		Displays only the latest location
information of the target station
received in the MAIN band.
•• SUB:		Displays only the latest location
information of the target station
received in the SUB band.
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Checking your location

DAbout
D
the Grid Locator

DChanging
D
the GPS Memory or Alarm

Grid Locator (GL) is a position compressed into a 6
character code, calculated by the longitude and the
latitude.
The locator is simply calculated by dividing the earth’s
surface into squares.
It is used to find the location of a transceiver station.

You can change the GPS Memory or GPS Alarm in
the GPS POSITION screen.

1.	 While selecting the MEM screen or ALM screen,
push [QUICK].
2.	 Select “GPS Memory Select,” or select “Alarm
Select.”

Field

MEM screen

PM74SO
Square Subsquare

The grid locator map of Japan
44
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3.	 Select the GPS Memory or GPS Alarm to display
on the GPS POSITION screen.
LLAdding or editing a GPS Memory: p. 6-22
LLSetting the GPS Alarm: p. 6-27
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Checking your location

D Changing the Compass Direction

DSaving your own or a received
station’s position

You can set the compass direction to Heading
Up, North Up, or South Up�

You can save the position of your station or the
position of the caller station�
The transceiver has 300 GPS memories, and the
memories can be assigned to one of 27 banks, A ~ Z,
and (No Group)�

1� While displaying the GPS POSITION screen, push
[QUICK]�
2� Select “Compass Direction�”

1� Select the screen that you want to save�
L To save your own position: MY screen
L To save a received position: RX screen

2� Push [QUICK]�
3� Select “Add To GPS Memory�”
3� Select the compass direction�

L See pages 6-22 ~ 6-24 for entering details�

4� Select “<<Add Write>>�”
Heading Up

The top is always
your course direction�

North Up

South Up

The top is
always north�

The top is
always south�

L To select the destination group to be saved, select
“GROUP�”

5� Select “YES�”

• Saves the data in the GPS Memory, then returns to
the GPS POSITION screen�

6� To close the GPS POSITION screen, push
[MENU]�

TIP: The position is saved in the selected group in
the GPS MEMORY EDIT screen� (Step 4)
([MENU] > GPS > GPS Memory)
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Checking GPS information (Sky view screen)
This screen is used to view GPS satellite information
when the GPS icon does not stop blinking for a long
time.
The GPS Information displays the quantity, signal
power, and position of the satellites.
The sky view screen displays the position of the
satellites. The screen also displays each satellite’s
direction, elevation angle, satellite numbers, and their
receiving signal strength status.
1.	 Push [QUICK].
2.	 Select “GPS Information.”

Tracking
satellite
quantity

Sky view screen

Altitude
Latitude
Longitude

About the display

Satellite
number 19’s
signal is weak.

••
••

:
Untracking satellite.
:	Tracking satellite with a weak signal, shown
by the satellite number.
•• :	Tracking satellite with a strong signal, shown
by the satellite number.
•• SAT:
The quantity of tracking satellites.
•• Altitude:	The altitude of your station. The altitude is
only displayed when 4 or more satellites
are tracked. When 3 or less satellites are
tracked, “------ft” is displayed.
•• Longitude/Latitude:
	Longitude and Latitude of your station.

Satellite
number 06’s
signal is strong.

Untracking satellite

Elevation angle
0 degree line
Elevation angle
30 degree line
Elevation angle
60 degree line
Elevation angle
90 degree line
(Zenith)

TIP: The following satellite number is assigned to
the each satellite system.
•• GPS:
01 ~ 32
•• SBAS:
33 ~ 71
•• GLONASS: 65 ~ 96
•• QZSS:
193 ~ 202

The image of satellite number 06

3.	 To close the GPS INFORMATION screen, push
[MENU].

N

Elevation angle
90 degree line (Zenith) Elevation angle
60 degree line
Elevation angle
E 30 degree line
Elevation angle
0 degree line

Satellite
number 06

W
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GPS OPERATION (ADVANCED)

Transmitting D-PRS data
When D-PRS is selected as the GPS TX mode, you
can transmit D-PRS data�
When operating in the D-PRS mode, the following
codes are transmitted to the PC�
D-PRS code is based on APRS® code�
(APRS®: Automatic Packet Reporting System)

NOTE:

• If “GPS select” is set to “Manual,” the manually entered
position data in “Manual Position” is changed to the
D-PRS data format to transmit�
([MENU] > GPS > GPS Set > GPS Select)
• Note that if “GPS Auto TX” is set to any other setting than
“OFF,” it is transmitted according to the set time�
([MENU] > GPS > GPS Auto TX)

DD-PRS
D-STAR Packet Reporting System (D-PRS) is a mode
that simultaneously sends position data received from
the internal GPS receiver, using the slow speed data
packet space, along with voice audio in the DV mode�
In the Analog mode, you can transmit or receive only
voice audio or data at one time� However, a D-PRS
capable radio can transmit or receive message data
or GPS position data simultaneously when voice is
being transmitted or received� An I-GATE is required
to send position data to the APRS server�
The image of D-PRS
<Using a Repeater>
Voice, Messages, and
D-PRS positions

D-STAR Repeater
D-PRS positions
APRS server
Information from
an APRS network

Voice, Messages, and
D-PRS positions

D-PRS
positions

PC
JA3YUA-Z

<Simplex>

INTERNET
You can check the
position on a map site!

Voice, Messages, and
D-PRS positions

D-PRS positions

Voice, Messages, and
D-PRS positions
I-GATE

DOperating in the D-PRS mode

TIP: In the D-PRS mode, you can transmit
earthquake or weather information, in addition to
position data�
([MENU] > GPS > GPS TX Mode > D-PRS > TX Format)

To transmit D-PRS data, follow the steps below�
For more details, see the pages listed along with the
steps�
1� Enter “MY” (Your own call sign)�
(Basic manual D-STAR GUIDE)
2� Confirm the GPS signal is receiving�
3� Set GPS TX mode to “D-PRS�” (p� 6-14)
4� Set TX information�

TX format of D-PRS

• Position (Mobile/Base):
Used to transmit position data�
• Object:
Used to transmit specific position data�
(Contains a time stamp�)
• Item:
Used to transmit specific position data�
(Does not contain a time stamp�)
• Weather: Used to transmit weather information�

L You must set “SSID” and “Symbol�”
([MENU] > GPS > GPS TX Mode > D-PRS)

↓
Complete! You can transmit in the D-PRS mode�
6-12
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Transmitting D-PRS data

DDisplayed
D
items

Depending on the TX format, the setting items and displayed order of the items differ.
D-PRS

Data extension: OFF

Data extension: Course/Speed

Data extension: Power/Height/Gain/Directivity

Data extension: OFF

Data extension: Course/Speed

Data extension: Power/Height/Gain/Directivity

Weather

Item

Base

Object

Mobile

Position

Unproto Address

✓

✓

✓

✓

✓

✓

✓

✓

✓

Comment

✓

✓

✓

✓

✓

✓

✓

✓

✓

Altitude

✓

✓

Object Name/
Item Name

✓

✓

✓

✓

✓

✓

Data Type

✓

✓

✓

✓

✓

✓

Position information
(Latitude/Longitude/
Altitude)

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

Data Extension

✓

✓

Course

✓

✓

Speed

✓

✓

Power

✓

✓

✓

Height

✓

✓

✓

Gain

✓

✓

✓

Directivity

✓

✓

✓

Symbol

✓

✓

✓

✓

✓

✓

✓

✓

✓

SSID

✓

✓

✓

✓

✓

✓

✓

✓

✓

Time stamp

✓

✓

✓

✓

✓

✓

✓: Displayed
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Transmitting D-PRS data

DSetting
D
D-PRS Position (Mobile/Base)
Set to transmit as a D-PRS Position (Mobile/Base).
LLSee page 6-31 for details.

9. Setting the Data Extension
Set the data extension of your station’s information.

1. Setting the GPS TX Mode to D-PRS
[MENU] > GPS > GPS TX Mode > D-PRS

LLSet “Data Extension” to “Course/Speed” to transmit as a
mobile station.
LLSet “Data Extension” to “Power/Height/Gain/Directivity” to
transmit as a base station.

2. Checking the Unproto Address
You should use the default address, and editing is not
recommended.

When you set “Data Extension” to
“Power/Height/Gain/Directivity”:

3. Setting the TX format to “Position”
Set “TX Format” to “Position.”

9-1. Setting the TX power
Select the TX power level of the base station to
transmit along with the position data.

4. Selecting the Symbol
Select the Symbol that indicates your operating
situation.

9-2. Setting the antenna height
Select the height of the base station’s antenna to
transmit along with the position data.

LLSee page 6-31 to directly enter the Symbol.

5. Selecting the SSID
To help identify your station’s type, select the APRS®
(Automatic Packet Reporting System) based SSID
after the D-PRS data call sign. (p. 6-32)

9-3. Setting the antenna gain
Select the gain of the base station’s antenna to
transmit along with the position data.

6. Entering a comment
Enter a comment, and transmit it with the D-PRS
position data.

9-4. Setting the antenna directivity
Select the direction the base station’s antenna was
pointing to transmit along with the position data.

LLThe number of characters you can enter differs,
depending on the data extension and altitude settings.
(p. 6-32)

1.	
2.	
3.	
4.	
5.	
6.	

10. Exiting the POSITION screen
To close the POSITION screen, push [MENU].

Select “Comment.”
Push [QUICK].
Select “Edit.”
Enter a comment.
After entering, push [ENT].
Push [ENT] again.

•• Returns to the standby screen, and then
displayed.

7. Setting the Time Stamp
Set the Time Stamp function to transmit the received
time data in UTC (Universal Time Coordinated) time.
(p. 6-32)
8. Setting the Altitude
Set whether or not to transmit the altitude data
acquired from the GPS receiver. (p. 6-33)
NOTE: If you transmit with the altitude setting ON,
the character string is included in a comment on the
products that cannot display the altitude. (p. 6-4)
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Transmitting D-PRS data

DSetting
D
D-PRS Object/Item

Set to transmit as a D-PRS Object or Item.
LLSee page 6-31 for details.

9. Setting the Data Extension
Set the data extension of an Object or Item’s
information.

1. Setting the GPS TX Mode to D-PRS
[MENU] > GPS > GPS TX Mode > D-PRS

LLSet “Data Extension” to “Course/Speed” to transmit as a
mobile station.
LLSet “Data Extension” to “Power/Height/Gain/Directivity” to
transmit as a base station.

2. Checking the Unproto Address
You should use the default address, and editing is not
recommended.
3. Setting the TX format to “Object” or “Item”
Set “TX Format” to “Object” or “Item.”

When you set “Data Extension” to
“Course/Speed”:

4. Entering Object name or Item name

9-1. Entering the Course
Enter the Object or Item’s course when the station
moves.

Enter an Object or Item name, such as event information or
location.

5. Selecting Data type
Set the Object or Item’s status.

9-2. Entering the Speed
Enter the Object or Item’s speed.

LLFor example, if you want to transmit finished event
information as an Object, set the Date type to “Killed
Object.”

When you set “Data Extension” to
“Power/Height/Gain/Directivity”:

6. Setting the Symbol
Select the Symbol that indicates an Object or Item.

9-3. Setting the TX power
Select the Object or Item’s TX power level if the
station is a repeater, node, access point, and so on,
and an antenna is installed.

LLSee page 6-31 to directly enter the Symbol.

7. Entering a comment
Enter a comment to transmit as an Object or Item.

9-4. Setting the antenna height
Select the height of the Object or Item’s antenna.

LLThe number of characters you can enter differs,
depending on the data extension and altitude settings.
(pp. 6-34, 6-36)

1.	
2.	
3.	
4.	
5.	
6.	

9-5. Setting the antenna gain
Select the gain of the Object or Item antenna.

Select “Comment.”
Push [QUICK].
Select “Edit.”
Enter a comment.
After entering, push [ENT].
Push [ENT] again.

9-6. Setting the antenna directivity
Select the direction the base Object or Item’s
antenna is pointing.
10. Selecting the SSID
To help identify your station’s type, select the APRS®
(Automatic Packet Reporting System) based SSID
after the D-PRS data call sign. (p. 6-32)

8. Entering the Position data
Enter the position data of an Object or Item.

LLFor example, if you want to transmit traffic accident
information as an Item, enter the position data where the
accident happened.
If the position data is in the GPS memory, you can easily
set the position data from the memory.

11. Setting the Time Stamp
LLThis item is displayed when the TX format is
“Object.”
Set the Time Stamp function to transmit the received
time data in UTC (Universal Time Coordinated) time.
(p. 6-35)
12. Exiting the OBJECT or ITEM screen
To close the OBJECT or ITEM screen, push [MENU].
•• Returns to the standby screen, and then
displayed.
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Transmitting D-PRS data

DSetting
D
D-PRS Weather

Set to transmit as a D-PRS Weather station.
LLSee page 6-31 for details.

1. Setting the GPS TX Mode to D-PRS
[MENU] > GPS > GPS TX Mode > D-PRS
2. Checking the Unproto Address
You should use the default address, and editing is not
recommended.
3. Setting the TX format to “Weather”
Set “TX Format” to “Weather.”
4. Selecting the Symbol
Select the Symbol that indicates the weather station.
LLSee page 6-31 to directly enter the Symbol.

5. Selecting the SSID
To help identify your station’s type, select the APRS®
(Automatic Packet Reporting System) based SSID
after the D-PRS data call sign. (p. 6-32)
6. Entering a comment
Enter a comment to transmit as a D-PRS Weather
station.
1.	 Select “Comment.”
2.	 Push [QUICK].
3.	 Select “Edit.”
4.	 Enter a comment.
5.	 After entering, push [ENT].
6.	 Push [ENT] again.
7. Setting the Time Stamp
Set the Time Stamp function to transmit the received
time data in UTC (Universal Time Coordinated) time.
(p. 6-38)
8. Exiting the WEATHER screen
To close the WEATHER screen, push [MENU].
•• Returns to the standby screen, and then
displayed.

is
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Transmitting D-PRS data

DWeather
D
station transmission

DConfirming
D
the weather data input

When you transmit as a weather station, you should
set the weather station’s settings and input the
weather data into the [USB] port.
You can input the weather data from a third party’s
weather device by converting it to the APRS weather
format in your PC or microcomputer.

You can confirm whether or not the weather data is
input into the [USB] port.
1.	 Set “GPS TX Mode” to “D-PRS,” and “TX format”
to “Weather.” (p. 6-16)
2.	 On the Standby screen, push [QUICK].
3.	 Select “Weather Information.”
LLDisplays the WEATHER INFORMATION screen if the
weather data is entered correctly.
LLWhen the weather information is displayed, you can
transmit as a weather station. If “-” is displayed on the
screen, the weather data is not entered. In that case,
check the entered data settings.

After completing the weather station’s settings and
inputting the weather data, you can transmit as a
weather station.
NOTE: To input the Weather data into the [USB]
port, set “USB Connect” to “Serialport,” and set “USB
Serialport function” to “DV Data.”
([MENU] > SET > Function > USB Connect)
([MENU] > SET > Function > USB Serialport function)

If the weather data is not input into the [USB] port,
you cannot transmit as a weather station.
PC

DAbout
D
the weather data content

The weather data should be input according to the
format (based on the APRS® Weather Data), shown
below.

USB cable
(User supplied)
or

To the [USB]
port

Microcomputer

Example:

220/004 g005 t077 r000 p000 P000 h50 b09900 End code
1 2
3
4
5
6
7
8
9

Weather
device

No.

DApplication
D
setting

Configure the communication software as follows.

•• Port:		The COM port number that is used by the
transceiver.*
•• Baud rate:		 Your desired speed
•• Data:		 8 bit
•• Parity:		none
•• Start:		 1 bit
•• Stop:
1 bit
•• Flow control: none
* Depending on the PC environment, the COM port number
used by the ID-52A/E may be higher than 5.
In that case, use an application that can set it to higher
than 5.

Item

Value

Unit

1

Wind direction

000 to 360

°

2

Wind speed

000 to 999

mph

3

Gust speed

g000 to g999

mph

Temperature

t-99 to t-01,
t000 to t999

°F

5

Rainfall

r000 to r999*1

inch

6

Rainfall (24 Hours)

p000 to p999*1

inch

Rainfall (Midnight)

P000 to

P999*1

inch

Humidity

%
h00, h01 to h99
(h00 indicates 100%.)

Barometric pressure

b00000 to b99999*2

4

7
8
9

hPa,
mb

*1 The last two digits indicate the one decimal place and the
two decimal places.
*2 The last digit indicates the one decimal place.
LLIf you have no data, enter a space or “.” (period) instead
of a number.
(Example: “.../...g...t077r000p...P...h50b.....”)
LLEnter <CR>, <LF>, or <CR><LF> for an end code.
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Transmitting D-PRS data

DDisplaying
D
your location using mapping software
If you transmit to an I-GATE station, and then enter
the call sign information on the Internet map website,
the selected symbol is displayed.

You can check it on the Internet!
PC

Smartphone

Example: Check your location on the APRS.fi site.
1.	 Display a free APRS® related map site on the
Internet. (Example: http://aprs.fi/ )
2.	 Enter your call sign in the “Track callsign” field.
3.	 Click <Search>.

Enter your call sign,
and then click <Search>.

•• The icon (D-PRS symbol) is displayed on the map site.

← Your symbol and your call sign
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Transmitting D-PRS data
TIP:

D-PRS data content
D-PRS data content are shown below�
DPosition (Mobile)
(e�g�) JA3YUA-A>API52,DSTAR*:/002338h3437�38N/13534�29E>090/002/A=000012ID-52
q
w
e
r
u
i
!0
!1
!3
o
o
DPosition (Base)
(e�g�)

OP�SATOH
!4

JA3YUA-A>API52,DSTAR*:/002338h3437�38N/13534�29E-PHG5132OP�SATOH
q

w

e

r

u

i

!0

o

!2

o

!4

DObject
(e�g�)

JA3YUA-A>API52,DSTAR*:;HAM FESTA*012345z3437�38N\13534�29Eh2021�11�01 am10-pm4
q

w

e

r

t

y

u

i

!0

o

!4

o

DItem
(e�g�)

JA3YUA-A>API52,DSTAR*:)REPEATER!3454�00N/13536�00ErPHG5132439�39MHｚDV RPT JP3YHH A
q

w

e

r

t

y

i

!0

o

o

!4

!2

DWeather
(e�g�)

JA3YUA-A>API52,DSTAR*:/012345z3454�00N/13536�00E_220/004g005t077r000p000P000h50b09900
q

w

e

qCall sign
wSSID
eUnproto Address
rD-PRS Data type
/ Position with time stamp
! Position without time stamp
; Object
) Item
tObject Name/Item Name
yData Type
* Live Object
! Live Item
_ Killed Object/Killed Item
uTime Stamp (UTC)
h Hour Minute Second
z Day Hour Minute
iLatitude
oSymbol
!0Longitude
!1Data Extension (Course/Speed)
Course:0 ~ 360°
Speed:0 ~ 999 knots

r

u

i

!0

o

!5

o

!6

!7

!8

!9

@0

@1

@2

!2Data Extension(PHG codes)
PHG codes definitions
0

1

2

3

4

5

6

7

8

9

First: Power

0

1

4

9

16

25

36

49

64

81

(W)

Second: Height

10

20

40

80

160

320

640

1280

2560

5120

(feet)

6

7

8

9

(dB)

360°N

−

−

Third: Gain
Fourth: Directivity

0

1

2

3

4

5

omni

45°NE

90°E

135°SE

180°S

225°SW

!3Altitude
−99999 ~ 999999 feet
!4Comment
!5Wind direction/Wind speed
Wind direction:0 ~ 360°
Wind speed: 0 ~ 999 mph
!6Gust speed
0 ~ 999 mph
!7Temperature
−99 ~ 999ƒ
!8Rainfall
0�00 ~ 9�99 inch

!9Rainfall (24 Hours)
0�00 ~ 9�99 inch
@0Rainfall (Midnight)
0�00 ~ 9�99 inch
@1Humidity
1 ~ 99%, 00=100%
@2Barometric pressure
0�0 ~ 9999�9 hPa
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Transmitting NMEA data
Set a GPS sentence to transmit GPS data in the DV
mode.

DSetting
D
the GPS data sentence
[MENU] > GPS > GPS TX Mode > NMEA > GPS Sentence
1.	
2.	
3.	
4.	

Push [MENU].
Select “GPS TX Mode” in the “GPS” menu.
Select “NMEA.”
Select “GPS Sentence.”

6.	 Repeat step 5 to set the GPS sentence.

LLUp to 4 GPS sentences can be set at a time.

7.	 To close the “GPS Sentence” screen, push [MENU].
•• Returns to the standby screen, and then
displayed.

is

NOTE:

•• Set “GSV Sentence” to “OFF” when sending the GPS
message to conventional digital transceivers. (p. 6-4)
•• If “GPS Select” is set to “Manual,” the transceiver
automatically sets the NMEA sentence and transmits
it along with the manually entered position data in
“Manual Position.”
([MENU] > GPS > GPS Set > GPS Select)
([MENU] > GPS > GPS Set > Manual Position)
•• Note that if “GPS Auto TX” is set to any other option
than “OFF,” data is automatically transmitted according
to the set time.
([MENU] > GPS > GPS Auto TX)
LLIf “GPS Select” is set to “OFF” or “Manual,” the GPS
Automatic Transmission function is not activated.

5.	 Select the GPS Sentence.

•• Displays “ ” when the sentence is set to ON.
LLThe selectable GPS sentences are RMC, GGA, GLL,
VTG, GSA, and GSV. The GGA sentence is set to
ON as the default GPS sentence.
LLTo reset to the default setting, push [QUICK], and
then select “Default.”

Contents of GPS sentence
Sentence

Lon
/Lat

RMC

✔

GGA

✔

GLL

✔

Alt

✔

UTC

Date
(UTC)

Status

✔

✔

✔

2D
/3D

SOG
(knot)

✔

✔

Others
Magnetic variation, Mode Indicator

✔

✔

Number of satellites in use, HDOP,
Geoidal separation, Age of Differential
GPS data, Differential reference station ID

✔

✔

Mode Indicator

VTG
GSA

COG
(True)

✔
✔

✔

✔

COG (Magnetic north), SOG (km/h),
Mode Indicator
PRN number of satellites used in
solution, PDOP, HDOP, VDOP
Total number of sentences, Sentence
number, Total number of satellites in
view, Satellite information (ID, Elevation,
Azimuth, S/N)

GSV
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Transmitting NMEA data

GPS Automatic Transmission

DSetting
D
a GPS message

NOTE:

•• Use the GPS Automatic Transmission function in only
the Simplex mode.
•• Using the function through a Repeater may interfere
with other communications.

Enter a GPS message to be transmitted with the
position data.
Example: Entering “OSAKA Suzuki”

You can set the GPS Automatic Transmission function
in the following menu.

[MENU] > GPS > GPS TX Mode > NMEA >
GPS Message
1.	
2.	
3.	
4.	

Push [MENU].
Select “GPS TX Mode” in the “GPS” menu.
Select “NMEA.”
Select “GPS Message.”

[MENU] > GPS > GPS Auto TX
If you set this function, GPS data is automatically
transmitted according to the set time.

LLThis function is not activated if your call sign (MY) is not
entered in the transceiver.
LLIf “GPS Select” is set to “OFF” or “Manual,” this function is
not activated.
([MENU] > GPS > GPS Set > GPS Select)

5.	 Push [QUICK].
6.	 Select “Edit.”

7.	 Enter a GPS message of up to 20 characters.

LLSee page iii on how to enter characters.

8.	 After entering, push [ENT].

•• You can confirm the entered message.

9.	 To close the “GPS Message” screen, push
[MENU].
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GPS Memory
You can add GPS data to GPS Memory.
You can add your own position, other station’s
position, or any entered positions manually.
You can save up to 300 GPS memories, and
conveniently saved in up to 27 groups, from A ~ Z and
“(No Group).” The A to Z groups can also be named.

GPS Memory

Group names are just
example.

(No Group)
A: ICOM

Icom Osaka HC
Icom America

B: HAM festa

Tokyo Big Sight

C: Railroad

Dayton Hamventio
Friedrichshafen

Z:

DAdding
D
a GPS Memory

Example: Add “HOME” into (No Group).
1. Adding a GPS Memory and entering the edit mode

2. Entering a GPS Memory name
1.	 Select “NAME.”
2.	 Enter a GPS Memory name of up to 16
characters. (Example: HOME)

[MENU] > GPS > GPS Memory
1.	 Push [MENU].
2.	 Select “GPS Memory” in the “GPS” menu.

•• The previously added GPS Memories are displayed
on the GPS MEMORY screen.

LLSee page iii on how to enter characters.

3.	 After entering, push [ENT].

3.	 Select “(No Group).”

4.	 Push [QUICK].
5.	 Select “Add.”

•• The GPS MEMORY EDIT screen is displayed.

TIP: To edit the previously saved GPS Memory,
select “Edit” in step 5. You can enter the content in
the same way as described above.

6-22

6

GPS OPERATION (ADVANCED)

GPS Memory
DDAdding a GPS Memory (Continued)
5. Entering the GPS Memory latitude
1.	 Select “LATITUDE.”
2.	 Push D-pad() to move the cursor.
3.	 Rotate [DIAL] to enter the latitude.

3. Entering the GPS Memory date
1.	 Select “DATE.”
2.	 Push D-pad() to move the cursor.
3.	 Rotate [DIAL] to enter the date.

LLSet between 2000/01/02 and 2099/12/30.

LLInformation
•• Set between 0°00.00′ and 90°00.00′.
•• You can change the unit.
([MENU] > SET > Display > Display Unit >
Latitude/Longitude)
•• To enter a north latitude, select “N,” and to enter a
south latitude, select “S.”

4.	 Repeat steps 2 and 3 to enter the date.

4.	 Repeat steps 2 and 3 to enter the latitude.
5.	 After entering, push [ENT].

5.	 After entering, push [ENT].

4. Entering the GPS Memory time
1.	 Select “TIME.”
2.	 Push D-pad() to move the cursor.
3.	 Rotate [DIAL] to enter the date.
LLSet between 00:00:00 and 23:59:59.

6. Entering the GPS Memory longitude
1.	 Select “LONGITUDE.”
2.	 Push D-pad() to move the cursor.
3.	 Rotate [DIAL] to enter the longitude.

4.	 Repeat steps 2 and 3 to enter the time.

LLInformation
•• Set between 0°00.00′ and 180°00.00′.
•• You can change the unit.
([MENU] > SET > Display > Display Unit >
Latitude/Longitude)
•• To enter an east longitude, select “E,” and to enter a
west longitude, select “W.”

5.	 After entering, push [ENT].

4.	 Repeat steps 2 and 3 to enter the longitude.

5.	 After entering, push [ENT].
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GPS Memory
DDAdding a GPS Memory (Continued)
9. Writing the GPS Memory
1.	 Select “<<Add Write>>.”

7. Entering the GPS Memory altitude
1.	 Select “ALTITUDE.”
2.	 Rotate [DIAL] to select plus or minus.
3.	 Push D-pad() to move the cursor.
4.	 Rotate [DIAL] to enter the altitude.
LLSet between –32808 and +32808 feet.

5.	 Repeat steps 3 and 4 to enter the altitude.
•• The confirmation dialog is displayed.
LLIf you edit a previously added GPS Memory, select
“<<Overwrite>>.”

2.	 Select “YES.”
6.	 After entering, push [ENT].

8. Selecting a GPS Memory group
1.	 Select “GROUP.”
•• The data is added to the GPS memory, and then the
selected GPS Memory group screen is displayed.
LLTo exit the MENU screen, push [MENU].

TIP:
To view the entered content:
Select the GPS Memory channel. Rotate [DIAL] to
check the whole content.

2.	 Select the group between (No Group) and A ~ Z.

LLYou can save up to 300 Memories in each group.

To cancel the entered data:
While entering or editing the GPS Memory, push [CLR]
to display the confirmation dialog, as shown below.
Select “YES” to cancel entering, and the display
returns to the GPS Memory group screen.
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GPS Memory

DEntering
D
the GPS Memory group name

DDeleting
D
the GPS Memory

You can enter a name for each GPS Memory group.

You can delete the GPS Memories.
There are 2 ways to delete the Memories:

[MENU] > GPS > GPS Memory

•• Deletes all GPS Memory in a group.
•• Deletes a specific GPS Memory.

1.	 Push [MENU].
2.	 Select “GPS Memory” in the “GPS” menu.

NOTE: Deleted GPS Memories cannot be restored.
[MENU] > GPS > GPS Memory
Example: Deleting all in Group E.
1.	 Push [MENU].
2.	 Select “GPS Memory” in the “GPS” menu.
3.	 Select the group where the GPS Memory to delete
is saved.

3.	 Select the group that the name to be entered.

LLDO NOT push [ENT].

LLDO NOT push [ENT].

4.	 Push [QUICK].
5.	 Select “Delete All In Group.”

4.	 Push [QUICK].
5.	 Select “Edit Name.”

•• The confirmation dialog is displayed.

6.	 Select “YES.”

6.	 Enter a group name of up to 16 characters.

•• All GPS Memory in the selected group are deleted,
then returns to the GPS MEMORY screen.
LLTo exit the MENU screen, push [MENU].

LLSee page iii on how to enter characters.

7.	 After entering, push [ENT].

TIP: Deleting a specific GPS Memory
1.	 Select the GPS Memory to delete, then push
[QUICK].
2.	 Select “Delete.”

LLTo exit the MENU screen, push [MENU].

•• The confirmation dialog is displayed.

3.	 Select “YES.”

•• The selected GPS Memory is deleted.
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GPS Memory

DRearranging
D
the display order of the GPS data
You can move the entered GPS Memories to
rearrange their display order in the selected GPS
Memory group.

LLTo move the GPS Memory out of their assigned Memory
group, select the Memory group in the GPS MEMORY
EDIT screen, and then save.

[MENU] > GPS > GPS Memory
6.	 Select the position to insert the Memory you want
to move.

1.	 Push [MENU].
2.	 Select “GPS Memory” in the “GPS” menu.

3.	 Select the group where the GPS Memory you
want to move is saved.

•• The selected Memory is inserted above the
destination Memory name.
LLIf you select “<<Move End>>,” the Memory is moved
to the bottom of the group.
LLTo exit the MENU screen, push [MENU].

4.	 Select the GPS Memory to move, and then push
[QUICK].

5.	 Select “Move.”

•• “DESTINATION” blinks at the top left of the screen.
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GPS Alarm
The transceiver can sound a GPS Alarm when a target station or position comes into the alarm area.
This function can be set to a caller station, all GPS Memories, a selected GPS Memory group, or a selected GPS
Memory.
Alarm Area (Group) (Setting plural stations)
When “All Memories” or a GPS Memory group is selected:
Point A

N

0�25′

0�25′

0�25′

0�25′

Your location

Point B

Point C
Sounds 3 beeps�

Alarm Area (RX/Memory) (Setting specific station)
When a specific GPS Memory is selected:
N

Extended range
approximately 1 km, 1094 Y
Limited range
approximately 500 m, 547 Y

Your location

Target
station
Sounds a beep�

Sounds 3 beeps�
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GPS Alarm

DSetting
D
the GPS Alarm function to All Memories (all GPS Memories)
[MENU] > GPS > GPS Alarm
1.	 Push [MENU].
2.	 Select “GPS Alarm” in the “GPS” menu.

LLInformation

•• When either one of the group’s stations enters the set
range, the alarm sounds 3 times.
•• When the transceiver sounds a GPS Alarm, “GPS
ALARM” is displayed on the screen, and “ ” blinks.
See the illustration below.
•• To cancel the GPS Alarm function, select “OFF” in step
4 to the left.
Blinks

3.	 Select “Alarm Select.”

GPS ALARM

“GPS ALARM” is displayed on the screen
and the alarm sounds 3 times.

4.	 Select “Group.”

TIP: When selecting “All Memories,” “No Group,” or
a GPS Memory group (A ~ Z) in step 5 to the left,
you also have to set “Alarm Area (Group)” to use the
GPS Alarm function. (p. 6-43)
([MENU] > GPS > GPS Alarm > Alarm Area (Group))
5.	 Select “All Memories.”

•• Returns to the GPS ALARM screen.
LLIf you want to set the alarm to a specific GPS
Memory group, select “(No Group)” or “A” to “Z.”
LLTo exit the MENU screen, push [MENU].
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GPS Alarm

DSetting
D
the GPS Alarm function to RX (a caller station)
[MENU] > GPS > GPS Alarm
1.	 Push [MENU].
2.	 Select “GPS Alarm” in the “GPS” menu.

LLInformation

•• When a station with its GPS Alarm set enters within an
approximate 1 kilometer (1094 yards) range, it sounds
once. When it enters within an approximate 500
meters (547 yards) range, the alarm sounds 3 times.
•• When the transceiver sounds a GPS Alarm, “GPS
ALARM” is displayed on the screen, and “ ” blinks.
See the illustration below.
•• To cancel the GPS Alarm function, select “OFF” in step
4 to the left.

3.	 Select “Alarm Select.”

Blinks

GPS ALARM

4.	 Select “RX.”
“GPS ALARM” is displayed on the screen
and the alarm sounds 3 times.
NOTE: Even if “RX” is selected in step 4, when the
received signal has no position data, the GPS Alarm
does not sound.
TIP: When selecting “RX” or a specific GPS Memory
in step 4 to the left, you also have to set the “Alarm
Area (RX/Memory)” to use the GPS Alarm function.
(p. 6-44)

([MENU] > GPS > GPS Alarm > Alarm Area (RX/Memory))

•• Returns to the GPS ALARM screen.
LLIf you want to set the alarm to a specific GPS
Memory group, select “Memory” and then select a
GPS Memory in a GPS Memory group.
LLTo exit the MENU screen, push [MENU].
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GPS items
NOTE: The default settings shown below are for the USA transceiver version. The default settings may differ,
depending on your transceiver version. To return to your transceiver version’s default settings, push [QUICK] and
select “Default.”
GPS Select

Power Save

(Default: ON)

[MENU] > GPS > GPS Set > GPS Select

[MENU] > GPS > GPS Set > GPS Option >
Power Save

Selects how to capture position data.

Selects whether or not to use the Power Save function
for the internal GPS receiver.
When this function is ON, and if the GPS receiver
does not receive signals from a satellite for 5 minutes,
the function turns OFF the GPS receiver for this set
period of time.
•• OFF:
The GPS receiver is always turned ON.
•• 1, 2, 4, 8min:
			When the receiver cannot receive signals
from a satellite for 5 minutes, the GPS
receiver is turned OFF for the selected
period of time. (1, 2, 4, or 8 minutes).
After this period, the receiver resumes
receiving.
•• Auto:	When the receiver cannot receive signals
from a satellite for 5 minutes, the GPS
receiver is turned OFF for 1 minute.
After this period, the receiver resumes
receiving. The Power Save interval time
extends to 2, 4, and then 8 minutes
when receiving no signals for another 5
minutes, respectively.

LLWhen “GPS Time Correct” is set to “Auto,” set this item to
“ON” to automatically correct the time by a received GPS
sentence. (p. 12-30)

•• OFF:
A GPS receiver is not used.
•• ON:	Position data of the internal GPS receiver
is used for the GPS functions.
•• Manual:	Manually enter the current Latitude,
Longitude, and Altitude in “Manual
Position.”

SBAS

(Default: OFF)

[MENU] > GPS > GPS Set > GPS Option > SBAS
Turns the SBAS (Satellite Based Augmentation
System) function ON or OFF.

LLWhen turning ON this function, the GPS position accuracy
can be improved, but the transceiver’s battery is quickly
exhausted.

•• OFF:	Turns OFF the function.
•• ON:	Turns ON the function.

GLONASS

(Default: Auto)

(Default: OFF)

[MENU] > GPS > GPS Set > GPS Option > GLONASS
Selects whether or not to use the data from
the GLONASS (GLObal’naya NAvigatsionnaya
Sputnikovaya Sistema) satellites.

Satellite Information Out

(Default: GPS/QZSS/GLONASS)
[MENU] > GPS > GPS Set > GPS Option >
Satellite Information Out

LLWhen turning ON this function, the GPS position accuracy
can be improved, but the transceiver’s battery is quickly
exhausted.

Selects whether or not to output the data from the
QZSS (Quasi-Zenith Satellite System) satellites and
the GLONASS satellites.
•• GPS/QZSS/GLONASS:
			Outputs the data from the GPS satellites,
the QZSS satellites, and the GLONASS
satellites.
•• GPS Only:	Outputs the data from only the GPS
satellites.

•• OFF:	Does not use the data from the
GLONASS satellites.
•• ON:	Uses the data from the GLONASS
satellites.

Manual Position
(Default: LATITUDE: 0°00.00′N,
LONGITUDE:0°00.00′W, ALTITUDE: ------ft)
[MENU] > GPS > GPS Set > Manual Position
Manually enter the latitude, longitude, and altitude of
your current position.

LLYou can capture position data from the GPS receiver if
“Capture From GPS” is selected.
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GPS items
GPS Out (USB Port)

Symbol

(Default: OFF)

[MENU] > GPS > GPS Set > GPS Out (USB Port)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Symbol

Selects whether or not to output the position
information to the USB port.
•• OFF:	Does not send the position information to
the USB port.
•• ON:	Send the position information to the USB
port.
GPS TX Mode

Selects the symbol that indicates your operating
situation. The selected symbol channel’s symbols (1 ~
4) are transmitted with position data.
<Editing a symbol with a 2 character symbol code>
1.	 Select a symbol channel.

(Default: OFF)

2.	
3.	
4.	
5.	
6.	
7.	
8.	

[MENU] > GPS > GPS TX Mode
Selects a GPS transmission mode to send GPS
position data while in the DV mode.
•• OFF:
Does not transmit GPS data.
•• D-PRS: Transmits GPS data in the D-PRS format.
•• NMEA: Transmits GPS data in the NMEA format.
Unproto Address

(Default: Person)

(Default: API52,DSTAR*)

LLDO NOT push [ENT].

Push [QUICK].
Select “Edit Symbol.”
Push [QUICK].
Select “Direct Input.”
Rotate [DIAL] to edit the first digit.
Push D-pad() to select the second digit.
Rotate [DIAL] to edit the second digit.
Selectable characters and symbols

[MENU] > GPS > GPS TX Mode > D-PRS >
Unproto Address

<For the first digit> /, \, 0 to 9, A to Z
<For the second digit> A to Z, a to z, 0 to 9, ! “ #
$%&’()*+,-./:;<=>?@[\]^_`{|}˜

Displays an unproto address of up to 56 alphanumeric
characters.

9.	 After editing, push [ENT].

NOTE: You should use the default address, and
editing is not recommended.

•• Sets the symbol into the symbol channel selected in
step 1.

<Selecting a preset symbol>
1.	 Select a symbol channel.
LLDO NOT push [ENT].

2.	 Push [QUICK].
3.	 Select “Edit Symbol.”
4.	 Select a symbol.

•• Sets the symbol into the symbol channel selected in
step 1.
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GPS items
SSID

Comment

(Default: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Comment

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > SSID

Enter a comment to transmit it with the D-PRS
position data.
You can enter up to four comments.
The number of characters you can enter differs,
depending on the Data Extension and Altitude settings.

Selects an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.
LLThe SSID’s additional methods differ, depending on
whether the call sign includes a space or not.

•• ---:

•• (-0):

•• -1~-15:

•• -A~-Z:

The space in call sign is converted to “-.”

LLIf no text is entered after space, space will
be deleted, and space is not converted to
“-.”
Example: J A3YUA → JA3YUA
JA3YUA A → JA3YUA-A

Data Extension

Altitude

OFF

OFF

No SSID is added.

LLIf a call sign includes a space, any text or
digit after space will be deleted.
Example: J A3YUA → JA3YUA
JA3YUA A → JA3YUA

Adds an SSID of -1 to -15 to your call sign.

LLExample: S
 SID is “-9.”
JA3YUA → JA3YUA-9
JA3YUA A → JA3YUA-9

Characters
entered
(maximum)
43 (Default)

OFF

ON

35

Course/Speed

OFF

36

Course/Speed

ON

28

Power/Height/Gain/Directivity

OFF

36

Power/Height/Gain/Directivity

ON

28

The symbol “ ” displays the transmittable comment
range. Note that the characters that exceed the range
will not be transmitted.

Adds an SSID of -A to -Z to your call sign.

LLExample: S
 SID is “-Z.”
JA3YUA → JA3YUA-Z
JA3YUA A → JA3YUA-Z

TIP: About the SSID
According to a common guideline, to help identify a
station’s type, designated call sign SSIDs are used
in D-PRS (or APRS®).
The guideline may be changed when the
infrastructure environment, such as a product or
network, is changed. Check the latest guideline
in the web site related to D-PRS and APRS® and
correctly set.
http://aprs.org/aprs11/SSIDs.txt

Transmittable comment range display
(Example: up to 28 characters)
Time Stamp

(Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Time Stamp
Selects the transmitting time stamp type.
The time stamp is transmitted with the position
data in the D-PRS mode, and UTC (Universal Time
Coordinated) time is used.

LLWhen your position is manually set, time stamp data is
not transmitted.

•• OFF:
Does not transmit the time information.
•• DHM:	Transmits the time stamp in the Day,
Hour, and Minute format.
•• HMS:	Transmits the time stamp in the Hour,
Minute, and Second format.
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GPS items
Altitude

Height

(Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Height

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Altitude

Selects the height of the base station’s antenna to
transmit along with the position data.

Selects whether or not to transmit altitude data with
the position data in the D-PRS mode.

LLThe number of characters you can enter in “Comment”
differs, depending on the “Altitude” and “Data Extension”
settings.

•• OFF:
•• ON:

LLThis item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

•• Select 10, 20, 40, 80, 160, 320, 640, 1280, 2560, or
5120 feet.*

No altitude data is transmitted.
Transmits altitude data with position data.

Data Extension

* If the Altitude/Distance unit is set to “m,” select 3, 6, 12,
24, 49, 98, 195, 390, 780, or 1561 meters.

(Default: OFF)

Gain

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Data Extension

(Default: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Gain

Selects whether or not to transmit the Course/Speed
data or the Power/Hight/Gain/Directivity data with the
position data in the D-PRS mode.

Selects the gain of the base station’s antenna to
transmit along with the position data.

LLThe number of characters you can enter in “Comment”
differs, depending on the “Altitude” and “Data Extension”
settings.

LLThis item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

•• Select between 0 and 9 dB.

•• OFF:
Does not transmit any information.
•• Course/Speed:
			Transmits the course and speed data
with the position data.

Directivity

(Default: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Directivity

LLThe course and speed data are not transmitted
when your location is manually set.
LLWhen transmitting with this setting, your
station is regarded as a mobile station.

Selects the direction the base station’s antenna was
pointing to transmit along with the position data.

LLThis item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

•• Power/Height/Gain/Directivity:
			Transmits the TX power level, height,
antenna gain, antenna direction, and
position data.

•• Select Omni, 45° NE, 90° E, 135° SE, 180°S, 225°
SW, 270° W, 315° NW, or 360° N.

Object Name

LLThe Power, Height, Gain, and Directivity
data are transmitted even if your location is
manually set.
LLWhen transmitting with this setting, your
station is regarded as a base station.

Power

(Default: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Object Name
Sets an Object’s name of up to 9 characters.
Data Type

(Default: 0W)

(Default: Live Item)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Data Type

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Power

Selects the Object’s status.
•• Live Item:
The Item station is valid.
•• Killed Item: The Item station is invalid.

Selects the TX power level of the base station to
transmit along with the position data.

LLThis item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

Symbol

•• Select 0, 1, 4, 9, 16, 25, 36, 49, 64, or 81 W.

(Default: Transceiver)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Symbol
The symbol is an icon that indicates the Object’s
means of transportation or location. The saved symbol
is transmitted along with the position data while in the
D-PRS mode.
LLSee page 6-31 for details of editing a symbol.
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GPS items
Comment

Position
(Default: LATITUDE: 0°00.00′N,
LONGITUDE:0°00.00′W, ALTITUDE: ------ft)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Comment

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Position

Enters a comment to transmit it with the D-PRS
position data.
You can enter up to four comments.
The number of characters you can enter differs,
depending on the Data Extension and Altitude settings.
Altitude

Characters
entered
(maximum)

OFF

—

43 (Default)

OFF

Entered

35

Course/Speed

—

36

Course/Speed

Entered

28

Power/Height/Gain/Directivity

—

36

Power/Height/Gain/Directivity

Entered

28

Data Extension

Displays the position information of the Object.
Push [QUICK] to open the Quick Menu window shown
below.

TIP: When you select “Capture From GPS” or “Set
From GPS Memory,” you can capture the position
from the GPS or set the Item’s position from the
GPS memory.

The symbol “ ” displays the transmittable comment
range. Please note that the characters that exceed the
range will not be transmitted.

Entering the position information manually
1.	 Select “Edit” on the Quick Menu window.
•• The POSITION EDIT screen is displayed.

2.	 Select “LATITUDE.”
3.	 Enter a latitude.

LLSelect “N/S” to switch the north latitude and the
southern latitude.

4.	 Select [ENT].
5.	 Select “LONGITUDE.”
6.	 Enter a longitude.

Transmittable comment range display
(Example: up to 28 characters)

LLSelect “E/W” to switch the east longitude and the
west longitude.

7.	 Select [ENT].
8.	 Select “ALTITUDE.”
9.	 Enter an altitude.

LLAfter entering, select [+/−] to switch “+” and “−.”

10.	Select [ENT].
11.	 Select “<<Write>>.”
12.	Select “YES.”

•• The position information is entered.
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GPS items
Data Extension

(Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Data Extension
Selects whether or not to transmit the Course/Speed
data or the Power/Hight/Gain/Directivity data with the
position data in the D-PRS mode.

LLThe number of characters you can enter in “Comment”
differs, depending on the “Altitude” and “Data Extension”
settings.

•• OFF:
Does not transmit any information.
•• Course/Speed:
			Transmits the course and speed data
with the position data.
•• Power/Height/Gain/Directivity:
			Transmits the TX power level, height,
antenna gain, antenna direction, and
position data.

Course

(Default: 0°)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Course
Sets the Object’s course to between 0° and 360°

LLThis item is displayed when “Data Extension” is set to
“Course/Speed.”

Speed

(Default: 0mph)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Speed
Sets the Object’s speed to between 0 and 1150 mph.*
* If the Speed unit is set to “km/h,” set to between 0 to
1850 km/h, or set to “knots,” set to between 0 and
999 knots.
LLThis item is displayed when “Data Extension” is set to
“Course/Speed.”

Power

(Default: 0W)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Power
Selects the TX power level of Object to transmit along
with the position data.
LLThis item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

•• Select 0, 1, 4, 9, 16, 25, 36, 49, 64, or 81 W.

Height

(Default: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Height
Selects the height of the Object’s antenna to transmit
along with the position data.

LLThis item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

•• Select 10, 20, 40, 80, 160, 320, 640, 1280, 2560, or
5120 feet.*

* If the Altitude/Distance unit is set to “m,” select 3, 6, 12,
24, 49, 98, 195, 390, 780, or 1561 meters.
6-35

Gain

(Default: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Gain
Selects the gain of the Object’s antenna to transmit
along with the position data.
LLThis item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

•• Select between 0 and 9 dB.

Directivity

(Default: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Directivity
Selects the direction the Object’s antenna was
pointing to transmit along with the position data.

LLThis item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

•• Select Omni, 45° NE, 90° E, 135° SE, 180°S, 225°
SW, 270° W, 315° NW, or 360° N.

SSID

(Default: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > SSID
Selects an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.

LLThe SSID’s additional methods differ, depending on
whether the call sign includes a space or not.
LLSee page 6-32 for details of the SSID.

•• ---:		
The space in call sign is converted to “-.”
•• (-0):		
No SSID is added.
•• -1 ~ -15:	Adds an SSID of -1 to -15 to your call
sign.
•• -A ~ -Z:	Adds an SSID of -A to -Z to your call
sign.

Time Stamp

(Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Time Stamp
Selects the transmitting time stamp type.
The time stamp is transmitted with the position
data in the D-PRS mode, and UTC (Universal Time
Coordinated) time is used.

LLWhen your position is manually set, time stamp data is
not transmitted.

•• DHM:	Transmits the time stamp in the Day,
Hour, and Minute format.
•• HMS:	Transmits the time stamp in the Hour,
Minute, and Second format.
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GPS items
Position
(Default: LATITUDE: 0°00.00′N,
LONGITUDE:0°00.00′W, ALTITUDE: ------ft)

Item Name
[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Item Name

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Position

Sets the Item station’s name of up to 9 characters.
Data Type

(Default: Live Item)

Displays the position information of the Item.
Push [QUICK] to open the Quick Menu window shown
below.

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Data Type
Selects the Item station’s status.
•• Live Item:
The Item station is valid.
•• Killed Item: The Item station is invalid.
Symbol

(Default: Transceiver)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Symbol

TIP: When you select “Capture From GPS” or “Set From
GPS Memory,” you can capture the position from the
GPS or set the Item’s position from the GPS memory.

Selects the symbol that indicates the Item’s means
of transportation or location. The selected symbol
channel’s symbols are transmitted with position data
while in the D-PRS mode.
LLSee page 6-31 for details of editing a symbol.

LLSee page 6-34 when you want to enter the position
information manually.

Comment

Data Extension

(Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Data Extension

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Comment

Selects whether or not to transmit the Course/Speed
data or the Power/Hight/Gain/Directivity data with the
position data in the D-PRS mode.

Enters a comment to transmit it with the D-PRS
position data.
The number of characters you can enter differs,
depending on the Data Extension and Altitude settings.
Data Extension

Altitude

Characters
entered
(maximum)

OFF

—

43 (Default)

OFF

Entered

35

Course/Speed

—

36

Course/Speed

Entered

28

Power/Height/Gain/Directivity

—

36

Power/Height/Gain/Directivity

Entered

28

LLThe number of characters you can enter in “Comment”
differs, depending on the settings.

•• OFF:
Does not transmit any information.
•• Course/Speed:
			Transmits the course and speed data
with the position data.
•• Power/Height/Gain/Directivity:
			Transmits the TX power level, height,
antenna gain, antenna direction, and
position data.

Course

(Default: 0°)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Course

The symbol “ ” displays the transmittable comment
range. Please note that the characters that exceed the
range will not be transmitted.

Sets the Item’s course to between 0° and 360°

LLThis item is displayed when “Data Extension” is set to
“Course/Speed.”

Speed

(Default: 0°)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Speed
Sets the Item’s speed to between 0 and 1150 mph.*
* If the Speed unit is set to “km/h,” set to between 0 to
1850 km/h, or set to “knots,” set to between 0 and
999 knots.

Transmittable comment range display
(Example: up to 28 characters)

6-36

LLThis item is displayed when “Data Extension” is set to
“Course/Speed.”
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GPS items
Power

SSID

(Default: 0W)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Power

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > SSID
Selects an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.

Selects the TX power level of Item, to transmit along
with the position data.
LLThis item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

LLThe SSID’s additional methods differ, depending on
whether the call sign includes a space or not.
LLSee page 6-32 for details of the SSID.

•• Select 0, 1, 4, 9, 16, 25, 36, 49, 64, or 81 W.

Height

•• ---:		
The space in call sign is converted to “-.”
•• (-0):		
No SSID is added.
•• -1 ~ -15:	Adds an SSID of -1 to -15 to your call
sign.
•• -A ~ -Z:	Adds an SSID of -A to -Z to your call
sign.

(Default: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Height
Selects the height of the Item’s antenna to transmit
along with the position data.

LLThis item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

•• Select 10, 20, 40, 80, 160, 320, 640, 1280, 2560, or
5120 feet.*
* If the Altitude/Distance unit is set to “m,” select 3, 6, 12,
24, 49, 98, 195, 390, 780, or 1561 meters.

Gain

(Default: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Gain
Selects the gain of the Item’s antenna to transmit
along with the position data.

LLThis item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

•• Select between 0 and 9 dB.

Directivity

(Default: ---)

(Default: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Directivity
Selects the direction the Item’s antenna was pointing
to transmit along with the position data.

LLThis item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

•• Select Omni, 45° NE, 90° E, 135° SE, 180°S, 225°
SW, 270° W, 315° NW, or 360° N.
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GPS items
Symbol

(Default: WX Station)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Weather > Symbol
The symbol is an icon that indicates the weather
station’s means of transportation or location.
The saved symbol is transmitted along with the
position data while in the D-PRS mode.
LLSee page 6-31 for details of editing a symbol.

SSID

(Default: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Weather > SSID
Selects an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.
LLThe SSID’s additional methods differ, depending on
whether the call sign includes a space or not.
LLSee page 6-32 for details of the SSID.

•• ---:		
The space in call sign is converted to “-.”
•• (-0):		
No SSID is added.
•• -1 ~ -15:	Adds an SSID of -1 to -15 to your call
sign.
•• -A ~ -Z:	Adds an SSID of -A to -Z to your call
sign.

Comment
[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Weather > Comment
Enter a comment to transmit it with the D-PRS
position data, up to 43 characters.
Time Stamp

(Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Weather > Time Stamp
Selects the transmitting time stamp type.
The time stamp is transmitted with the position
data in the D-PRS mode, and UTC (Universal Time
Coordinated) time is used.
•• OFF:
Does not transmit the time information.
•• DHM:	Transmits the time stamp in the Day,
Hour, and Minute format.
•• HMS:	Transmits the time stamp in the Hour,
Minute, and Second format.
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GPS items
GPS Sentence

GPS Message

(Default: GGA)

[MENU] > GPS > GPS TX Mode > NMEA >
GPS Sentence

[MENU] > GPS > GPS TX Mode > NMEA >
GPS Message

Selects sentences to be transmitted in the GPS mode
to transmit position data. Set to between RMC, GGA,
GLL, VTG, GSA, and GSV.

Enter a GPS message of up to 20 alphanumeric
characters. (p. 6-21)
NOTE: When you do not want to send a message,
delete the entered message.

NOTE: Set the GSV sentence to OFF when
sending the GPS message to conventional digital
transceivers. (p. 6-4)
The GSV sentence is incompatible with them.

GPS Information
[MENU] > GPS > GPS Information
Displays the GPS satellite direction, elevation angle,
satellite number, and receiving status. (p. 6-11)

LLInformation
•• Up to 4 GPS sentences can be set at a time.
•• Displays “ ” when the sentence is set to ON.
•• “VTG,” “GSA,” and “GSV” sentences are not transmitted
when your position has been manually set.

TIP: Contents of GPS sentence
The Time Stamp is displayed based on the UTC (Universal Time Coordinated) time.
Sentence

Lon/Lat

RMC

✔

GGA

✔

GLL

✔

Alt

✔

GPS Time
Stamp
(UTC)

Date
(UTC)

Status

✔

✔

✔

✔

✔

✔

✔

2D/3D

COG
(True)

SOG
(knot)

✔

✔

✔

✔

VTG
GSA

✔

✔

GSV
Sentence

Others

RMC

Magnetic variation, Mode Indicator

GGA

Number of satellites in use, HDOP, Geoidal separation, Age of Differential GPS data,
Differential reference station ID

GLL

Mode Indicator

VTG

COG (Magnetic north), SOG (km/h), Mode Indicator

GSA

PRN number of satellites used in solution, PDOP, HDOP, VDOP

GSV

Total number of sentences, Sentence number, Total number of satellites in view,
Satellite information (ID, Elevation, Azimuth, S/N)
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GPS items
GPS Position

RX screen (Received position data of the other station)
Depending on the caller’s TX mode or TX format, the
displayed items and these meanings are different. The
following lists describe the items for each category.
No data is displayed when no position data is received
on your transceiver.

[MENU] > GPS > GPS Position
Your current position, received position, GPS Memory,
or GPS Alarm position information is displayed.
(p. 6-6)
Rotating [DIAL] to select the MY, RX, MEM, and ALM
screens.

<1. When the caller’s TX mode is NMEA>

MY screen (MY Position)

Compass*

Displays the caller’s direction from
your location.

Compass*

Displays your direction.

Latitude

Displays the caller’s latitude.

Course

Displays your direction heading.

Longitude

Displays the caller’s longitude.

Latitude

Displays your latitude.

Longitude

Displays your longitude.

GL

GL

Displays the grid locator based on
the latitude and longitude of your
location.

Displays the grid locator based on
the latitude and longitude of the
caller’s location.

ALT

Displays the caller’s altitude.

ALT

Displays your own altitude.

DST

Displays the caller’s distance from
your location.

SPEED

Displays your speed over the ground.

Call sign

Displays the caller’s call sign.

TIME

Displays current time received from
the GPS.

COURSE

Displays the caller’s direction over
the ground.

SPEED

Displays the caller’s speed.

GPS Time Stamp

Displays the time that the caller
acquired the position data.

LLWhen “GPS Select” is set to “Manual,” the screen
displays only latitude, longitude, altitude, GL (Grid
locator), and time (internal clock).

<2. When the caller’s TX format is D-PRS Position
(Mobile station)>
Compass*

Displays the caller’s direction from
your location.

Symbol

Displays the caller’s D-PRS
symbol.

Latitude

Displays the caller’s latitude.

Longitude

Displays the caller’s longitude.

GL

Displays the grid locator based on
the latitude and longitude of the
caller’s location.

ALT

Displays the caller’s altitude.

DST

Displays the caller’s distance from
your location.

Call sign

Displays the caller’s call sign
(with SSID).

COURSE

Displays the caller’s direction over
the ground.

SPEED

Displays the caller’s speed.

GPS Time Stamp

Displays the time that the caller
acquired the position data.

* You can change the display type in the Quick Menu
window.
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GPS items
GPS Position (continued)
<4. When the caller’s TX format is D-PRS Object/
Item>

<3. W
 hen the caller’s TX format is D-PRS Position
(Base station)>
Compass*

Displays the caller’s direction from
your location.

Compass*

Displays the Object/Item’s direction
from your location.

Symbol

Displays the caller’s D-PRS
symbol.

Symbol

Displays the Object/Item’s D-PRS
symbol.

Latitude

Displays the caller’s latitude.

Latitude

Displays the Object/Item’s latitude.

Longitude

Displays the caller’s longitude.

Longitude

Displays the Object/Item’s longitude.

GL

Displays the grid locator based on
the latitude and longitude of the
caller’s location.

GL

Displays the grid locator based on
the latitude and longitude of the
Object/Item’s location.

ALT

Displays the caller’s altitude.

ALT

Displays the Object/Item’s altitude.

DST

Displays the caller’s distance from
your location.

DST

Displays the Object/Item’s distance
from your location.

Call sign

Displays the caller’s call sign
(with SSID).

Object/Item name

Displays the Object/Item’s name.

POWER

Displays the caller’s TX power level.

Call sign

Displays the caller’s call sign
(with SSID).

HEIGHT

Displays the caller’s antenna height.

GAIN

Displays the caller’s antenna gain.

COURSE

Displays the Object/Item’s direction
over the ground.

DIRECT

Displays the direction of the caller’s
antenna was pointing.

SPEED

Displays the Object/Item’s speed.

GPS Time Stamp

Displays the time that the caller
acquired the position data.

POWER

Displays the Object/Item’s TX power
level.

HEIGHT

Displays the Object/Item’s antenna
height.

GAIN

Displays the Object/Item’s antenna
gain.

DIRECT

Displays the direction that the
Object/Item’s antenna was pointing.

GPS Time Stamp

Displays the time that the caller
sent the Object’s data.

LLWhen the Object or Item is disabled, “KILLED” is
displayed.

* You can change the display type in the Quick Menu
window.
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GPS items
GPS Position (continued)
MEM screen (GPS memory position)

<5. When the caller’s TX format is D-PRS Weather>
Compass*

Displays the caller’s direction from
your location.

Compass*

Displays GPS Memory channel’s
direction from your location.

Symbol

Displays the caller’s D-PRS
symbol.

Latitude

Displays GPS Memory channel’s
latitude.

Latitude

Displays the caller’s latitude.

Longitude

Displays the caller’s longitude.

Longitude

Displays GPS Memory channel’s
longitude.

GL

Displays the grid locator based on
the latitude and longitude of the
caller’s location.

GL

Displays the grid locator based on
the latitude and longitude of the
GPS Memory channel.

DST

Displays the caller’s distance from
your location.

DST

Displays GPS Memory channel’s
distance from your location.

Call sign

Displays the caller’s call sign
(with SSID).

GPS memory name

Displays the caller’s call sign (with
SSID).

Temperature

Displays the temperature of the
caller station’s area.

LLYou can change the GPS Memory in the Quick Menu
window.

Humidity

Displays the humidity of the caller
station’s area.

ALM screen (GPS alarm position)

RAIN

Displays the rainfall of the caller
station’s area.

WIND DIR

Displays the wind direction of the
caller station’s area.

WIND SPD

Displays the wind speed of the
caller station’s area.

Compass*

Displays GPS Alarm area’s
direction from your location.

Latitude

Displays GPS Alarm area’s latitude.

Longitude

Displays GPS Alarm area’s
longitude.
Displays the grid locator based on
the latitude and longitude of the
GPS Alarm area.

BARO

Displays the barometric pressure of
the caller station’s area.

GL

GPS Time Stamp

Displays the time that the caller
acquired the position data.

DST

Displays the GPS Alarm area’s
distance from your location.

GPS Alarm

Displays “RX,” GPS memory
group name, or GPS memory
name specified for the GPS Alarm
function.

LLYou can change the GPS Alarm in the Quick Menu
window.

* You can change the display type in the Quick Menu
window.
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GPS Memory

Alarm Select

[MENU] > GPS > GPS Memory

[MENU] > GPS > GPS Alarm > Alarm Select

The transceiver has 300 GPS memories to save the
received position data, or often-used position data,
with an alphanumeric memory name.
The channels can be divided into the “(No Group)”
group and each Memory group (A to Z) for easy
Memory management.

Selects the target positions for the GPS Alarm
function.
•• OFF:		
Turns OFF the function.
•• RX:		The GPS Alarm sounds when a target
(the last received position) enters
your active alarm range.
•• Group:	The GPS Alarm sounds when a target
(positions in the GPS Memory, or the
selected GPS Memory Group) enters
your active alarm range.
•• Memory:	The GPS Alarm sounds when a target
(the entered position in the GPS
Memory) enters your active alarm
range.

The display of the GPS MEMORY screen
(No Group)

GPS Memories not assigned to any
group

A ~ Z: Group Name

GPS Memories assigned to the
selected group.

GPS Memory Groups (A ~ Z)
GROUP NAME

GPS Memory Group name
(Up to 16 alphanumeric characters)

Alarm Area (Group)

Sets the GPS active alarm range.
When a target enters this set active alarm range, the
GPS Alarm sounds, and the GPS Alarm icon blinks.

GPS Memories
GPS memory name
(Up to 16 alphanumeric characters)

DATE

Saved date

TIME

Saved time

LATITUDE

Saved position (latitude)

LONGITUDE

Saved position (longitude)

ALTITUDE

Saved altitude

GROUP

The group letter and the name of
the group

(Default: 0.25′)

[MENU] > GPS > GPS Alarm > Alarm Area (Group)

LLYou can edit the GPS Memory Group name. (p. 6-25)

NAME

(Default: OFF)

LLWhen “Alarm Select” is set to “Group,” this setting is
enabled.

Ranges differ, depending on the Latitude/
Longitude unit setting.
•• Latitude/Longitude = ddd°mm.mm′
Ranges: 00.08′ to 59.99′ (0.01′ steps)
•• Latitude/Longitude = ddd°mm′mm″
Ranges: 00′05″ to 59′59″ (0′01″ steps)
•• Latitude/Longitude = ddd.dddd°
Ranges: 0.0014° to 0.9999° (0.0001° steps)

LLWhen you save the received position data on the GPS
POSITION screen, the received station’s call sign is used
as the GPS Memory name.
LLIn the Quick Menu window, you can edit the GPS Memory
contents, such as the GPS Memory name.

LLPushing D-pad() moves the cursor to the tenths and
hundredths place digits, or the thousandths and ten
thousandths place digits.

Example:
When a target enters the active alarm range, the GPS
Alarm sounds, and the GPS alarm icon blinks.
0�25′

N

0�25′

0�25′

Point A

0�25′

Your location

Point B

Point C
Sounds 3 beeps�
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Alarm Area (RX/Memory)

GPS Logger

(Default: Both)

[MENU] > GPS > GPS Logger

[MENU] > GPS > GPS Alarm >
Alarm Area (RX/Memory)

Turns the GPS Logger function ON or OFF.
This function logs the position, altitude, course, speed,
and number of satellites being used.
•• OFF: Turns OFF the function.
•• ON:	The transceiver automatically logs GPS data.
Once this function is turned ON, the GPS
data will be continuously logged until turning
it OFF, even if the transceiver power is turned
OFF, then ON again.

Selects the GPS active alarm range.
When a target enters the active alarm range, the GPS
Alarm sounds, and the GPS alarm icon blinks.

LLWhen “Alarm Select” is set to “RX” or “Memory,” this
setting is enabled. (p. 6-43)

•• Limited:	The transceiver sounds 3 beeps, and
the GPS Alarm icon blinks when the
target enters the 500 meters range.
•• Extended:	The transceiver sounds 3 beeps, and
the GPS Alarm icon blinks when the
target enters the 1-kilometer range.
•• Both:		The transceiver sounds a beep, and
the GPS Alarm icon blinks when the
target enters the 1-kilometer range
and sounds 3 beeps, and the icon
blinks when it enters the 500 meters
range. When the target exits the
500 meters range but is still in the
1-kilometer range, the icon continues
to blink, but no beeps sound.

LLThis function requires a microSD card (User supplied).
LLWhen “GPS select” is set to “OFF” or “Manual,” this
function does not save the log.

TIP: The log data is saved on the microSD card. The
file name is automatically created, as shown below:
•• Log start date and time: 1st November 2021 15:30:00
•• Filename: 20211101_153000.csv

Record Interval

(Default: 10sec)

[MENU] > GPS > GPS Logger > Record Interval
Sets the GPS Logger function record interval to 1, 5,
10, 30 seconds, or 1, 5, or 10 minutes.

Example:
When a target station enters the active alarm range
(500 meters or 1 kilometer range, depending on the
setting), the GPS Alarm sounds, and the GPS Alarm
icon blinks.
Extended range
approximately 1 km, 1094 Y

(Default: ON)

Record Sentence

(Default: ✔ RMC/ ✔ GGA/ ✔ VTG/ ✔ GSA)
[MENU] > GPS > GPS Logger > Record Sentence
Sets the GPS Logger function record sentence to
RMC, GGA, VTG, or GSA.

N

•• Displays “

” when the sentence is set.

NOTE: Select at least one sentence, otherwise an
error beep will sound.

Limited range
approximately 500 m, 547 Y

Your location

<<GPS Logger Only>>
[MENU] > GPS > GPS Logger >
<<GPS Logger Only>>

Target
station
Sounds a beep�

You can turn ON the GPS Logger Only mode.
Only the GPS Logger is functioning in this mode, and
the transceiver does not transmit or receive it.

Sounds 3 beeps�

LLInformation

•• BE SURE to insert a microSD card.
•• Set “GPS Select” to “ON.” (p. 6-30)
•• To cancel the mode, restart the transceiver.
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GPS items
GPS Auto TX

(Default: OFF)

[MENU] > GPS > GPS Auto TX
Selects an option for the GPS automatic transmission
function.
This function automatically transmits the current
position data received from a GPS receiver and any
entered GPS message at the set interval.
•• OFF:	Does not automatically transmit the position
data. (When you push [PTT], the transceiver
transmits the position data.)
•• 30 sec to 30 min:
			Transmits the current position data at the
selected interval (30 seconds, or 1, 3, 5, 10,
or 30 minutes).
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Section 7

VOICE TX FUNCTION

NOTE: See the Basic manual
Section 6 for details on how to
insert or remove a microSD card
and precautions.
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Voice TX function
DRecording
D
the voice audio

The Voice TX function transmits the recorded audio
that is on the microSD card, one time or repeatedly,
for up to 10 minutes at the set interval.
This function is convenient to repeatedly call CQ, or
for other events.
You can assign the [Voice TX] key function to an
optional microphone key or optional Bluetooth
headset. (pp. 12-18, 12-34)

[MENU] > VOICE > Record
1.	 Push [MENU].
2.	 Select “VOICE.”
3.	 Select “Record.”

NOTE: BE SURE to insert a microSD card into the
transceiver.

4.	 Hold down [PTT] to record.

Displayed
while
recording

Recording time
Audio level

LLInformation
•• Hold the microphone 5 ~ 10 cm (2 ~ 4 inches) from
your mouth, then speak at your normal voice level.
•• The maximum record time is 1 minute.
•• Only 1 voice memory can be recorded.

TIP: On the VOICE TX RECORD screen,
push [QUICK], then select “Clear” to clear the
recorded audio.
5.	 Push [ENT] to confirm the recorded voice.
•• The voice is played back.

Displayed
while playing

Total time
Play back time

LLIf you hold down [PTT], the recording starts again.
In this case, the previous recorded audio will be
overwritten.
LLTo exit the MENU screen, push [MENU].
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Voice TX function

DTransmitting
D
the recorded voice audio
NOTE: BE SURE to insert a microSD card into the
transceiver.

LLInformation

•• While transmitting, the SD card icon blinks.
•• When you select “<<Repeat TX>>,” the transceiver
repeatedly transmits the recorded voice audio for up to 10
minutes at the interval set in “Repeat Time.”
([MENU] > VOICE > TX Set > Repeat Time)

[MENU] > VOICE > <<Single TX>>
[MENU] > VOICE > <<Repeat TX>>
1.	 Push [MENU].
2.	 Select “VOICE.”
3.	 Select “<<Single TX>>” or “<<Repeat TX>>.”

•• <<Single TX>>:
The recorded voice audio is transmitted only once.
•• Any of the following action cancels the transmission.
- Pushing [PTT]
- Turning OFF the transceiver, then turning it ON again.
- Pushing any key (except for [VOL] and [ ])
•• After the second transmission, the transmission continues
pausing, if receiving a signal, even if “Busy Lockout” is set
to “ON.”
([MENU] > SET > Function > Busy Lockout)
However, if the squelch is manually opened in the
FM mode, the voice audio is repeatedly transmitted,
according to the “Repeat Time” setting.
•• You can select whether or not to output the TX voice
audio from the speaker.
([MENU] > VOICE > TX Set > TX Monitor)

•• <<Repeat TX>>:
The recorded voice audio is repeatedly transmitted.

Blinks

TIP: To transmit the recorded voice audio in the
Quick Menu window, push [QUICK], then select
“Voice TX.”

Transmission is
paused
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VOICE items
Record

<<Single TX>>

[MENU] > VOICE > Record

[MENU] > VOICE > <<Single TX>>

Up to 1 minute of audio can be recorded onto a
microSD card for voice transmission. (p. 7-2)
The transceiver can save only 1 voice audio.

The transceiver transmits the recorded voice audio
only once.

LLBE SURE to insert a microSD card.
LLWhile recording a QSO, you cannot use this function.

LLYou can also select “Single TX” in the Quick Menu
window.
([QUICK] > Voice TX > Single TX)

Repeat Time

<<Repeat TX>>

(Default: 5sec)

[MENU] > VOICE > <<Repeat TX>>

[MENU] > VOICE > TX Set > Repeat Time

The transceiver repeatedly transmits the recorded
voice audio for up to 10 minutes, according to the
“Repeat Time” setting.

Sets the Repeat Time to between 1 and 15 seconds
(in 1 second steps).
The transceiver repeatedly transmits the recorded
voice audio for this set interval.

LLInformation

•• You can also select “Repeat TX” in the Quick Menu
window.
([QUICK] > Voice TX > Repeat TX)
•• If 10 minutes passes while transmitting, the transceiver
continues to transmit until the complete voice audio
transmission is finished.
•• Any of the following action cancels the transmission.
- Pushing [PTT]
- Turning OFF the transceiver, then turning it ON again.
- Pushing any key (except for [VOL] and [ ])

NOTE: The recorded voice audio is repeatedly
transmitted for up to 10 minutes. If 10 minutes
passes while transmitting, the transceiver
continues to transmit until the complete voice audio
transmission is finished.

TX Monitor

(Default: ON)

[MENU] > VOICE > TX Set > TX Monitor
Turns the TX Monitor function ON or OFF.
•• OFF:	The TX voice audio is not heard from the
speaker.
•• ON:	The TX voice audio is heard from the speaker.
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RECORDER FUNCTION

Recording a QSO audio
NOTE:

•• You must insert a microSD card into the transceiver
before recording audio.
•• The recording function is continuously ON, even if the
transceiver is turned OFF then ON again.

To start recording
1.	 Push [QUICK].
2.	 Select “<<REC Start>>.”

To stop recording
1.	 Push [QUICK].
2.	 Select “<<REC Stop>>.”

•• “Recording started.” is displayed, then returns to the
standby screen.

TIP:
•• You can select to record the received audio from
only the MAIN band or both the MAIN and SUB
bands. (p. 8-15)
([MENU] > RECORD > QSO Recorder
> Recorder Set > REC Operation)
•• When “RX REC Condition” is set to “Always,” the
recording automatically starts when
“<<REC Start>>” is selected. In that case,
recording continues, even when no signal is
received.* (p. 8-15)
([MENU] > RECORD > QSO Recorder
> Recorder Set > RX REC Condition)
* The recorded file contains no sound.

Recording standby

The recording starts when you
transmit or the squelch opens.
While recording, the SD card icon
blinks.

LLInformation

•• The recording pauses while no signal is received, and
resumes when a signal is received again.
•• The recording continues until you manually stop
recording, or the card becomes full.
•• If the recording file’s content reaches 2GB, the
transceiver automatically creates a new file, and
continues recording.
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Playing back a recorded audio
TIP: Selecting the record file type to display.
In step 6, push [QUICK], then select “Display File”
and select the record file type to display.

NOTE: Insert the microSD card that contains the
recorded audio file into the transceiver’s slot.
[MENU] > RECORD > QSO Recorder > Play Files
1.	 Push [MENU].
2.	 Select “RECORD.”
3.	 Select “QSO Recorder.”

•• ALL: Displays all recorded files.
•• A only:	Displays only the audio file that was recorded on
the A band.
•• B only:	Displays only the audio file that was recorded on
the B band.

4.	 Select “Play Files.”

The VOICE PLAYER screen description
The number of the file being played back/
The total number of recorded files.
Recording start
date and time

5.	 Select the folder that contains the audio file to play.

Band (A/B)
TX/RX

Operating
information

Play back time/
Total time
[RX→CS]
Plays the previous file

[CD]
Rewinds

LLThe folder is named in the following format:
yyyymmdd (yyyy: year, mm: month, dd: day)

[LO] Fast forwards
[ENT] Pauses or plays
[DR] Plays the next file

6.	 Select the audio file to play.
Recorded time

Fast forward [LO]/Rewind [CD]

•• Hold down to continuously fast forward, or rewind the file.
•• The default skip time is 10 seconds. If you want to
change it, see page 8-16 for details.
•• You can fast forward or rewind the file by rotating
[DIAL]. The fast forward/rewind time is 1/20 of the total
file time, regardless of the skip time setting.
•• If you push [CD] within the first 1 second of the file, the
end of the previous file is played back.

Band (A/B)

Total playback time
TX/RX
Operating mode
Operating frequency

Playing the previous file [RX→CS]

•• While the oldest file in the folder is playing back,
pushing [RX→CS] plays back the same file.
•• While the file is paused, pushing [RX→CS] moves to
the beginning of the previous file.

•• The VOICE PLAYER screen is displayed, and the file
starts to play.

Playing the next file [DR]
While the latest file in the folder is playing back,
pushing [DR] plays back the same file.
Operating information
The operating frequency, mode, and audio category
(RX/TX audio) are displayed.
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Changing the QSO recorder settings
You can change the recording settings.
See pages 8-15 and 8-16 for details.
Continue to record, even while the squelch is
closed

Synchronize the recording to PTT
[MENU] > RECORD > QSO Recorder >
Recorder Set > PTT Auto REC

[MENU] > RECORD > QSO Recorder >
Recorder Set > RX REC Condition

LLThe default setting is “ON” (Recording is synchronized to
PTT).

LLThe default setting is “Squelch Auto” (Records only while
the squelch is open).

TIP: When “PTT Auto REC” is set to “ON”

•• Starts recording not only when [PTT] is pushed, but also
when switched to transmit by a speaker microphone
or a Bluetooth headset, by a CI-V command, or by the
VOX function.
•• A signal that is received within 10 seconds after the
squelch is closed is recorded in the same file.

Record the QSO audio as one file
[MENU] > RECORD > QSO Recorder >
Recorder Set > File Split

Change the Skip Time
[MENU] > RECORD > QSO Recorder >
Player Set > Skip Time

LLThe default setting is “ON” (transmit and receive audio
are separately recorded in different files).
LLWhen “RX REC Condition” is set to “Squelch Auto,” an
audio file is created every time the squelch opens. The
received audio is recorded in a separated file.

Separately start or stop recording on the selected
band (MAIN band)

LLThe default setting is “10sec.”

[MENU] > RECORD > QSO Recorder >
Recorder Set > REC Operation

LLThe default setting is “A/B Link” (recording simultaneously
starts on the MAIN and SUB bands).
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Deleting the audio folder/file
NOTE: A deleted audio file can NOT be recovered.

DDeleting
D
an audio folder
NOTE: All audio files in the folder are deleted.
[MENU] > RECORD > QSO Recorder > Play Files
1.	 Push [MENU].
2.	 Select “RECORD.”
3.	 Select “QSO Recorder.”

TIP: To delete all folders
Select “Delete All Folders” in step 7.

4.	 Select “Play Files.”

5.	 Select the folder to delete.

LLDO NOT push [ENT].

6.	 Push [QUICK].
7.	 Select “Delete.”

•• The confirmation dialog is displayed.

8.	 Select “YES.”

•• The folder is deleted.
LLTo exit the MENU screen, push [MENU].
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Deleting the audio folder/file

DDeleting
D
an audio file
[MENU] > RECORD > QSO Recorder > Play Files
1.	 Push [MENU].
2.	 Select “RECORD.”
3.	 Select “QSO Recorder.”

TIP: To delete all files
Select “Delete All” in step 8.

LLIf “Display File” is set to “A only” or “B only,” only
displayed files are deleted.

•• “Display File” is “ALL”

4.	 Select “Play Files.”

•• “Display File” is “A only”

5.	 Select the folder that contains the audio file to delete.

•• “Display File” is “B only”

6.	 Select the audio file to delete.

LLDO NOT push [ENT].

7.	 Push [QUICK].
8.	 Select “Delete.”

•• The confirmation dialog is displayed.

9.	 Select “YES.”

•• The file is deleted.
LLTo exit the MENU screen, push [MENU].
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Viewing the file information
The recorded audio file contains the recording data.
See page 8-8 for the recorded contents.

[MENU] > RECORD > QSO Recorder > Play Files

8.	 Select “File Information.”

1.	 Push [MENU].
2.	 Select “RECORD.”
3.	 Select “QSO Recorder.”

4.	 Select “Play Files.”

9.	 Rotate [DIAL] to change the screen.

LLTo exit the MENU screen, push [MENU].

5.	 Select the folder that contains the audio file to
view the information.

TIP: To view the folder information
Push [QUICK] in step 5, and then select “Folder
Information” to view the folder information.

6.	 Select the audio file to view the information.

Folder name
Total files (total size)
Created date and time
LLDO NOT push [ENT].

7.	 Push [QUICK].
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Viewing the file information
File information examples

LLDepending on the recording status, some data may not be displayed.
LLThe file is named in the following format: yyyymmdd_hhmmss
(yyyy: year, mm: month, dd: day, hh: hour, mm: minute, ss: second)

•• TX audio file information

•• RX audio file information

Operating information (TX)
Recording date and time

Operating information (RX)
Recording date and time

MY station position

MY station position

DR setting

Caller and received repeater

File data

RX station position

File data
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Using the Voice Recorder function
The microphone audio, including audio from an
external microphone, can be recorded for your
convenience.

LLDepending on the microSD card capacity, you may
continuously record up to a maximum of about 37 hours.
If the file size exceeds 2 GB, a new file is automatically
created in the same folder, and the recorded voice audio
is saved there.

NOTE: You must insert a microSD card into the
transceiver before recording audio.

DTo
D start recording
5.	 Push [PTT] to start recording.

NOTE: You cannot record a voice while recording
a QSO. In that case, push [QUICK] in the standby
screen, and then select “Stop Recording” to stop the
QSO recording.

•• The microphone audio recording starts.

Recording time

[MENU] > RECORD > Voice Recorder > Record
1.	 Push [MENU].
2.	 Select “RECORD.”
3.	 Select “Voice Recorder.”

Microphone input level

6.	 Push [PTT] again to stop.

LLTo exit the MENU screen, push [MENU].

TIP: Even if the external microphone or Bluetooth
headset is connected, the internal microphone’s
voice audio is recorded when the transceiver’s [PTT]
is pushed.
To record the external microphone’s voice audio,
hold down the external microphone’s [PTT].
To record the Bluetooth headset’s voice audio, hold
down the Bluetooth headset’s [PTT].

4.	 Select “Record.”

To change the microphone gain level
Push [QUICK] in the VOICE RECORDER screen,
and then select “MIC Gain.”

Remaining time
Microphone gain level
•• The VOICE RECORDER screen is displayed.
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Using the Voice Recorder function

DPlaying
D
back a recorded audio
NOTE: You cannot play back a recorded audio while
recording a QSO. In that case, push [QUICK] in the
standby screen, and then select “Stop Recording” to
stop the QSO recording.

The VOICE PLAYER screen description
The number of the file being played back/
The total number of recorded files.
Recording start
date and time

[MENU] > RECORD > Voice Recorder > Play Files
1.	 Push [MENU].
2.	 Select “RECORD.”
3.	 Select “Voice Recorder.”

Play back time/
Total time
[RX→CS]
Plays the previous file
[CD]
Rewinds

[LO] Fast forwards
[ENT] Pauses or plays
[DR] Plays the next file

4.	 Select “Play Files.”

Fast forward [LO]/Rewind [CD]

•• Hold down to continuously fast forward or rewind the file.
•• The default skip time is 10 seconds. If you want to
change it, see page 8-16 for details.
•• You can fast forward or rewind the file by rotating
[DIAL]. The fast forward/rewind time is 1/20 of the total
file time, regardless of the skip time setting.
•• If you push [CD] within the first 1 second of the file, at
the end of the previous file is played back.

5.	 Select the folder that contains the audio file to play.

Playing the previous file [RX→CS]

•• While the oldest file in the folder is playing back,
pushing [RX→CS] plays back the same file.
•• While the file is paused, pushing [RX→CS] moves to
the beginning of the previous file.

Playing the next file [DR]
While the latest file in the folder is playing back,
pushing [DR] plays back the same file.

LLThe folder is named in the following format:
yyyymmdd (yyyy: year, mm: month, dd: day)

6.	 Select the audio file to play.
Recorded time

Total playback time
•• The VOICE PLAYER screen is displayed, and the file
starts to play.
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Using the Voice Recorder function

DDeleting
D
an audio folder
NOTE:

TIP: To delete all folders
Select “Delete All Folders” in step 7.

•• All audio files in the folder are deleted.
•• A deleted audio file can NOT be recovered.

[MENU] > RECORD > Voice Recorder > Play Files
1.	 Push [MENU].
2.	 Select “RECORD.”
3.	 Select “Voice Recorder.”

4.	 Select “Play Files.”

5.	 Select the folder to delete.

LLDO NOT push [ENT].

6.	 Push [QUICK].
7.	 Select “Delete.”

•• The confirmation dialog is displayed.

8.	 Select “YES.”

•• The folder is deleted.
LLTo exit the MENU screen, push [MENU].
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Using the Voice Recorder function

DDeleting
D
an audio file
NOTE: A deleted audio file can NOT be recovered.
[MENU] > RECORD > Voice Recorder > Play Files
9.	 Select “YES.”

1.	 Push [MENU].
2.	 Select “RECORD.”
3.	 Select “Voice Recorder.”

•• The file is deleted.
LLTo exit the MENU screen, push [MENU].

4.	 Select “Play Files.”

TIP: To delete all files
Select “Delete All” in step 8.

5.	 Select the folder that contains the audio file to delete.

6.	 Select the audio file to delete.

LLDO NOT push [ENT].

7.	 Push [QUICK].
8.	 Select “Delete.”

•• The confirmation dialog is displayed.
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Using the Voice Recorder function

DViewing
D
the file information
[MENU] > RECORD > Voice Recorder > Play Files
1.	 Push [MENU].
2.	 Select “RECORD.”
3.	 Select “Voice Recorder.”

TIP: To view the folder information
Push [QUICK] in step 5, and then select “Folder
Information” to view the folder information.

4.	 Select “Play Files.”
Folder name
Total files (total size)
Created date and time

5.	 Select the folder that contains the audio file to
view the information.

6.	 Select the audio file to view the information.

LLDO NOT push [ENT].

7.	 Push [QUICK].
8.	 Select “File Information.”

LLTo exit the MENU screen, push [MENU].
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Playing back the recorded audio on the PC
You can play back the recorded audio on your PC.
LLOperation data is not displayed.
LLWindows 10 is used for these instructions.

Example: P
 laying back the audio file on the microSD
card on your PC.
1.	 Insert the microSD card into the memory card slot
or memory card reader on your PC.

5.	 Double-click the folder that contains the audio file
to play it back. (Example: “20211101”)

Double-Click
microSD
card

ID-52A/E

To the
card reader

6.	 Double-click the file to play it back.
(Example: “20211101_152135A.wav”)

PC

2.	 Click the “Open folder to view files” option to
access the card.
Double-Click

LLSee the instruction manual of your player for
operation details.
LLThe audio file may not play back, depending on the
player.

Click

3.	 Double-click the ‘ID-52’ folder.

TIP: When “USB Connect” is set to “SD Card Mode,”
and the transceiver is connected to the PC through a
USB data cable, you can directly access the microSD
card that is set in the transceiver from the PC.
([MENU] > SET > Function > USB Connect)

Double-Click
4.	 Double-click the ‘Voice’ folder.

Double-Click
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RECORD items
<<REC Start>>

RX REC Condition

[MENU] > RECORD > QSO Recorder >
<<REC Start>>

(Default: Squelch Auto)

[MENU] > RECORD > QSO Recorder >
Recorder Set > RX REC Condition

After selecting “<<REC Start>>,” starts QSO
recording.

Selects whether or not the squelch status affects the
received voice audio recording.
•• Always:	The transceiver always records the
receive voice audio regardless of the
squelch status.
•• Squelch Auto:	The transceiver records the receive
voice audio only when a signal is
received (the squelch is opened).
When the squelch closes while
recording, the recording will continue
for 2 seconds, and then pause.

•• “Recording started.” is displayed.

LLInformation

•• BE SURE to insert a microSD card.
•• While recording, “<<REC Stop>>” is displayed on the
QSO RECORDER screen. To stop recording, select
“<<REC Stop>>.”
•• Once a recording has started, the recording will continue,
even if the transceiver is turned OFF and then ON again.

Play Files

File Split

[MENU] > RECORD > QSO Recorder > Play Files

(Default: ON)

[MENU] > RECORD > QSO Recorder >
Recorder Set > File Split

Displays saved voice data folders.

LLBE SURE to insert a microSD card.

Turns the File Split function ON or OFF.
•• OFF:	Once a recording starts, the transceiver
continues to record on the same file.

Playing back:
1.	 Select a folder that contains the file you want to
playback.
2.	 Select a file to playback.

LLIf the file size exceeds 2 GB, a new file is
automatically created in the same folder, and the
voice audio is recorded there.

•• The VOICE PLAYER screen is displayed and starts
playing back the audio.
LLSee page 8-3 for details.

•• ON:	During recording, if transmission and
reception, or squelch status* (open and close)
is changed, a new file is automatically created
in the same folder, and the voice audio is
saved into a new file.
* Only when “RX REC Condition” is set to
“Squelch Auto.”

3.	 Push [MENU] to exit the VOICE PLAYER screen.
NOTE:

•• The folder is automatically named, as shown below:
(Example)
Recording date:
1st November 2021
Folder name:
20211101
•• The file is automatically named, as shown below:
(Example)
Recording date and time: 1st November 2021 15:30:00
File name:
20211101_153000
•• The voice audio is recorded onto a microSD card, and
saved in the “wav” format. (“.wav” is not displayed on
the transceiver’s screen.)
•• The recorded voice audio can also be played back on a
PC.

REC Operation

(Default: A/B Link)

[MENU] > RECORD > QSO Recorder >
Recorder Set > REC Operation
Selects the recording operation on the dual band
display.
•• A/B Separate:	The recording function is separately
active/inactive on the selected band
(MAIN band) when the function is
started or stopped.
•• A/B Link:	The recording function is
simultaneously active/inactive on
both MAIN and SUB bands when the
function is started or stopped.
 On the single band display,
only displayed band (A or B) is
recorded.
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RECORD items
PTT Auto REC

Play Files

(Default: ON)

[MENU] > RECORD > Voice Recorder > Play Files

[MENU] > RECORD > QSO Recorder >
Recorder Set > PTT Auto REC

Plays back the voice audio that is recorded on the
VOICE RECORDER screen.
Push [ENT] to display the folders that contain the
recorded voice audio files.

Turns the PTT Automatic Recording function ON or OFF.
LLTransmitting from a speaker microphone or a Bluetooth
headset, using the VOX function, or sending a CI-V
command also starts recording.

LLBE SURE to insert a microSD card.

•• OFF:	Turns OFF the function.
•• ON:	The recording automatically starts when you
push [PTT].

MIC Gain
[MENU] > RECORD > Voice Recorder >
Recorder Set > MIC Gain

The recording stops when:
•• No signal is transmitted for 10 seconds after releasing [PTT].
•• No signal is received for 10 seconds after releasing [PTT].
LLWhen the transceiver receives a signal within
10 seconds after releasing [PTT], the recording
automatically starts.
•• The operating frequency, Frequency Selecting mode,
or operating mode is changed after releasing [PTT].

Skip Time

(Default: 3)

Sets the internal microphone sensitivity to between 1
(minimum sensitivity) and 4 (maximum sensitivity) for
the Voice Recorder function. Higher values make the
microphone more sensitive to your voice.
Skip Time

(Default: 10sec)

[MENU] > RECORD > Voice Recorder >
Player Set > Skip Time

(Default: 10sec)

[MENU] > RECORD > QSO Recorder >
Player Set > Skip Time

Sets the Skip Timer to 3, 5, 10, or 30 seconds to
rewind or skip forward for this set period of time when
you push the fast-rewind or fast-forward key while
playing the recorded voice audio.

Sets the Skip Timer to 3, 5, 10, or 30 seconds to
rewind or skip forward for this set period of time when
you push the fast-rewind or fast-forward key while
playing the recorded QSO audio.

LLSee “The VOICE PLAYER screen description” for
forwarding or rewinding. (p. 8-10)

LLSee “The VOICE PLAYER screen description” for
forwarding or rewinding. (p. 8-3)

DV Auto Reply
[MENU] > RECORD > DV Auto Reply

Record

Up to 10 seconds of audio can be recorded for the
Automatic Reply function.

[MENU] > RECORD > Voice Recorder > Record
Push [ENT] to display the VOICE RECORDER
screen, and then push [PTT] to start a voice
recording. While recording, push [PTT] again to stop
the recording. (p. 8-9)

LLBE SURE to insert a microSD card.
LLSee page 5-25 for details.

LLInformation

•• BE SURE to insert a microSD card.
•• This function cannot record a QSO.
•• While recording a QSO, you cannot use this function.
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General description
The Memory mode enables you to quickly select
often-used frequencies, modes, and other parameters.
While operating in the Memory mode, you can
temporarily change the operating frequency, mode,
and so on, without overwriting the memory channel
contents.
Group

00 to 99

CALL CH

Memory
channel
00 to 99

NOTE: Memory content may be accidentally
cleared by static electricity, electric transients,
and other causes. In addition, it may be cleared
by a malfunction, or during repairs. Therefore, we
recommend that you backup the Memory content or
save it onto a microSD card* or a PC.

*User supplied
LLThe CS-52 programming software can also be used
to backup your memory content. See its instruction
manual for details.

Descriptions
Regular memory channels.
Up to 1000 channels can be
separately stored in the 100
memory channel groups.

144 C0/C1 Call channels each of the 144 and
430 C0/C1 430 bands.

DMemory
D
channel content

The following information can be entered into the
Memory channels:

•• Operating frequency
•• Duplex ON/OFF
•• Duplex direction (DUP+ or DUP–)
•• Duplex frequency offset
•• Memory name
•• Scan skip setting
•• Tuning step
•• Operating mode
•• Subaudible tone encoder, tone squelch, or DTCS squelch
ON/OFF
•• Subaudible tone frequency, tone squelch frequency, or
DTCS code with polarity
•• Digital code
•• Digital Call sign squelch or Digital code squelch ON/OFF
•• UR station call sign
•• R1/R2 call signs
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Selecting a Memory channel

Selecting a Call channel

In the Memory mode, you can select the Memory
channels by rotating [DIAL].

Call channels are used for quick recall of most often
used operating frequencies.
Factory default frequencies and operating modes are
entered into the Call channels. Change these to suit
your operating needs.

1.	 Push [MR] to enter the Memory mode.

1.	 Hold down [CALL] for 1 second to enter the Call
Channel mode.

LLFor only the ID-52A, pushing [MR] each time selects
the Memory and Weather Channel modes.

2.	 Rotate [DIAL].

•• Selects a Memory channel.
LLBlank channels are not selected.
LLTo select a Memory Group, push [QUICK], and then
select “Group Select.”
LLThe Memory channels are commonly used for the A
and B bands. On the B band, if you select a memory
channel that is out of the selectable frequency range,
“
” is displayed, and the signal cannot be received.

2.	 Rotate [DIAL].

•• Selects a Call channel.

TIP: To sequentially select a channel in a
different group
1.	 Push [QUICK].
2.	 Select “Channel Select Group Range.”

3.	 Select “All Groups.”
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Entering Memory channel contents
After selecting a frequency in the VFO mode, you can
enter it into a selected channel or an automatically
selected blank channel.

DEntering
D
into a selected channel
Example: E
 ntering 146.030 MHz/FM mode into
Channel 11 in Group 01.
1.	 Push [VFO/MHz] to enter the VFO mode.
2.	 Push [MODE] to enter the FM mode.
3.	 Rotate [DIAL] to set a frequency to 146.030 MHz.

10.	Push [ENT].

•• The confirmation dialog is displayed.

11.	 Select “YES.”

•• Beeps sound and the Memory contents are briefly
displayed, then returns to the VFO mode.

4.	 Hold down [MW] for 1 second.

•• A short and a long beep sound.

5.	 Select “Write to New CH.”

TIP: In step 7, you can select the following options.
•• NAME:
Displays the Memory name edit screen. (p. 9-11)
•• SKIP:
Displays the SKIP setting items.
•• Group Select:
Displays the GROUP SELECT screen.
•• <<Write>>:
Enters into the selected Memory channel.
•• <<Insert Write>>:
Inserts a Memory channel above the selected
channel.

6.	 Push [QUICK].
7.	 Select “Group Select.”

8.	 Select Group “01.”

9.	 Rotate [DIAL] to select Channel “11.”
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Entering Memory channel contents

DOverwriting
D
to the selected channel

DEntering
D
to a blank channel

Example: E
 ntering 146.330 MHz/FM mode into
Channel 11 in Group 01.
1.	 Push [MR] to enter the Memory mode.

Example: Entering 441.100 MHz/FM mode into a
blank channel.
1.	 Push [VFO/MHz] to enter the VFO mode.
2.	 Push [MODE] to enter the FM mode.
3.	 Rotate [DIAL] to set a frequency to 441.100 MHz.

You can write a frequency into a pre-entered channel.

LLFor only the ID-52A, pushing [MR] each time selects
the Memory and Weather Channel modes.

2.	 Rotate [DIAL] to select Channel 11 in Group 01.

4.	 Hold down [MW] for 3 seconds.
LLTo select a Memory Group, push [QUICK], and then
select “Group Select.”

3.	 Push [VFO/MHz] to enter the VFO mode.
4.	 Rotate [DIAL] to set a frequency to 146.330 MHz.

•• The Memory contents are briefly displayed for 2
seconds, then returns to the VFO mode.

5.	 Hold down [MW] for 1 second.

•• A short and a long beep sound.

6.	 Select “Write to Selected CH.”

7.	 Push [MR].
8.	 Select “YES.”

•• Beeps sound and the Memory contents are briefly
displayed, then returns to the VFO mode.
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Copying Memory content to the VFO
It is convenient when you want to operate on a
channel frequency near a Memory or Call channel.
Example: C
 opying Memory Channel 11 in Group 01
to the VFO.
1.	 Push [MR] to enter the Memory mode.

LLFor only the ID-52A, pushing [MR] each time selects
the Memory and Weather Channel modes.

2.	 Rotate [DIAL] to select Channel 11 in Group 01.

LLTo select a Memory Group, push [QUICK], and then
select “Group Select.”

3.	 Hold down [MW] for 1 second.

•• A short and a long beep sound.

4.	 Select “Copy to VFO.”

5.	 Select “YES.”

•• Beeps sound and copies the selected Memory
contents to the VFO, then returns to the VFO mode.
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MEMORY screen
DViewing
D
the Memory channel contents

On the MEMORY screen, you can easily manage the
Memory or Call channel content.

You can view the Memory channel contents on the
MEMORY screen.

DTree
D
view of the MEMORY screen
Memory CH

Example: Viewing the contents of Channel 01 in
Group 00.

Group 00

[MENU] > MEMORY > Memory CH
1.	 Push [MENU].
2.	 Select “MEMORY” on the second page of the
MENU screen.

00

MEMORY

99

LLIn the VFO, Memory, or Call Channel mode, you can
open the MEMORY screen by holding down [MW] for
1 second, then selecting “Manage Memory.”

Group 99

3.	 Select “Memory CH.”
4.	 Select Group “00.”

S: SKIP CH*
Call CH

144 C0
144 C1
430 C0
430 C1

5.	 Select Channel “01.”
Your Call Sign
Repeater List

* Skips the set frequency during a scan.
(While a VFO scan is paused and if you want to skip
the frequency, holding down [MW] for 1 second sets
the frequency as the Skip channel.)

•• Channel contents are displayed.
LLRotate [DIAL] to scroll the screen.
LLTo exit the MENU screen, push [MENU].

TIP: To edit, copy, or clear the memory content.
1.	 Push [QUICK] in step 5.
2.	 Select “Edit,” “Copy,” or “Clear.”
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Copying Memory contents to another Memory channel
You can copy the memory content to another Memory
channel.
Example: C
 opying Channel 01 in Group 00 to
Channel 06 in Group 00.
[MENU] > MEMORY > Memory CH
1.	
2.	
3.	
4.	
5.	

8.	 Select the destination channel.

Push [MENU].
Select “MEMORY.”
Select “Memory CH.”
Select Group “00.”
Select Channel “01.”

LLDO NOT push [ENT].

6.	 Push [QUICK].
7.	 Select “Copy.”

•• Beeps sound, and the contents are copied to the
destination channel.
LLIf the selected channel is not blank, a confirmation
dialog is displayed. When you select “YES,” the
Memory contents are overwritten.

TIP: To copy the channel to a different group
In step 6, while “DESTINATION” is displayed, push
[QUICK] and select “Group Select.”

•• The GROUP SELECT screen is displayed.
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Moving the Memory contents to another channel in a different group
You can move the memory content to another Memory
channel in a different group.
Example: M
 oving Channel 01 in Group 00 to Channel
00 in Group 02.
[MENU] > MEMORY > Memory CH
1.	
2.	
3.	
4.	
5.	

11.	 Select the destination channel.

Push [MENU].
Select “MEMORY.”
Select “Memory CH.”
Select Group “00.”
Select Channel “01.”

LLDO NOT push [ENT].

6.	 Push [QUICK].
7.	 Select “Move.”

•• Beeps sound, and the contents are moved to the
destination channel.
LLChannels other than the one that you moved will
move up.

TIP: To rearrange the display order in the
selected group
In step 7, while “DESTINATION” is displayed, go to
step 11.

8.	 Push [QUICK].
9.	 Select “Group Select.”

10.	Select the destination group.
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Inserting a blank channel
You can insert a blank channel between 2 Memory
channels. This function is convenient to organize your
memory channels.
Example: Inserting a blank channel between Channel
00 and 01 in Group 00.
[MENU] > MEMORY > Memory CH
1.	
2.	
3.	
4.	
5.	

Push [MENU].
Select “MEMORY.”
Select “Memory CH.”
Select Group “00.”
Select Channel “01.”

TIP: To insert a blank group
On the Memory Group screen, select a group and
push [QUICK], then select “Insert Group.”

•• A blank group is inserted above the selected group.
LLDO NOT push [ENT].

6.	 Push [QUICK].
7.	 Select “Insert.”

•• Beeps sound, a blank channel is inserted above the
selected channel.
LLIf you select channel 99 in step 5, a confirmation
dialog is displayed. When you select “YES,” channel
99 is deleted.
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Entering a group/memory name
You can assign a name of up to 16 characters to each
channel group (00 ~ 99) and memory channel.
Example: E
 ntering “Calling” as a Memory name to
Channel 01 in Group 00.
[MENU] > MEMORY > Memory CH
1.	
2.	
3.	
4.	
5.	

Push [MENU].
Select “MEMORY.”
Select “Memory CH.”
Select Group “00.”
Select Channel “01.”

10.	After entering, push [ENT].

11.	 Select “<<Overwrite>>.”

LLDO NOT push [ENT].

6.	 Push [QUICK].
7.	 Select “Edit.”

12.	Select “YES.”

8.	 Select “NAME.”

•• Beeps sound, then returns to the Memory channel
screen.

TIP: To enter a group name
On the Memory Group list screen, select a group
and push [QUICK], then select “Edit Name.”

9.	 Enter a name.

•• The Group Name edit screen is displayed.
LLSee page iii on how to enter characters.
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Selecting a memory name display
While in the memory mode, the entered memory
name can be displayed in different styles. You can
select a display type.

TIP: There are 5 types of Memory name displays.
•• Freq (Name OFF):
Displays only the frequency.

Example: S
 electing “Name (Large)” in the Single
band display.
1.	 Push [MR] to select the Memory mode.

LLFor only the ID-52A, pushing [MR] each time selects
the Memory and Weather Channel modes.

2.	 Push [QUICK].
3.	 Select “Display Type.”

•• Freq (Normal Name):
Displays the large font sized frequency and small font
sized Memory name.
LLIn the Dual band display, select “Freq.”

4.	 Select a display type.

•• Freq (Large Name):
Displays the large font sized frequency and large font
sized Memory name.
LLYou cannot select in the Dual band display.

LL“Freq (Name OFF)” is set as the default.

•• Name (Normal):
Displays the small font sized Memory name and small
font sized frequency.

•• Name (Large):
Displays the large font sized Memory name and small
font sized frequency.
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Clearing a Memory contents
Contents of entered memories can be cleared
(erased), if desired.

LLThe cleared channel becomes a blank channel.
LLYou can also clear the Skip channels (Group “S”).

NOTE: Cleared memory channel contents cannot be
restored.
Example: C
 learing channel 01 in group 00.
[MENU] > MEMORY > Memory CH
1.	
2.	
3.	
4.	
5.	

Push [MENU].
Select “MEMORY.”
Select “Memory CH.”
Select Group “00.”
Select Channel “01.”

TIP: To Delete a memory channel
In step 7, select “Delete (next CH moves up).”

•• The selected channel is deleted.
LLYou can also delete Memory groups.
Select a group, then select “Delete Group.”

LLDO NOT push [ENT].

6.	 Push [QUICK].
7.	 Select “Clear.”

8.	 Select “YES.”

•• Beeps sound, and the contents are cleared.
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Scan Type
Scanning is a versatile function that can automatically search for signals. A scan makes it easier to locate stations
to contact or listen to, or to skip unwanted channels or frequencies.

DVFO
D
scan

DMemory
D
scan

The VFO scan searches for signals within the
specified frequency range.

The Memory scan searches signals on the
preregistered memory channels.

Full scan (ALL)
Repeatedly scans the entire band.

ALL scan (ALL)
Repeatedly scans all memory channels.

ID-52A/E
RX frequency
lower end

Memory Groups (00 ~ 99 and S: Skip CH)
Scan

ID-52A/E
RX frequency
upper end

P SKIP

Scan

00

P SKIP

Band edge frequency
upper end

Scan

AM

Upper edge

00

AM

DV

AM

01

02

98 99

Unchecked groups are skipped

AM

S

Jump

LLAt least 2 groups must be checked to start a Group Link
scan. ([MENU] > SET > Scan > Group Link)
See page 10-10 for more details.

LLSee page 10-8 for more details.

Group scan (GROUP 00 ~ 99)
Scans the Memory channels in the selected group.

Program scan edges (Example: P00 ~ P10)
Scan
P03

Scan

Memory Groups (00 ~ 99 and S: Skip CH)
Scan

Program Link scan (P-LINK 0 ~ 9)
Sequentially scans the Program Scan ranges. The
links are set on the MENU screen.
([MENU] > SET > Scan > Program Link)

P02

FM

Group link scan (GROUP LINK)
Sequentially scans the memory groups that are set to
link on the MENU screen.

Jump

P01

Jump

Modes other than AM are skipped

LLAt least one Program Scan range (P-Scan Edges) must
be entered to start a Program scan.
([MENU] > SET > Scan > P-Scan Edge)
See page 10-7 for more details.

P00

S

Example: S
 canning AM mode
Memory group 02

PSKIP Scan PSKIP
Jump

99

LLThe Mode scan scans all memory groups.
(Group 00 ~ 99, S: SKIP CH)

Program scan (P00 ~ P24)
Repeatedly scans the selected Program Scan range
(P-Scan Edge 00 ~ 24).
Scan range

98

Mode scan (MODE)
Scans memory channels that are entered with the
same operating mode as the currently selected mode.

PSKIP

Jump

Lower edge

03

Selected band scan (BAND)
Scans all memory channels on the same frequency
band as the selected channel.

Band scan (BAND)
Repeatedly scans the selected band.

PSKIP

02

Empty groups are skipped

Jump

Band edge frequency
lower end

01

P10

Jump
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Scan Type
Duplex (DUP) scan
The Duplex scan searches for signals on both TX
and RX frequencies used in duplex operation
(p. 11-4).

LL“D–” or “D+” is displayed in the Duplex mode.
LLA Duplex scan does not start when the frequency offset
is set to “0.000.00 MHz.”

Tone scan
The Tone scan searches for signals with tone
frequencies or DTCS codes from stations using the
Tone Squelch function.
LLA Tone scan is usable in any VFO, Memory, or Call
channel mode.
LLDuring a scan, rotate [DIAL] to change the scan
direction.
LLSee pages 15-8 and 15-9 about the Tone Squelch
function and DTCS Code Squelch function.
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About Scans
D[DIAL]
D
operation during a scan

DOperating
D
mode during a scan

DSquelch
D
setting for a scan

DWhen
D
a signal is received

•• Rotate [DIAL] to change the scan direction during a scan.
•• When the scan is paused, rotate [DIAL] to resume the
scan.

•• The VFO scan uses the selected operating mode.
•• During a Memory mode scan, the operating mode
entered into the channel is used.

You can change the squelch level to suit your
operating needs. Set the squelch level to open the
squelch, according to the received signal strength.

When a signal is received, the scan pauses for this
set period of time. (p. 12-5)
When a received signal disappears, the scan resumes
for this set period of time. (p. 12-5)

LLDuring a scan, rotate [DIAL] while holding down [SQL]
to adjust the squelch level. The scan resumes after
adjusting.

LLThese settings can be separately set to A band and B band.

[MENU] > SET > Scan > Pause Timer
[MENU] > SET > Scan > Resume Timer

Blinks
Blinks

DTuning
D
step for a VFO scan

The selected tuning step is applied to the scan.
For a Program scan or Program Link scan, set the
tuning step in the Program Scan Edge ranges (P-Scan
Edge).

DScan
D
Stop Beep function

The Scan Stop Beep function sounds a beep when a
signal is received.
This function can be turned ON or OFF on the MENU
screen. (p. 12-29)

DScan
D
Skip function

The skip function speeds up scanning by not scanning
those frequencies set as skip channels.

[MENU] > SET > Sounds > Scan Stop Beep

LLThese settings can be separately set to A band and B band.

In the VFO mode
The frequencies that are set as “PSKIP” are skipped
during a scan. (p. 10-6)
In the Memory mode
The frequencies that are set as skip channels “PSKIP”
and “SKIP” are not scanned. (p. 10-11)
LLYou must enter 2 or more Memory channels to start a
memory scan.

TIP: When “Program Skip” is set to OFF, you cannot
use the Program Skip scan function. (p. 12-5)
([MENU] > SET > Scan > Program Skip)
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VFO Scan
DScan
D
Type

1.	 Push [VFO/MHz] to enter the VFO mode.
2.	 Push [MODE] to select the operating mode.
3.	 Hold down [SCAN] for 1 second.

•• ALL:		
Full scan
•• BAND:
Band scan
•• DUP:		Duplex scan
(Displayed only when Duplex is set)
•• P-LINK0 ~ 9: Program Link scan
•• P00 ~ 24:
Program scan
•• TONE:	Tone scan
(For the Tone Squelch scanning)

•• Opens the Scan Type Select window.

4.	 Select a scan type.

LLInformation
•• The frequencies that are set as a Skip channel
(PSKIP) are skipped during a scan. (p. 10-6)
•• When “Program Skip” is set to “OFF,” the Skip channel
frequencies are not skipped. (p. 12-5)
([MENU] > SET > Scan > Program Skip)
•• To set a Program Link scan, see page 10-8.
•• To set a Program scan, see page 10-7.

Blinks

TIP:

•• During a scan, rotate [DIAL] to change the scanning
direction.
•• During a scan, push [MODE] to select the operating
mode.
•• During a scan, hold down [
] to turn the Lock
function ON or OFF.
•• The scan continuously runs, even if you push [MENU]
or [QUICK] during a scan.
•• You can select a scan type by rotating [DIAL] while
holding down [SCAN]. Release [SCAN] to start the
scan.

•• The scan starts.
•• The decimal point and the selected Scan Type icon
blink.
LLWhen receiving a signal, the S-meter displays the
received signal strength.

5.	 Hold down [SCAN] for 1 second.

•• Cancels the scan.
LLPushing [CLR] also cancels the scan.
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VFO Scan

DAbout
D
a Program scan name

DStoring
D
the skip frequencies

When a Scan name is entered to a Program scan, the
name is displayed in the Scan Type Select window.
(p. 10-5)

You can skip unnecessary frequencies during a scan.
While a scan is paused and if you want to skip the
frequency, you can store it into the Skip channels
group S (00 ~ 99) as a Skip channel (PSKIP).
The Scan Skip function speeds up a scan.

When the Scan name is entered

1.	 While a VFO scan is paused, hold down [MW] for
1 second.

LLThe name is not displayed during a scan.
LLTo enter the name, see page 10-7.

When the Scan name is not entered

•• The window, as shown above, is displayed.

2.	 Select “Adds to SKIP MR Group.”

•• Two short beeps sound.
•• The frequency is stored in the Skip channels group.
•• After storing, the scan resumes.
LLIf there is no blank channel, an error beep sounds,
and the frequency is not stored.

TIP: Once a frequency is set as a Skip channel, the
frequency is skipped until you clear the skip setting.
To clear the skip setting, see page 10-11.

DAbout
D
a Program Link scan name
When a Program Link scan name is entered, it is
displayed in the Scan Type Select window.
(p. 10-5)

LLThe skip setting is also cleared when the Memory
channel set as a Skip channel is cleared.

LLThe name is not displayed during a scan.
LLTo enter the name, see page 10-8.

When a Program Link name is entered

When a Program Link name is not entered
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VFO Scan

DEntering
D
Program Scan Edges

You can enter the upper and lower frequency edges
for a Program scan.
Each Program Scan range has its tuning step and
operating mode setting.
You can enter up to 25 Program Scan ranges (P-Scan
Edge) on the MENU screen.
[MENU] > SET > Scan > P-Scan Edge
8.	 After editing contents, select “<<Write>>.”

1.	 Push [MENU].
2.	 Select “Scan” in the “SET” menu.
3.	 Select “P-Scan Edge.”

•• The confirmation dialog is displayed.

9.	 Select “Yes.”

4.	 Select a blank Program scan range “00” ~”24.”

LLDO NOT push [ENT].

LLTo exit the MENU screen, push [MENU].

5.	 Push [QUICK].
6.	 Select “Edit.”

TIP:

•• To clear the Program scan range, select “Clear” in step 6.
•• When scanning a range where the set “TS” or “MODE”
cannot be used, the preset “TS” or “MODE” setting on
each band is applied.

•• The edit screen is displayed.

7.	 Select “FREQ LOW” or “FREQ HIGH” to enter the
lower edge and higher edge, and then push [ENT].
LLInformation

•• Rotate [DIAL] to select the item, and push [ENT] to
enter the edit screen.
•• Set the lower edge and higher edge by rotating
[DIAL].
Push [VFO/MHz] to select the 1 MHz tuning step.
•• When the “NAME” is entered, it displays on the Scan
Type Select window.
See page iii on how to enter characters.
•• When the “TS” (Tuning Step) and/or “MODE” is
blanked, they have used the current setting on the
VFO mode.
The “TS” and “MODE” must be set to match with your
desired signals.
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VFO Scan

DAbout
D
the Program Link Scan

DSetting
D
the Program Link function

This item sets the Link function for 2 or more
Program Scan ranges to sequentially scan during a
Program Link scan. The Program Link scan scans all
frequencies in the scan ranges.

[MENU] > SET > Scan > Program Link
1.	 Push [MENU].
2.	 Select “Scan” in the “SET” menu.
3.	 Select “Program Link.”

Example settings of the Program Link
Program Scan Program Scan
upper edge
lower edge
Program Link

01：144.000−440.000

0：
Edit Name

Delete

1：

...

4.	 Select a Program Link number “0” ~ “9.”

Blank

9：

Program Scan range (p. 10-7)
Program Link number (0 to 9)

LLInformation

•• The Program Link Number screen displays the frequency
range.
•• You can add a Link setting by pushing [QUICK] when 2 or
more Program Scan ranges (P-Scan Edge) are entered.
•• When there is no Program Scan range (P00 ~ P24)
entered, “Add” is not displayed after pushing [QUICK].

•• The Program Link Number screen displays the
preregistered Program Scan ranges.
LLWhen no Program Scan range is selected, “– Blank –”
is displayed.

5.	 Push [QUICK].
6.	 Select “Add.”

7.	 Select the Program Scan range that you want to add.

8.	 Repeat steps 6 and 7 until all Program scan ranges that
you want are added.
9.	 Push [ENT] to save the Program Link.
LLTo exit the MENU screen, push [MENU].

TIP:

•• To edit the name of the Program Link, push [QUICK]
and select “Edit Name” at above step 4.
•• To delete the registered Program Scan range from the
Program Link, select “Delete” at above step 6.
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Memory Scan
DScan
D
Type

NOTE: You must enter 2 or more Memory channels
that are not set as Skip channels to start a Memory
scan.

•• ALL:
Full scan
•• BAND:
Band scan
•• MODE:
MODE scan
•• DUP:	Duplex scan
(Displayed only when Duplex is set)
•• GROUP LINK:
Group Link scan
•• GROUP 00 ~ 99: Group scan
•• TONE:	Tone scan
(For the Tone Squelch scanning)
LLWhen 2 or more Memory channels that are not set as
Skip channels are entered, the Memory scan is usable.
LLThe channel set as a Skip channel (PSKIP or SKIP) is
skipped during a scan. (p. 10-11)

1.	 Push [MR] to enter the Memory mode.

LLFor only the ID-52A, pushing [MR] each time selects
the Memory and Weather Channel modes.

2.	 Hold down [SCAN] for 1 second.

•• Opens the Scan Type Select window.

3.	 Select a scan type.

TIP:

•• During a scan, rotate [DIAL] to change the scanning
direction.
•• During a scan, hold down [
] to turn the Lock
function ON or OFF.
•• The scan continuously runs, even if you push [MENU]
or [QUICK] during a scan.
•• You can select a scan type by rotating [DIAL] while
holding down [SCAN]. Release [SCAN] to start the
scan.

Blinks

•• The scan starts.
•• The decimal point and “
” blink.
LLWhen receiving a signal, the S-meter displays the
received signal strength.

4.	 Hold down [SCAN] for 1 second.

•• Cancels the scan.
LLPushing [CLR] also cancels the scan.
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Memory Scan

DAbout
D
a Group scan name

DSetting
D
the Group Link

When a group name is entered to a Memory channel
group, the name is displayed in the Scan Type Select
window. (p. 10-9)

You can sequentially scan the memory groups which
are set to link on the MENU screen.
LLIn the default setting, all groups are set to link.

LLThe name is not displayed during a scan.
LLTo enter the name, see page 9-11.

[MENU] > SET > Scan > Group Link
1.	 Push [MENU].
2.	 Select “Scan” in the “SET” menu.
3.	 Select “Group Link.”

When the Group name is entered

When the Group name is not entered

4.	 Select a group, “00” ~ “99,” “S: SKIP CH.”

5.	 Push [ENT] to turn the Link function ON or OFF.
•• “ ” is displayed when the function is set to “ON.”
LLPush [QUICK] to quickly turn all the groups ON or
OFF.

LLTo exit the MENU screen, push [MENU].
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Memory Scan

Temporary skip function

DSetting
D
the skip channel

This function temporarily skips unwanted frequencies
(or memory channels) during a scan for the set
period of time or condition, without changing the Skip
Channel setting.

You can set or clear a Skip Channel setting.
The channels that are set as a Skip channel are
skipped during a scan.

1.	 While a scan is paused, hold down [MW] for 1
second.
2.	 Select “Temp Skip Set.”

1.	 Push [MR] to enter the Memory mode.
2.	
3.	
4.	
5.	

LLFor only the ID-52A, pushing [MR] each time selects
the Memory and Weather Channel modes.

Select the memory channel to be skipped.
Push [QUICK].
Select “SKIP.”
Select an option.

•• Sets the frequency or Memory channel as a Skip
Frequency or Channel.
•• The scan automatically resumes.

TIP:

When a Skip channel is set,
“SKIP” or “PSKIP” is displayed.
•• OFF:
Cancels the Skip Channel setting.
•• SKIP:
Skipped during a Memory scan.
•• PSKIP:	Skipped during both VFO and Memory
scans.
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•• Up to 20 Temporary Skip frequencies or Memory
channels can be set. When the 21st frequency
or Memory channel is set, the oldest setting is
automatically deleted.
•• You can also set the Temporary Skip function in the
Quick Menu window.
•• The Temporary Skip function is canceled when the
Temporary Skip Timer (Default: 5 min) has passed, or
when selecting “Temp Skip Cancel” in the Quick Menu
window.
([MENU] > SET > Scan > Temporary Skip Timer)
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11 REPEATER AND DUPLEX OPERATIONS
FM Repeater operation
A Repeater receives signals and on one frequency,
and then retransmits them on a different frequency.
When using a Repeater, the transmit frequency is
shifted from the receive frequency by a frequency
offset.
A Repeater can be accessed using the Duplex
function by setting the transceiver’s offset to the same
value as the Repeater’s offset.
See Section 5 for details on accessing a D-STAR
Repeater.

Repeater
RX: 144900 MHz
TX: 145500 MHz

Station A

Station B

RX: 145500 MHz
TX: 144900 MHz

DSetting
D
the Repeater frequency

RX: 145500 MHz
TX: 144900 MHz

1.	 Push [VFO/MHz] to enter the VFO mode.
2.	 Push [MODE] to select the FM mode.

7.	 Push [QUICK].
8.	 Select “TONE” and turn ON the Repeater Tone.

3.	 Rotate [DIAL] to set the frequency received from a
repeater.

9.	 Hold down [PTT] for 2 seconds.

•• The TONE icon is displayed.

•• If your transmit signal reached the repeater, after
releasing [PTT], you can hear the repeater’s call sign
in morse codes or its announcement.
Accessing
a Repeater

Receiving from
a Repeater

▲

TIP: For only the USA version
The Auto Repeater function (p. 11-5)
automatically sets the repeater settings (duplex
ON/OFF, duplex direction, tone encoder ON/
OFF). When the function is ON, steps 4 ~ 8 are
not necessary.

Push [PTT] for
2 seconds

Receives the
Repeater’s call sign

10.	Operate in the same way as a simplex call,
alternately transmit and receive.

LLYou can turn OFF the function and manually set the
repeater settings.
([MENU] > SET > Function > Auto Repeater)

Receive frequency

Transmit frequency
Shifts by the
offset amount

4.	 Set the offset frequency and the Duplex direction.
(p. 11-4)

TIP:

•• When the repeater tone frequency or the frequency
offset is changed, the tone or offset for Auto Repeater
function is also changed.
•• If the offset value causes the transmit frequency to be
out of the band, “OFF BAND” is displayed on the display
when you push [PTT], and transmit is inhibited. (p. 11-5)

•• The Duplex icon is displayed.

5.	 Set the Repeater tone. (Default: 88.5 Hz)
([MENU] > SET > DUP/TONE... > Repeater Tone)
(p. 12-4)
6.	 Push [MENU] to exit the MENU screen.
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FM Repeater operation

DChecking
D
the Repeater input signal

D1750
D
Hz tone burst

You can check whether or not that another station’s
transmit signal can be received directly (not through a
repeater), by listening to the repeater input frequency.

A 1750 Hz tone is required to access many European
repeaters.
For the ID-52E only
Push [PTT] briefly and release, and then hold down
[PTT] to transmit a 1750 Hz tone burst signal.

Hold down [SQL] to listen on the repeater input
frequency.

1.	 Push [MENU].
2.	 Select “DTMF/T-CALL” in the “SET” menu.

Display while monitoring

3.	 Select “DTMF Memory.”

LLInformation

•• While monitoring, the status indicator lights green, and an
S/RF meter dot blinks.
•• While monitoring, the displayed frequency automatically
changes to the transceiver transmit frequency (repeater
input frequency).
•• When the other station’s signal can be directly received,
move to a non-repeater frequency, and use simplex.
(Duplex OFF)

4.	 Select “T-CALL.”

5.	 Push [MENU] to exit the MENU screen.
6.	 Rotate [DIAL] to set the frequency received from a
repeater.
7.	 Set the offset frequency and the duplex direction.
(p. 11-4)
•• The duplex icon is displayed.

8.	 While holding down [PTT] to transmit, push [SQL]
to transmit a 1750 Hz tone signal.
•• Accesses the repeater with a short tone burst.

9.	 Operate in a normal way.

LLIn the same way as a simplex call, alternately
transmit and receive.
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Duplex operation
DSetting
D
the duplex direction

The duplex operation shifts the transmit frequency
up or down from the receive frequency by an offset
amount.

1.	 Push [QUICK].
2.	 Select “DUP.”

DSetting
D
the frequency offset
NOTE: The frequency offset cannot be changed
when using the DR function.
[MENU] > SET > DUP/TONE... > Offset Freq
1.	 Push [MENU].
2.	 Select “DUP/TONE...” in the “SET” menu.

3.	 Select the duplex direction.

•• OFF:	For simplex operation (the receive and
transmit frequencies are the same).
•• DUP–:	The transmit frequency shifts down from the
receive frequency by the offset amount.
•• DUP+:	The transmit frequency shifts up from the
receive frequency by the offset amount.

		
3.	 Select “Offset Freq.”

4.	 Rotate [DIAL] to set the offset.

•• Displays “D–” or “D+.”

DDuplex
D
operation

LLInformation
•• Set to between 0.000.00 and 59.99500 MHz.
•• The selected tuning step in the VFO mode is used to
set the offset.
•• To exit the MENU screen, push [MENU].

1.	 Hold down [SQL] to listen to the transmit
frequency to check whether another station is
transmitting on it, or not.
•• The shifted transmit frequency is displayed.

2.	 Operate in a normal way.

LLIn the same way as a simplex call, alternately
transmit and receive.

TIP: If the offset value causes the transmit frequency
to be out of the band, “OFF BAND” is displayed
when you push [PTT], and transmit will be inhibited.
(p. 11-5)

NOTE: When the Auto Repeater function is ON, and
the operating frequency is set out of the repeater
output frequency range, the Duplex mode is
automatically canceled.
([MENU] > SET > Function > Auto Repeater)
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Auto Repeater function

Off band indication

When the operating frequency falls within the
Repeater output frequency range, the Auto Repeater
function automatically sets the Repeater settings
(Duplex ON/OFF, Duplex direction, Tone encoder ON/
OFF). The Auto Repeater function uses the preset
repeater tone frequency and frequency offset.

If the transmit frequency is out of the amateur band,
the off band indication, “OFF BAND,” is displayed
when you push [PTT]. Check the frequency offset or
duplex direction in this case. (p. 11-4)

NOTE for the USA version transceiver:
When turned ON, the Auto Repeater function
has priority over the manual duplex setting. If the
transmit frequency changes after setting, the Auto
Repeater function may have changed the duplex
setting.
[MENU] > SET > Function > Auto Repeater
1.	 Push [MENU].
2.	 Select “Function” in the “SET” menu.

3.	 Select “Auto Repeater.”

4.	 Select the option to turn ON the Auto Repeater
function.

•• OFF:
Turns OFF the function.
•• ON (DUP):	Turns ON only the duplex
operation. (Default)
•• ON (DUP, TONE):	Turns ON the duplex operation
and Tone encoder.
LLTo exit the MENU screen, push [MENU].

Frequency range and offset direction
Frequency range

Shift direction

145.200 ~ 145.495 MHz

“DUP–” is set

146.610 ~ 146.995 MHz

“DUP–” is set

147.000 ~ 147.395 MHz

“DUP+” is set

442.000 ~ 444.995 MHz

“DUP+” is set

447.000 ~ 449.995 MHz

“DUP–” is set
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Selecting an item
You can open the MENU screen by pushing [MENU].
You can use the MENU screen to set infrequently
changed values or function settings.
In addition to this page, see pages 12-4 through 12-36
for details of each item’s options and default values.

TIP: The MENU screen is constructed in a tree
structure. You may go to the next tree level, or go
back a level, depending on the selected item.

DMENU
D
screen operation
Switches between the
MENU screen and
the standby screen.

Selects an item or option.
Goes to the
previous tree
level.
Goes to the
next tree level.
Returns to the
default setting.

Goes to the previous
tree level.
[ENT]
Sets an option.
Selects an item or option.

Simplified description—‘Select’ operation
In this manual, the user’s ‘Select’ operation is
simplified, as described below.
Simplified description:
1.	 Push [MENU].
2.	 Select “30min.”
Operation:
1.	 Push [MENU] to open the MENU screen.
2.	 Push D-pad() to select “30min,” and then push
[ENT].
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Selecting an item

DSelecting
D
an item

Example: Set “Auto Power OFF” to “30 min.”

TIP: To return to the default setting
1.	 Push [QUICK] in step 5.
2.	 Select “Default.”

[MENU] > SET > Time Set > Auto Power OFF
1.	 Push [MENU].
2.	 Select “SET.”
3.	 Select “Time Set.”

•• The setting returns to the default.

4.	 Select “Auto Power OFF.”

5.	 Select “30min.”

•• Sets the option, then goes back to a tree level.
(The TIME SET screen is displayed.)
LLTo exit the MENU screen, push [MENU].
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NOTE: The default settings shown below are for the USA transceiver version. The default settings may differ,
depending on your transceiver version.

DUP/TONE...
Offset Freq

DTCS Code

(Default: 0.600.00*)

[MENU] > SET > DUP/TONE... > Offset Freq

[MENU] > SET > DUP/TONE... > DTCS Code

Sets the frequency offset for Duplex (repeater)
operation to between 0.000.00 and 59.995.00 MHz.

Selects a DTCS (both encoder/decoder) code for the
DTCS Squelch.
You can select a total of 104 codes (023 ~ 754).

LLPush [VFO/MHz] to select the 1 MHz tuning step.
LLThe Duplex shift direction (DUP–/DUP+) (p. 11-4) or the
tuning step is set in the Quick Menu window.
LLWhen the DR function is ON, editing is disabled.

•• Selectable DTCS codes
023
025
026
031
032
036
043
047
051
053
054
065
071

* The default value may differ, depending on the frequency
band (selected as the MAIN band before entering the
MENU screen) and the transceiver version.

Repeater Tone

(Default: 88.5)

[MENU] > SET > DUP/TONE... > Repeater Tone
Selects a repeater tone frequency for repeater access
and other functions.
You can select 50 tone frequencies (67.0 ~ 254.1 Hz).
TSQL Freq

(Default: 88.5)

Tone Burst

151.4
156.7
159.8
162.2
165.5
167.9
171.3
173.8

177.3
179.9
183.5
186.2
189.9
192.8
196.6
199.5

203.5
206.5
210.7
218.1
225.7
229.1
233.6
241.8

244
245
246
251
252
255
261
263
265
266
271
274
306

311
315
325
331
332
343
346
351
356
364
365
371
411

412
413
423
431
432
445
446
452
454
455
462
464
465

466
503
506
516
523
526
532
546
565
606
612
624
627

631
632
654
662
664
703
712
723
731
732
734
743
754

(Default: Both N)

Selects the DTCS polarity to use for transmitting (TX)
and receiving (RX).
•• Both N: Normal polarity is used for both TX and RX.
•• TN-RR:	Normal polarity is used for TX, Reverse
polarity for RX.
•• TR-RN:	Reverse polarity is used for TX, Normal
polarity for RX.
•• Both R:	Reverse polarity is used for both TX and
RX.

•• Selectable Repeater Tone/TSQL frequencies
(Unit: Hz)
114.8
118.8
123.0
127.3
131.8
136.5
141.3
146.2

152
155
156
162
165
172
174
205
212
223
225
226
243

[MENU] > SET > DUP/TONE... > DTCS Polarity

Selects a CTCSS tone frequency for the Tone Squelch
function.
You can select 50 tone frequencies (67.0 ~ 254.1 Hz).

88.5
91.5
94.8
97.4
100.0
103.5
107.2
110.9

072
073
074
114
115
116
122
125
131
132
134
143
145

DTCS Polarity

[MENU] > SET > DUP/TONE... > TSQL Freq

67.0
69.3
71.9
74.4
77.0
79.7
82.5
85.4

(Default: 023)

250.3
254.1

Digital Code

(Default: 00)

[MENU] > SET > DUP/TONE... > Digital Code
Selects the digital code for Digital Code Squelch.
You can select a total of 100 codes (00 ~ 99).

(Default: OFF)

[MENU] > SET > DUP/TONE... > Tone Burst
Turns the Tone Burst function ON or OFF in the FM
mode when using the Tone Squelch function.
•• OFF:	When you transmit a signal that superimposes
the CTCSS tone, the other station may hear
a short burst of noise from their receiver, just
after you stop transmitting.
When you transmit a signal that superimposes
•• ON:	
the CTCSS tone, the function mutes the noise
from being heard in the other station’s receiver.
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Scan
Pause Timer

Program Skip

(Default: 10sec)

[MENU] > SET > Scan > Pause Timer

[MENU] > SET > Scan > Program Skip

Selects the Scan Pause Timer. When receiving a
signal, the scan pauses for this set period of time.

Turns the Program Skip Scan function ON or OFF for
a VFO scan. This function enables the transceiver to
skip the unwanted frequencies that are entered as a
Memory channel and are set to “PSKIP.”

LLIndividually selectable for A band and B band.

•• 2sec ~ 20sec:	When a signal is received, the scan
pauses for 2 ~ 20 seconds (in 2
second steps).
•• HOLD:	The scan pauses on a received
signal until the signal disappears.

Resume Timer

LLIndividually selectable for A band and B band.

•• OFF:	The transceiver scans all frequencies.
•• ON:	The transceiver does not scan frequencies set
as “PSKIP” frequencies.

Group Link

(Default: 2sec)

(Default: ✔ 00 ~ ✔ 99/ ✔ S: SKIP CH)

[MENU] > SET > Scan > Group Link

[MENU] > SET > Scan > Resume Timer

Selects groups to be scanned during a Group Link
Scan. The Group Link function scans all channels in
the selected groups.
Select a group, A ~ Z, and then push [ENT] to turn the
Link function ON or OFF.

Selects the scan Resume Timer. When a received
signal disappears, the scan resumes for this set
period of time.

LLIndividually selectable for A band and B band.

•• 0sec:	The scan resumes immediately after
the signal disappears.
•• 1sec ~ 5sec:	The scan resumes 1 ~ 5 seconds after
the signal disappears.
•• HOLD:	The scan remains paused for the
“Pause Timer” setting, even if the
signal disappears.

LLDisplays “✔” when the function is set to ON.
LLIndividually selectable for A band and B band.

P-Scan Edge
[MENU] > SET > Scan > P-Scan Edge
You can delete, copy, or edit the upper and lower
frequencies for programmed scans.
The transceiver has a total of up to 25 frequency
ranges (00 ~ 24), and you can set the scan name,
tuning step, and operating mode for each scan edge.

NOTE: Rotate [DIAL] to resume the scan.

Temporary Skip Timer

(Default: ON)

(Default: 5min)

LLThe default setting may differ, depending on the
transceiver version.

[MENU] > SET > Scan > Temporary Skip Timer
Selects the effective time of the Temporary Skip
function.

LLIndividually selectable for A band and B band.
LLThis timer is activated for the VFO scan, Memory scan,
and DR scan.

•• 5min/10min/15min:	The Temporary Skip channels
are skipped for the set period
of time.
•• While Scanning:	The Temporary Skip channels
are skipped until the Scan is
stopped.
•• While Powered ON:	The Temporary Skip channels
are skipped until the
transceiver is turned OFF.
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Scan
Program Link
[MENU] > SET > Scan > Program Link
Sets the link function for two or more Program Scan
Edge ranges to be sequentially scanned during
a Program Link Scan. The link function scans all
frequencies in the scan range.
Default settings of the Program Link:
Program Link

01：144.000−148.000

0：
Edit Name

Delete
02：430.000−450.000

1：

...

Blank

9：

Program Link number (0 to 9)

Delete

Program Scan Edge range

LLThe default setting may differ, depending on the
transceiver version.
LLWhen only one Program Scan Edge range is entered, or
there is no Programmed Scan Edge is left, “Add” is not
displayed after pushing [QUICK].

DUP Check During MR Scan

(Default: OFF)

[MENU] > SET > Scan > DUP Check During MR Scan
During a Memory scan, selects whether or not to scan
the offset frequency if Duplex is set on the channel.
•• OFF: The offset frequency is not scanned.
•• ON: The offset frequency is also scanned.
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Scope
Scope Mode

FIX Mode Center Frequency

(Default: Center)

[MENU] > SET > Scope > FIX Mode Center Frequency

[MENU] > SET > Scope > Scope Mode

Sets the center frequency of the FIX mode Band
Scope for each band.

Selects the Band Scope display mode.
•• Center:	Displays signals around the
operating frequency within the
selected span.
The operating frequency is always
displayed in the center of the screen.
•• FIX:	Displays signals within a specified
frequency range.
•• Scroll (FIX):	Displays signals within a specified
frequency range. When the operating
frequency moves outside of the
screen, the displayed frequency
range is automatically shifted.
Displayed Steps

LLThe selected tuning step in the VFO mode is used to set
the center frequency. To select the tuning step, open the
Quick Menu window on the Standby screen.
LLTo return to the default setting, push [QUICK], and
then select “Default” on the “Center Freq. (FIX)” or
“FREQUENCY” screen.
LLThe default setting may differ, depending on the
transceiver version.

AF Output (DUAL/AIR Band)

[MENU] > SET > Scope > AF Output (DUAL/AIR Band)
Selects whether or not to momentarily output the
received audio during a sweep by the Band Scope
function, when using the Dualwatch function or
selecting the AIR band.
•• OFF: No audio is output during the sweep.
•• ON:	The received audio is momentarily output
during the sweep.

(Default: ±15 Steps)

[MENU] > SET > Scope > Displayed Steps
Selects the number of displayed steps around the
center frequency in the Band scope.

LLThe tuning step depends on the TS setting.

•• ±15 Steps:

•• ±20 Steps:

Waterfall Function

(Default: ON)

[MENU] > SET > Scope > Waterfall Function
Selects whether or not to use the waterfall display in
the single display when the Band Scope function is
ON.
•• OFF: Turns OFF the Waterfall display.
•• ON: Turns ON the Waterfall display.
Waterfall Speed

(Default: OFF)

(Default: Fast)

[MENU] > SET > Scope > Waterfall Speed
Selects the waterfall speed.
•• Slow: Sets the Waterfall speed to Slow.
•• Fast: Sets the Waterfall speed to Fast.
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Call Sign
Call Sign
Step 2. Gateway “R2” setting
1.	 Select “R2.”

[MENU] > SET > Call Sign
Set or view the “UR,” “R1,” “R2,” and “MY” call signs
to use in the DV mode.
When not using the DR function, sets the call signs on
this screen.

LLTo manually enter a call sign, push [QUICK], then
select “Edit.”

2.	 Select “GW.”

About the RPT2 SELECT screen

For Simplex operation (DV mode)
You can set the “UR” and “MY” call signs.
For Duplex (repeater) operation
(DV mode/DR function)
You can set only the “MY” call sign when the DR
function is ON.

NOT USED*

For local area calls

GW

To select the gateway call sign from the
repeater list.

Repeater name

To select the repeater that has the
same gateway as the “R1” repeater.

Step 3. Destination “UR” setting
1.	 Select “UR.”

<To manually set the Duplex (repeater) operation>

LLTo manually enter a call sign, push [QUICK], then
select “Edit.”

Example: M
 aking a gateway CQ call to Kirkland
repeater (N71H B) from the Hirano repeater
(JP3YHH A), in the DV mode.

2.	 Select “Gateway CQ.”
3.	 Select a repeater group where your destination
repeater is listed.
4.	 Select a destination repeater.

LLBefore starting to set the call sign, set the frequency of
your Access repeater and duplex direction on the standby
screen.

About the YOUR SELECT screen

TIP: When the Digital Repeater Set function is ON,
the repeater call sign is automatically set.
([MENU] > SET > DV Set > Digital Repeater Set)
Step 1. Setting the call sign “R1”
1.	 Select “R1.”
LLDO NOT push [ENT].

2.	 Push [QUICK].
3.	 Select “Edit.”
4.	 Rotate [DIAL] to enter the first character.

LLSelectable characters are alphanumeric characters
and symbol (“/”).

CQCQCQ

To select “CQCQCQ” to make a noncall sign specific call.

Gateway CQ*

To select “Gateway CQ” to make a call
using the repeater list.

Your Call Sign

To select the destination “UR” call sign
using the Your Call Sign memory.

RX History

To select the destination “UR” call sign
using RX History.

TX History

To select the destination “UR” call sign
using TX History.

* Not displayed in the Simplex mode.

5.	 Push D-pad () to move the cursor.
6.	 Repeat steps 4 and 5 to enter the repeater call
sign of up to 8 characters, including a space.
(Example: JP3YHH A)
7.	 After entering, push [ENT].
•• Saves the entered repeater call sign.
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My Station
My Call Sign

TX Message

[MENU] > SET > My Station > My Call Sign

[MENU] > SET > My Station > TX Message

The transceiver has a total of 6 memories to save
your own call signs for use in the DV mode. You can
enter a call sign of up to 8 digits.
Also, you can enter a note of up to 4 characters, for
operating transceiver type, area, and so on.

The transceiver has a total of 5 memories to save
short messages for transmission with your voice
signal in the DV mode.
Enter a message of up to 20 alphanumeric characters
for each memory.

LLSee D-STAR GUIDE in the Basic manual for MY Call Sign
entry.
LLTo select another My Call Sign, push D-pad() to select
a call sign, and then push [ENT] on the MY CALL SIGN
screen.

LLSee page 5-17 for TX message entry.
LLTo select other TX message, push D-pad() to select
a memory, and then push [ENT] on the TX MESSAGE
screen.

TIP: To transmit no message, select “OFF.”
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DV Set
RX Bass

Auto Reply

(Default: Normal)

[MENU] > SET > DV Set > Tone Control > RX Bass

[MENU] > SET > DV Set > Auto Reply

Selects the receive audio bass filter level.
•• Cut:
Reduces low frequencies.
•• Normal: Normal tone balance.
•• Boost: Increases low frequencies.
RX Treble

Selects an option for the Automatic Reply function in
the DV mode. This function automatically replies to a
call addressed to your own call sign (MY), even if you
are away from the transceiver.
•• OFF:
Turns OFF the function.
•• ON:	Replies with your own call sign (MY).
(No audio reply is sent)
•• Voice:	Replies with your call sign (MY) and any
Auto Reply message recorded on the
microSD (up to 10 seconds).

(Default: Normal)

[MENU] > SET > DV Set > Tone Control > RX Treble
Selects the receive audio treble filter level.
•• Cut:
Reduces high frequencies.
•• Normal: Normal tone balance.
•• Boost: Increases high frequencies.
RX Bass Boost

LLThe transmitted audio can be monitored.
LLIf no microSD card is inserted, or no
message is recorded, only your call sign is
transmitted.

•• Position:	Replies with your own call sign and
transmits your position data using the
internal GPS receiver.

(Default: OFF)

[MENU] > SET > DV Set > Tone Control >
RX Bass Boost

LLWhen “GPS Select” is set to “OFF” or
“Manual,” the internal GPS receiver is
temporarily turned ON.
LLWhen “ON” or “Voice” is selected, the Automatic Reply
function is automatically turned OFF when you push
[PTT]. When “Position” is selected, the Automatic Reply
function is not turned OFF, even if you push [PTT].

Turns the Receive Audio Bass Boost function ON or
OFF.
LLThis function is different from the “Boost” setting of “RX
Bass.”

•• OFF: Turns OFF the function.
•• ON: This function boosts the receive audio bass.

TX Bass

DV Data TX

(Default: Normal)

(Default: Auto)

[MENU] > SET > DV Set > DV Data TX

[MENU] > SET > DV Set > Tone Control > TX Bass

Selects whether to manually or automatically transmit
data in the DV mode.
•• PTT:	Push [PTT] to manually transmit data.
•• Auto:	When data is input from a PC through the
[USB] port, the transceiver automatically
transmits it.

Selects the transmit audio bass filter level.
•• Cut:
Reduces low frequencies.
•• Normal: Normal tone balance.
•• Boost: Increases low frequencies.
TX Treble

(Default: OFF)

(Default: Normal)

Fast Data

[MENU] > SET > DV Set > Tone Control > TX Treble
Selects the transmit audio treble filter level.
•• Cut:
Reduces high frequencies.
•• Normal: Normal tone balance.
•• Boost: Increases high frequencies.

(Default: OFF)

[MENU] > SET > DV Set > DV Fast Data > Fast Data
Selects whether or not to use the DV Fast Data
function for data communication in the DV mode.
The DV Fast Data function uses the data and the
audio frames to send data approximately 3.5 times
faster than the normal speed. So, no audio can be
sent.
•• OFF:	Sends data at a slow speed
(approximately 950 bps).
•• ON:	Sends data at a fast speed
(approximately 3480 bps).

LLEven if “ON” is selected, when you push [PTT], the data
is sent at the slow speed, because the audio frame is
used for the audio transmission.
LLThe GPS data speed is set in “GPS Data Speed.”
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DV Set
GPS Data Speed

DV Auto Detect

(Default: Slow)

[MENU] > SET > DV Set > DV Auto Detect

[MENU] > SET > DV Set > DV Fast Data >
GPS Data Speed

Turns the DV mode Automatic Detect function ON
or OFF. When in the DV mode, if you receive a nondigital signal, this function automatically sets the
operating mode to the FM mode.
•• OFF:	Turns the function OFF. The operating mode
is fixed to the DV mode.
•• ON:	Automatically selects the FM mode for
temporary operation.

Sets the GPS data speed when the data is sent using
the DV Fast Data function.
•• Slow:	Sends GPS data at slow speed
(approximately 950 bps).
•• Fast:	Sends GPS data at fast speed
(approximately 3480 bps).
TX Delay (PTT)

(Default: 2sec)

RX Record (RPT)

[MENU] > SET > DV Set > DV Fast Data >
TX Delay (PTT)

The transceiver can record the data of up to 50
individual calls. When the received signal includes a
status message (“UR?” or “RPT?”) that is sent back
from the access repeater, you can record up to 50
messages, or only the last call, in the Received Call
Record.
•• ALL:
Records up to 50 calls.
•• Latest Only: Records only the last call.
[RX>CS] Key

(Default: Call Sign Capture)

[MENU] > SET > DV Set > [RX>CS] Key

NOTE: This function is usable only when “DV Data
TX” is set to “PTT.”

Selects the [RX→CS] Call Sign Capture key operation
when you hold down.
•• Call Sign Capture:	While holding down, the RX
History is displayed. After
releasing, the last received call
station’s call sign is set to “TO”
(destination).
•• RX>CS List:	When you hold down for 1
second, the RX History is
displayed. Rotate [DIAL] to
select a call sign to set to “TO”
(destination), and then push
[ENT].

(Default: Auto)

[MENU] > SET > DV Set > Digital Monitor
Selects a receive mode when pushing [SQL] in the DV
mode.
•• Auto:	Receives in the DV mode or the FM mode,
depending on the received signal.
•• Digital: Receives in the DV mode.
•• Analog: Receives in the FM mode.
Digital Repeater Set

(Default: ALL)

[MENU] > SET > DV Set > RX Record (RPT)

Sets the time for when the transceiver returns to
receive after sending DV data in the DV Fast Data
mode using [PTT].
•• OFF:	After releasing [PTT], the transceiver
returns to receive.
•• 1 ~ 10sec:	After releasing [PTT], the transceiver
sends data using the DV Fast Data
mode for this set period.
When the TX data is completely sent
within this set period, the transceiver
automatically returns to receive.

Digital Monitor

(Default: OFF)

(Default: ON)

BK

[MENU] > SET > DV Set > Digital Repeater Set

(Default: OFF)

[MENU] > SET > DV Set > BK

Turns the Digital Repeater Set function ON or OFF.
When accessing a repeater that has a call sign that
is different from the transceiver’s setting, this function
reads the repeater’s transmit signal and automatically
sets the repeater call sign.
•• OFF: Turns OFF the function.
•• ON: Automatically sets the repeater call sign.

The Break-in (BK) function enables you to break
into a conversation, where the two other stations are
communicating with call sign squelch enabled.
•• OFF:	Turns OFF the function.
•• ON:	Turns ON the function.
LLThe BK function is automatically turned OFF when the
transceiver is turned OFF.
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DV Set
EMR

(Default: OFF)

[MENU] > SET > DV Set > EMR
The Enhanced Monitor Request (EMR) function
enables all transceivers that receive an EMR signal
in the DV mode automatically to open their squelch to
receive the signal.
•• OFF:	Turns OFF the function.
•• ON:	Turns ON the function.
LLThe EMR function is automatically turned OFF when the
transceiver is turned OFF.

EMR AF Level

(Default: 19)

[MENU] > SET > DV Set > EMR AF Level
Sets the audio output level when an EMR
communication mode signal is received. When an
EMR signal is received, the audio will be heard at the
programmed level, or the transceiver’s audio level,
whichever is higher.
To disable the setting, set to “0.”
NOTE: After an EMR signal disappears, the audio
level will remain at the EMR level. In this case, rotate
[VOL] to adjust the audio level.

12-12

12 SET MODE
SPEECH
RX Call Sign SPEECH

DIAL SPEECH

(Default: ON (Kerchunk))

[MENU] > SET > SPEECH > RX Call Sign SPEECH

[MENU] > SET > SPEECH > DIAL SPEECH

Turns the RX Call Sign Speech function ON or OFF
for calls received in the DV mode.

Turns the Dial Speech function ON or OFF.
The Dial Speech function announces the frequency or
repeater call sign that is selected by rotating [DIAL].

LLInformation

LLWhen using the DR function, the frequency is announced
if the Simplex mode is selected or the FM repeater does
not have a call sign.
LLWhen you receive a signal during an announcement, the
transceiver cancels the announcement, and you can hear
the received audio.

•• When the Digital Squelch function is used, the calling
station’s call sign is not announced if the received signal
is not addressed to your call sign, or does not include a
matching digital code.
•• When you receive a signal from a repeater (“UR?” or
“RPT?”), the caller station’s call sign is not announced.
•• While scanning, the transceiver resumes the scan during
an announcement.
•• Even if a note is entered after the call sign, it is not
announced.
•• When you receive a signal during an announcement, the
transceiver cancels the announcement, and you can hear
the received audio.

•• OFF:	The frequency or repeater call sign is not
announced.
•• ON:	The frequency or repeater call sign is
announced, 1 second after rotating [DIAL].
In the VFO, Memory, or Call Channel mode,
the frequency is announced.
When using the DR function, the repeater call
sign is announced.

•• OFF:	The caller station’s call sign is not
announced, even when a call is
received.
•• ON (Kerchunk):	The caller station’s call sign is
announced only when they make a
quick transmission.
•• ON (All):	The caller station’s call sign is
always announced.
RX>CS SPEECH

(Default: OFF)

MODE SPEECH

(Default: OFF)

[MENU] > SET > SPEECH > MODE SPEECH
Turns the operating mode announcement ON or OFF.

LLDuring a VFO scan, the operating mode is announced
when you change the mode.

•• OFF:	The selected operating mode is not
announced.
•• ON:	The selected operating mode is announced.

(Default: ON)

[MENU] > SET > SPEECH > RX>CS SPEECH
Turns the RX>CS Speech function ON or OFF.
The RX>CS Speech function announces the station
call sign that is selected from a Received Call Record
by pushing [RX→CS].

SPEECH Language

(Default: English)

[MENU] > SET > SPEECH > SPEECH Language
Sets the speech language to English or Japanese.

LLIf a call is received during an announcement, the received
audio is muted, and the audio is not recorded onto the
microSD card.

Alphabet

(Default: Normal)

[MENU] > SET > SPEECH > Alphabet

•• OFF:	The station call sign is not announced.
•• ON:	The station call sign is announced.

Selects the type of phonetic announcement.
• Normal:	Normal code is used.
(Example: A as eh, B as bee)
• Phonetic Code:	The Phonetic code is used.
(Example: A as Alfa, B as Bravo)
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DTMF/T-CALL

SPEECH
SPEECH Speed

(Default: Fast)

You can set the DTMF tone code and DTMF Memory
channel for DTMF tone operation.
See page 15-5 for details.

[MENU] > SET > SPEECH > SPEECH Speed
Sets the speech speed to Fast or Slow.
SPEECH Level

DTMF Memory

(Default: d0)

[MENU] > SET > DTMF/T-CALL > DTMF Memory

(Default: 7)

Displays a list of the DTMF Memory channels.
•• T-CALL: 1750 Hz tone burst signal
•• d0 ~ d#: DTMF memory channel list

[MENU] > SET > SPEECH > SPEECH Level
Sets the Voice Synthesizer audio output level to
between 0 (OFF), 1 (minimum) and 9 (maximum).

LLThe voice synthesizer audio output level is linked with the
[VOL] setting from the minimum audio volume up to this
set level.

DTMF Speed

(Default: 100ms)

[MENU] > SET > DTMF/T-CALL > DTMF Speed
Selects the DTMF transmit speed.
•• 100ms: Transmits the DTMF codes at about 100
milliseconds per code
(5 characters per second).
•• 200ms: Transmits the DTMF codes at about 200
milliseconds per code
(2.5 characters per second).
•• 300ms: Transmits the DTMF codes at about 300
milliseconds per code
(1.6 characters per second).
•• 500ms: Transmits the DTMF codes at about 500
milliseconds per code
(1 character per second).
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QSO/RX Log
QSO Log

Separator/Decimal

(Default: ON)

[MENU] > SET > QSO/RX Log > QSO Log

[MENU] > SET > QSO/RX Log > CSV Format >
Separator/Decimal

Selects whether or not to make a communication log
on a microSD card. The communication log is made
on the card, and saved in the “csv” format.

Selects the separator and the decimal character for
the CSV format.

LLThis function requires a microSD card (User supplied).

LLThe default value may differ, depending on the
transceiver version.

•• Sep [,] Dec [.]: Separator is “,” and Decimal is “.”
•• Sep [;] Dec [.]: Separator is “;” and Decimal is “.”
•• Sep [;] Dec [,]: Separator is “;” and Decimal is “,”

•• OFF: The QSO Log function is OFF.
•• ON:	The transceiver makes a log on the microSD
card. The transceiver starts making a log
when you begin talking.

Date

TIP:

(Default: mm/dd/yyyy)

[MENU] > SET > QSO/RX Log > CSV Format >
Date

•• The folder name is automatically created, as
[ID-52\QsoLog].
•• The file name is automatically created, as shown in the
example below:
Log start date and time: 1st November 2021 15:30:00
File name:
20211101_153000.csv
•• The log contents are not displayed on the transceiver.
•• You can display the log contents on a PC.

RX History Log

(Default: Sep[,] Dec[.])

Selects the date format between “yyyy/mm/dd,”
“mm/dd/yyyy,” and “dd/mm/yyyy.”
(y: year, m: month, d: day)

LLThe default value may differ, depending on the
transceiver version.

(Default: OFF)

[MENU] > SET > QSO/RX Log > RX History Log
Selects whether or not to make a DV mode’s receive
history log on a microSD card. The receive history log
is made on a microSD card, and saved in the “csv”
format.
LLThis function requires a microSD card (User supplied).

•• OFF: The RX History Log function is OFF
•• ON:	The transceiver makes a DV mode’s receive
history log on the microSD card. The
transceiver starts making a receive history log
when you finish talking.
TIP:

•• The folder name is automatically created, as
[ID-52\RxLog].
•• The file name is automatically created, as shown in the
example below:
Log start date and time: 1st November 2021 15:30:00
File name:
20211101_153000.csv
•• The log contents are not displayed on the transceiver.
•• You can display the log contents on a PC.
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QSO/RX Log
The call log contents are shown below:
Contents

Example

Descriptions

TX/RX

TX

RX

Transmission and reception

Date

11/01/2021 13:51:48 11/01/2021 13:51:48 Date and time the call was started.

Frequency

438.010000

438.010000

Operating frequency

Mode

DV

DV

Operating mode (FM/FM-N/DV)

My Latitude

34.764667

34.764667

Your latitude (unit: degrees)
(+: North latitude, –: South latitude)

My Longitude

135.375333

135.375333

Your longitude (unit: degrees)
(+: East longitude, –: West longitude)

My Altitude

50.5

50.5

Your altitude (unit: meters)
Records to one decimal place.

RF Power

LOW

(Blank)

TX output power level

S meter

(Blank)

S0

The relative signal strength of the receive signal
(in 14 levels)

RPT Call Sign

JP3YHJ

JP3YHJ A

Repeater call sign (DV mode only)

TX Call Sign

CQCQCQ

(Blank)

TX Call sign (DV mode only)

RX Call Sign

(Blank)

JA3YUA A/52

RX Call sign/Note (DV mode only)

RX Latitude

(Blank)

34.764667

Caller’s latitude, if sent. (unit: degrees)
(+: North latitude, –: South latitude)
Records only when you receive in the DV mode.

RX Longitude

(Blank)

135.375333

Caller’s longitude, if sent. (unit: degrees)
(+: East longitude, –: West longitude)
Records only when you receive in the DV mode.

RX Altitude

(Blank)

30.5

Caller’s altitude, if sent. (unit: meters)
Records only when you receive in the DV mode.
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QSO/RX Log
The RX log contents are shown below:
Contents

Example

Descriptions

Frequency

438.010000

RX Frequency

Mode

DV

Operating mode (DV mode is fixed)

Caller

JA3YUA A

Call sign of the caller station (up to 8 characters)

/

ID52

Note after the call sign (up to 4 characters)

Called

CQCQCQ

Call sign of the called station

Rx RPT1

JP3YHH G

Access repeater call sign of the caller station, or the gateway repeater
call sign of your local area repeater.

Rx RPT2

JP3YHH A

Access repeater call sign of the called station

Message

Hello CQ D-STAR! Message included in the received call (up to 20 characters)

Status

(Blank)

Normal: blank, Uplink: “RPT UP”, Access repeater reply: “UR?” or “RPT?”

Received date

11/01/2021 13:51:48

Date and time the call was received
The format may differ, depending on the setting.

BK

*

BK call: “*”, Normal call: Blank

EMR

*

EMR call: “*”, Normal call: Blank

Latitude

34.764667

Caller’s latitude, if sent. (unit: degrees) (+: North latitude, –: South latitude)

Longitude

135.375333

Caller’s longitude, if sent. (unit: degrees) (+: East longitude, –: West longitude)

Altitude

30.5

Caller’s altitude, if sent. (unit: meters) Records to one decimal place.

SSID

-A

Caller’s SSID, if sent. (0, -1 to -15, -A to -Z)

D-PRS Symbol

Car

Icon: Converts to text, None: Code

Course

123

Caller’s course (unit: degrees)

Speed

23.5

Caller’s speed (unit: km/h) Records to one decimal place.

Power

49

TX power (unit: watts)

Height

24

Antenna height (unit: meters)

Gain

6

Antenna gain (unit: dB)

Directivity

Omni

Antenna directivity (Omni, 45, 90, 135, 180, 225, 270, 315, or 360)

Object/Item Name

HAM FES

Object name or Item name (up to 9 characters)

Data Type

Live Object

Data type of Object or Item (Live or Kill)

Temperature

20.5

Temperature (unit: °C) Records to two decimal places.

Rainfall

253.75

Rainfall (unit: mm) Records to two decimal places.

Rainfall (24 Hours)

253.75

Rainfall (24 Hours) (unit: mm) Records to two decimal places.

Rainfall (Midnight)

253.75

Rainfall (Midnight) (unit: mm) Records to two decimal places.

Wind Direction

315

Wind Direction (unit: degrees)

Wind Speed

10.0

Wind Speed (unit: m/s) Records to one decimal place.

Gust Speed

10.0

Gust Speed (unit: m/s) Records to one decimal place.

Barometric

1013.0

Barometric (unit: hPa) Records to one decimal place.

Humidity

85

Humidity (unit: %)

GPS Time Stamp

12:00:00

Time data that the caller station acquires along with the position data

GPS Message

Osaka City/ID-52

Caller is “NMEA”: Records the GPS message
Caller is “D-PRS: Records the D-PRS comment
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Function
Power Save

Dial Speed-UP

(Default: Auto (Short))

[MENU] > SET > Function > Power Save

[MENU] > SET > Function > Dial Speed-UP

Sets the Power Save function to reduce the current
drain and conserve battery power. When the Power
Save function is activated, the call sign or the
beginning of the signal may not be received correctly.
•• OFF:	Turns OFF the function.
•• Auto (Short):	Sets the Power saving time to
“Short.”

Turns the Dial Speed Acceleration ON or OFF.
The acceleration automatically increases the tuning
speed when you rapidly rotate [DIAL].
•• OFF: Turns OFF the function.
•• ON: Turns ON the function.
Auto Repeater

15 ms

The Auto repeater function automatically turns the
duplex operation and tone encoder ON or OFF.

75 ms

LLThis item is displayed in only the USA version.

No signal is received
for 5 seconds�

•• OFF:
Turns OFF the function.
•• ON (DUP):	Turns ON the duplex settings
only.
•• ON (DUP, TONE):	Turns ON the duplex settings
and the tone encoder function.

•• Auto (Middle):	Sets the Power saving time to
“Middle.”
15 ms

15 ms

～
～

Standby
Reception→
Disabled

75 ms

Remote MIC Key

150 ms

↑
60 s
No signal is received
for 5 seconds�

[MENU] > SET > Function > Remote MIC Key
The function assignments for the [A], [B], [], and
[] keys on the optional HM-75LS remote control
speaker microphone can be changed.
See pages 12-19 and 12-20 for the assignable key
functions.
•• During RX/Standby:	The assigned key function is
enabled while receiving or in
the standby mode.
(Default: [A]: BAND
[B]: VFO/MR
[]: UP
[]: DOWN)
•• During TX:	The assigned key function is
enabled while transmitting.
(Default: [A]: T-CALL
[B]: --[]: --[]: ---)

•• Auto (Long):	Sets the Power saving time to
“Long.”
15 ms

15 ms

～
～

Standby
Reception→
Disabled

(Default: ON (DUP))

[MENU] > SET > Function > Auto Repeater

Standby
Reception→
Disabled

(Default: ON)

75 ms

300 ms

↑
60 s
No signal is received
for 5 seconds�

NOTE: The Power Save function is disabled when:
•• Using an external DC power source.
•• Scanning.
•• Using the DV Gateway function.
•• Using the VOX function.

Monitor

(Default: Push)

TIP: Volume level adjustment while monitoring

[MENU] > SET > Function > Monitor

•• When “VOL UP”/“VOL DOWN” are assigned, push
these keys to adjust the volume level.
•• When “VOL UP”/“VOL DOWN” are not assigned, but
“UP”/“DOWN” are assigned, push these keys to adjust
the volume level.
•• When “VOL UP”/“VOL DOWN”/“UP”/“DOWN” are not
assigned, push []/[] to adjust the volume level, if
“Monitor (Push)” or “Monitor (Hold)” is not assigned to
[]/[].

Selects an option for the [SQL] Monitor function.
(Basic manual Section 3)
•• Push:	Hold down [SQL] to monitor the frequency.
Release to stop monitoring.
•• Hold:	Push [SQL] momentarily to monitor the
frequency and push momentarily again to
cancel it.
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Function
The assignable key functions
•• During RX/Standby
Function

Descriptions

---

No function

UP

Push to increase the frequency, Memory channel, repeater, or station call sign.

DOWN

Push to decrease the frequency, Memory channel, repeater, or station call sign.

VOL UP

Push to increase the volume level.

VOL DOWN

Push to decrease the volume level.

SQL UP

Push to increase the squelch level.

SQL DOWN

Push to decrease the squelch level.

Monitor (Push)

Hold down to open the squelch. Release to close the squelch.

Monitor (Hold)

Push to open or close the squelch.

CALL

Push to select a Call Channel mode.

MR (00-00 CH)

In the Memory mode, push to select Memory channel 00-00.

MR (00-01 CH)

In the Memory mode, push to select Memory channel 00-01.

VFO/MR

Push to select the VFO mode and the Memory mode.

DR

Push to turn the DR function ON or OFF.

FROM (DR)

In the DR screen, push to select “FROM.”

TO (DR)

In the DR screen, push to select “TO.”

Home CH

Push to directly select the Home Channel that is set to the selected mode (VFO/Memory) or DR screen.
LLWhile in the Call Channel mode, or when no Home CH is set, an error beep sounds.

BAND

Push to select an operating band.

SCAN

Push to start the previously selected scan. While scanning, push to stop the scan.

Temporary Skip

Push to set the frequency to be skipped while scanning.
The selected frequencies are temporarily skipped for faster scanning.

RX>CS

Hold down for 1 second to set the last calling station’s call sign to “TO” (destination).
LLIf “[RX→CS] Key” is set to “RX > CS List,” the received call sign is not captured. The RX History list
is displayed instead.
LLTo select the call sign in the RX History using the optional remote control speaker microphone,
assign “UP”/“DOWN.”

SPEECH

•• In the VFO, Memory, or Call Channel mode, push to announce the frequency and operating mode.
•• In the DR screen, push to announce the call sign.
LLIf the Simplex mode is selected, the frequency is announced.
If the FM repeater is selected, the frequency and operating mode, or the call sign and operating
mode are announced.

MAIN/DUAL

•• Push to set the A or B band as the MAIN band.
•• Hold down for 1 second to turn the Dualwatch function ON or OFF.

MODE

Push to select the operating mode.

LOW

Push to select the transmit output power.

DUP

Push to turn the Duplex mode ON or OFF, and the shift direction to DUP+ or DUP–.

TONE/D.SQL

•• In the FM/FM-N mode, push to select the tone type.
•• In the DV mode, push to select the digital squelch type.

MW

In the VFO mode or on the DR screen, hold down for 1 second to enter the Memory channel contents
to a blank channel.

REC

•• Push to start recording.
•• While recording, hold down for 1 second to stop recording.

Voice TX

•• Push to transmit the voice audio recorded on the microSD card once.
•• Hold down for 1 second to repeatedly transmit the voice audio.
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Function
The assignable key functions
•• During TX
Function

Descriptions

---

No function

VOL UP

Push to increase the volume level.

VOL DOWN

Push to decrease the volume level.

Voice TX

•• Push to transmit the voice audio recorded on the microSD card once.
•• Hold down for 1 second to repeatedly transmit the voice audio.
LLTo make a repeat transmission, [PTT] must be released after the transmission is started.

T-CALL

Push to transmit a 1750 Hz tone.
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Function
Key Lock

Active Band

(Default: Normal)

[MENU] > SET > Function > Key Lock

[MENU] > SET > Function > Active Band

Selects the key lock type when the Key Lock function
is ON.

Selects whether or not to enable continuous frequency
selection of the operating frequency across all bands
using [DIAL].
•• Single:	When you rotate [DIAL] on the band edge,
the displayed band’s higher or lower
frequency is selected.
•• All:	When you rotate [DIAL] on the band edge,
the next band is selected.
The selectable frequencies are set to all
bands, for continuous selection.
•• HAM:	When you rotate [DIAL] on the band
edge, the amateur band’s higher or lower
frequency is selected. You cannot select a
frequency out of the amateur band.

NOTE: Regardless of the setting, you can still use
[ ], [PTT], and [
] even if the Key Lock function is
ON.
•• Normal:	All keys and dials, except [SQL] and [VOL]
are locked.
•• No SQL:	All keys and dials, except [SQL] are locked.
•• No VOL:	All keys and dials, except [VOL] are locked.
•• ALL:	All keys and dials are locked.
PTT Lock

(Default: OFF)

LLTo select another band when “Single” is selected, push
[QUICK], then select “Band Select.”
LLThis setting is for the [DIAL] operation, so all frequencies
are scanned.

[MENU] > SET > Function > PTT Lock
Turns the PTT Lock function ON or OFF.
To prevent accidental transmissions, this function
inhibits all transmissions.
•• OFF: Turns OFF the function.
•• ON: Inhibits all transmissions.
Busy Lockout

MIC Gain (Internal)

(Default: 2)

[MENU] > SET > Function > MIC Gain (Internal)
Sets the internal microphone gain to between 1
(minimum) and 4 (maximum), to suit your operation
needs.
Higher values make the microphone more sensitive to
your voice.

(Default: OFF)

[MENU] > SET > Function > Busy Lockout
Turns the Busy Lockout function ON or OFF.
This function inhibits a transmission while receiving a
signal, or when the squelch is open.
•• OFF: Turns OFF the function.
•• ON: Turns ON the function.
Time-Out Timer

(Default: All)

MIC Gain (External)

(Default: 2)

[MENU] > SET > Function > MIC Gain (External)
Sets the external microphone gain to between 1
(minimum) and 4 (maximum), to suit your operation
needs.
Higher values make the microphone more sensitive to
your voice.

(Default: 5min)

[MENU] > SET > Function > Time-Out Timer
To prevent an accidental prolonged transmission,
the transceiver has the Time-Out Timer function. The
function inhibits continuous transmissions longer than
this set period of time.
•• OFF:
Turns OFF the function.
•• 1 to 30 min:	The transmission is cut OFF after the
set period of time ends
(1, 3, 5, 10, 15, or 30 minutes).
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Function
VOX

CI-V Address

(Default: OFF)

[MENU] > SET > Function > VOX > VOX

[MENU] > SET > Function > CI-V > CI-V Address

Turns the Voice Operated Transmission (VOX)
function ON or OFF.
The VOX function starts transmission without pushing
[PTT] when you speak into the microphone, and
then, automatically returns to receive when you stop
speaking.
•• OFF: Turns OFF the function.
•• ON:	Starts transmission without pushing [PTT]
when you speak into the microphone. Then
automatically returns to receive when you
stop speaking.
VOX Level

Sets the CI-V address in hexadecimal code.

LLTo distinguish devices, each CI-V transceiver has its own
Icom standard address. “A6” is the default address of
the ID-52A/ID-52E. When 2 or more ID-52A/ID-52Es are
simultaneously controlled by a PC, set a different address
for each transceiver between 02 and DF (hexadecimal).

CI-V Baud Rate (SP Jack)

Sets the CI-V data transfer speed when remotely
controlling the transceiver through the [SP] jack,
to 4800, 9600, 19200 bps, or Auto. When “Auto” is
selected, the baud rate is automatically set according
to the controller’s data rate.

(Default: 5)

Sets the VOX gain level to between 1 and 10, or OFF.
Higher values make the VOX function more sensitive
to your voice.
•• OFF: Turns OFF the VOX function.
•• 1 ~ 10:	1 (The minimum sensitivity)
10 (The maximum sensitivity)

CI-V Transceive

Turns the Transceive function ON or OFF.

LLTo use the RS-MS1A or RS-MS1I, set to “ON.”

•• OFF: The status is not output.
•• ON:	The status is output. When you change
a transceiver setting, the same change
is automatically set on other connected
transceivers or receivers, and vice versa.

(Default: 0.5sec)

Sets the VOX Delay to 0.5, 1.0, 1.5, 2.0, 2.5, or 3.0
seconds. The VOX Delay is the amount of time the
transmitter stays ON after you stop speaking, before
the VOX switches to receive.

CI-V USB/Bluetooth→REMOTE Transceive
Address
(Default: 00)

(Default: 3min)

[MENU] > SET > Function > CI-V >
CI-V USB/Bluetooth→REMOTE Transceive Address

[MENU] > SET > Function > VOX >
VOX Time-Out Timer

If you remotely operate your transceiver through a
USB cable or using Bluetooth when “CI-V Transceive”
is set to ON, the devices in the same system are also
externally controlled through the [SP] jack.
To prohibit the external control of an Icom transceiver,
set this value to other than “00.”
The control signal is output from the [SP] jack.
Select an address between 00 and DF (hexadecimal).

Sets the VOX Time-Out Timer to prevent an accidental
prolonged transmission. To disable the function, set to
“OFF.”
•• OFF: Turns OFF the function.
•• 1, 2, 3, 4, 5, 10, or 15min:
			If a continuous transmission exceeds the set
period of time, the transmission is stopped.
Headset Select

(Default: OFF)

[MENU] > SET > Function > CI-V > CI-V Transceive

[MENU] > SET > Function > VOX > VOX Delay

VOX Time-Out Timer

(Default: Auto)

[MENU] > SET > Function > CI-V >
CI-V Baud Rate (SP Jack)

[MENU] > SET > Function > VOX > VOX Level

VOX Delay

(Default: A6)

(Default: Other)

[MENU] > SET > Function > VOX > Headset Select
Selects the headset type to be connected.
•• HS-95: Select when using the HS-95.
•• Other: Select when using the HS-94 or HS-97.
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Function
USB Connect

USB Serialport Function

(Default: CI-V (Echo Back OFF))

(Default: Serialport)

[MENU] > SET > Function > USB Connect

[MENU] > SET > Function > USB Serialport Function

Selects the mode when connecting the transceiver to
a PC with a USB cable.
•• Charge Only:
	You can only charge the transceiver using a USB
cable.
•• Serialport:
	You can program the transceiver, input/output
D-STAR data, output GPS information, input
weather data, and remotely control the transceiver
using the CI-V commands.

Selects the Serialport function for the USB connection
to a data device, PC, and so on.
•• CI-V (Echo Back OFF):
			The CI-V command is input or output
through the USB port. Does not send
back the CI-V command input from the
USB port.
•• CI-V (Echo Back ON):
			The CI-V command is input or output
through the USB port. Sends back the
CI-V command input from the USB port.
•• DV Data:	The DV data is input or output to the USB
port.

LLInformation

•• You need to install the USB driver.
•• When a PC is connected, the USB connection indicator
is displayed on the transceiver.
•• Select the input/output data type in “USB Serialport
Function.”
•• Confirm that “GPS Select” is set to “ON,” when you output
the received position data.
([MENU] > GPS > GPS Set > GPS Select)

NOTE: When “CI-V (Echo Back OFF)” or “CI-V
(Echo Back ON)” is selected, you cannot remotely
control the transceiver through the [SP] jack.

•• SD Card Mode:
	You can transfer the files between the inserted
microSD card and a PC, using a USB cable.

Heterodyne

LLA confirmation dialog is displayed. (p. 2-9)

(Default: Normal)

[MENU] > SET > Function > Heterodyne

NOTE:

Selects the 1st Local Oscillator frequency.
Depending on a combination of the two operating
frequencies in the Dualwatch mode, the transceiver
might generate a spurious signal on a specific receive
frequency. This may cause the S-meter to fluctuate,
even when no signal is received, for example.
If this occurs, the Heterodyne function may help. The
Heterodyne function shifts the 1st Local Oscillator
frequency to the opposite side of the signal to change
the frequency combination.

•• To charge from a PC, set “USB Power Input (Phone,
Tablet, PC)” to “ON.”
•• Use a data communication compatible USB cable when
“Serialport” or “SD Card Mode” is selected.
•• While in the SD Card Mode, the transceiver works
not as a transceiver but as a data storage device. It
temporarily stops recording and logging.

TIP: Download the USB driver and the installation
guide from the Icom website.
https://www.icomjapan.com/support/
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Function
Battery Pack Select

LO/CALL Key Actions

(Default: BP-271/BP-272)

[MENU] > SET > Function > Battery Pack Select

[MENU] > SET > Function > LO/CALL Key Actions

Selects the model of the attached battery pack to
display the optimized battery status.
Battery Pack Confirmation

Selects whether or not to change the [CALL], [LO],
and [MR] keys operation to the same as the ID-51A/E.
•• Standard:	The key’s operations do not change.
•• ID-51 Compatible (CS/LOW):
			The key’s operation change as described
below.
				
[CALL]: Hold down for 1 second to
change the transmit power
levels.
				
[LO]:	In the DV mode, hold down for
1 second to display the CALL
SIGN screen.
				
[MR]:	Push to enter the Memory mode,
and then push again to enter the
Call Channel mode.
For the ID-52A only
In the Call Channel mode,
push to enter the Weather
Channel mode.

(Default: OFF)

[MENU] > SET > Function > Battery Pack Confirmation
Selects whether or not to display the Battery Pack
Select dialog the first time the transceiver is turned
ON after reattaching a battery pack.
Charging (Power ON)

(Default: Standard)

(Default: ON)

[MENU] > SET > Function > Charging (Power ON)
Selects whether or not to charge the battery pack
when the optional external DC power cable (CP-12L
or OPC-254L) is connected to [DC IN], even if the
transceiver is ON.
USB Power Input (Phone, Tablet, PC) (Default: ON)
[MENU] > SET > Function >
USB Power Input (Phone, Tablet, PC)

[CALL]
[MR]

Selects whether or not to use a mobile device or a PC
as an external power source.
Screen Capture [PWR] Key

[LO]

(Default: OFF)

[MENU] > SET > Function > Screen Capture [PWR] Key
Assigns the Screen Capture function to [ ].
•• OFF: [ ] does not act as the Screen Capture key.
•• ON:	Pushing [ ] captures the transceiver display
onto a microSD card.
Screen Capture File Type

(Default: BMP)

[MENU] > SET > Function > Screen Capture File Type
Sets the file format for the Screen Capture function to
PNG or BMP.
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Display
Backlight

Dim Screen

(Default: Auto (DC IN:ON))

[MENU] > SET > Display > Backlight

[MENU] > SET > Display > Dim Screen

Selects an option for the transceiver backlight.
•• OFF: The backlight does not light.
•• ON:	The backlight lights continuously.
•• Auto:	The backlight lights when you push a key or
rotate [DIAL], and reduces the brightness*
after the set period of time in “Backlight Timer.”
•• Auto (DC IN:ON):
			
The backlight lights when you push a key or
rotate [DIAL], and reduces the brightness*
after the set period of time in “Backlight Timer.”

Selects whether or not to automatically reduce the
backlight brightness.
•• OFF:	The backlight immediately goes out after the
set period of time in “Backlight Timer.”
The backlight brightness automatically changes
•• ON:	
to the “Brightness (Dim)” level after the set
period of time in “Backlight Timer,” and goes
out after the set period of time in “Dim Timer.”
The image of the Dim Screen function

				When an external DC power source is
connected, lights continuously.
LLWhen using the GPS Logger Only mode, “Auto” is
automatically selected.
* When “Dim Screen” is set to “OFF,” the backlight goes out
after the set period of time in “Backlight Timer.”

Backlight Timer

Operating

No operating

The Dim Screen
function is ON�

Backlight Timer
(Default: 10sec)

(Default: 10sec)

Lights at the
“Brightness” level�
(Default: 8)

[MENU] > SET > Display > Backlight Timer
Sets the Backlight Timer to 5, 10, or 30 seconds.
Depending on the “Backlight” setting, the backlight
lights for this set period of time, and then automatically
reduces the brightness.

1

2

3

4

5

The Backlight
goes out�

Dim Timer
(Default: 1min)

Lights at the
“Brightness (Dim)” level�
(Default: 1)

6

7

8

Dim Timer

LLWhen “Dim Screen” is set to “OFF,” the backlight goes out
after this set period of time.

Brightness

(Default: ON)

(Default: 1min)

[MENU] > SET > Display > Dim Timer
Sets the Dim Timer to 1, 2, 5, or 10 minutes, or Hold.
Depending on the “Dim Screen” setting, the backlight
lights at the “Brightness (Dim)” level for this set period
of time, and then automatically goes out.
•• 1/2/5/10min:	The backlight goes out after this set
period of time.
•• Hold:	The backlight does not go out.

(Default: 8)

[MENU] > SET > Display > Brightness
Sets the LCD backlight brightness level to between
1 (dim) and 8 (bright).

Brightness (Dim)

(Default: 1)

[MENU] > SET > Display > Brightness (Dim)
Sets the LCD backlight brightness level for the set period
of time in “Dim Timer,” to between 1 (dim) and 7 (bright).

LLSet a lower level than “Brightness.” If you set a higher level
than “Brightness,” the Dim Screen function does not work.
LLYou can check the brightness at each level on the
“Brightness” screen.

Background Color

(Default: White)

[MENU] > SET > Display > Background Color
Sets the display background color to Black or White.
Contrast

(Default: Standard)

[MENU] > SET > Display > Contrast
Sets the display contrast to Light, Standard, or Dark.
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Display
Busy LED

RX Position Display

(Default: ON)

[MENU] > SET > Display > Busy LED

[MENU] > SET > Display > RX Position Display

Selects whether or not to light the TX/RX indicator
while receiving a signal, or the squelch is open. To
conserve battery power, turn OFF this function.

Selects whether or not to display position data in
a dialog when the caller station’s position data is
included in the signal received in the DV mode.
•• OFF: No data is displayed in a dialog.
•• ON (Main/Sub):
			When the caller station’s position data is
included in the signal, its data is displayed in
a dialog.
•• ON (Main Only):
			When the caller station’s position data is
included in the signal received in the MAIN
band, its data is displayed in a dialog.

LLThe indicator lights red while transmitting, regardless of
the setting.

•• OFF:	The indicator does not light, even if a signal is
received.
•• ON:	The indicator lights green while receiving a
signal, or the squelch is open.

RX Call Sign

(Default: Normal)

[MENU] > SET > Display > RX Call Sign

LLThe time period to display the dialog depends on the “RX
Position Display Timer” setting.

In the DV mode, selects whether or not to display the
call sign and the message of the caller station when a
call is received.
•• OFF:	Does not display the caller station’s call
sign and message.
•• Normal:	The caller station’s call sign and message
automatically scroll once, and then
disappear.
•• RX Hold:	The caller station’s call sign and message
automatically scroll once, and then the
call sign is displayed on the transceiver’s
display until the signal disappears.
•• Hold:	The caller station’s call sign and message
automatically scroll once, and then the
call sign is displayed on the transceiver’s
display until the signal disappears.
When the signal disappears, the call sign
and the message are each repeatedly
displayed for 2 seconds.

RX Position Display Timer

(Default: 10sec)

[MENU] > SET > Display > RX Position Display Timer
Sets the RX position data’s time period to display in a
dialog.
•• 5/10/15/30sec:	Displays the caller’s position for this
set period of time.
•• Hold:	Displays the caller’s position until
you operate the transceiver.
Reply Position Display

(Default: ON)

[MENU] > SET > Display > Reply Position Display
Selects whether or not to display the caller’s position
data when the data is included in the Auto Replay
signal.
•• OFF: Does not display the caller’s position data.
•• ON:	Automatically displays the caller’s position
data.

LLWhen “Normal,” “RX Hold,” or “Hold” is selected, and if
the call sign and name of the caller station is entered in
your memory, the name is displayed after displaying the
call sign.

RX Picture Indicator
RX Position Indicator

(Default: ON (Main/Sub))

(Default: ON)

(Default: ON)

[MENU] > SET > Display > RX Picture Indicator

[MENU] > SET > Display > RX Position Indicator

Selects whether or not to display the RX Picture
Indicator when a picture is included in the received
signal.
•• OFF:	No indicator is displayed, even if a picture is
included in the received signal.
•• ON:	The indicator is displayed when a picture is
included in the received signal.

Selects whether or not to display the indicator when
position data is included in the signal received in the
DV mode.
•• OFF:	No indicator is displayed, even though the
position data is included in the received
signal.
•• ON:	The indicator is displayed when the position
data is included in the received signal.

LLWhen “RX Call Sign” is set to “OFF,” the indicator is not
displayed, even if a picture is included in the received
signal.

LLWhen “RX Call Sign” is set to “OFF,” the indicator is not
displayed, even though position data is included in the
received signal.
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Display
DV RX Backlight

Single Band Display

(Default: ON)

[MENU] > SET > Display > DV RX Backlight

(Default: Date)

[MENU] > SET > Display > Single Band Display

Turns the DV RX Backlight function ON or OFF.
In the DV mode, this function turns ON the backlight
while displaying the calling station’s call sign or a
received message.
•• OFF: Turns OFF the function.
•• ON:	The backlight automatically lights when
displaying the calling station’s call sign or a
received message. The backlight stays ON
while the call sign or message is scrolling.

Selects to display the date or GPS information at the
bottom of the Single band display.
•• Date:
Displays the date.
•• GPS Information: Displays the GPS information.
Latitude/Longitude

(Default: dddº mm.mm′)

[MENU] > SET > Display > Display Unit >
Latitude/Longitude
Selects the format to display the position data.

NOTE: When you set this item to “ON,” set
“Backlight” to “Auto” or “Auto (DC IN:ON).”

Altitude/Distance
TX Call Sign

[MENU] > SET > Display > Display Unit >
Altitude/Distance

(Default: Your Call Sign)

[MENU] > SET > Display > TX Call Sign

Selects the format to display the distance and elevation.

Selects whether or not to display the My or Your call
sign while transmitting.
•• OFF:
Turns OFF the function.
•• Your Call Sign:	Displays and scrolls the call sign of
the target station.
•• My Call Sign:	Displays and scrolls your own call sign.

LLThe default value may differ, depending on the
transceiver version.

Speed
Selects the format to display the speed.

LLThe default value may differ, depending on the
transceiver version.

Temperature

(Default: Fast)

Selects the format to display the temperature.

Sets the scrolling speed of the message, call sign, or
other text, that are displayed on the screen to “Slow”
or “Fast.”

LLThe default value may differ, depending on the
transceiver version.

Barometric

(Default: ON)

(Default: inHg)

[MENU] > SET > Display > Display Unit > Barometric

[MENU] > SET > Display > Opening Message

Selects the format to display the barometric pressure.

Selects whether or not to display the opening
message at power ON.
When you set this item to “ON,” Icom logo, MY call
sign, and the model are displayed.
Voltage (Power ON)

(Default: ºF)

[MENU] > SET > Display > Display Unit > Temperature

[MENU] > SET > Display > Scroll Speed

Opening Message

(Default: mph)

[MENU] > SET > Display > Display Unit > Speed

LLWhen “Your Call Sign” is selected, and if the call sign and
name of the caller station is entered in your memory, the
name is displayed after the call sign, in any DV mode
except when using the DR function.

Scroll Speed

(Default: ft/mi)

LLThe default value may differ, depending on the
transceiver version.

(Default: ON)

[MENU] > SET > Display > Voltage (Power ON)
Selects whether or not to display the voltage of the
battery or external DC power source at power ON.
NOTE: When the external DC power source voltage
is above 15.6V, “HI Voltage” is displayed. In that
case, immediately disconnect the DC power source.
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When you set the system language of the
transceiver to Japanese, the transceiver has the
capability to display both English and Japanese
characters. HOWEVER, if you select Japanese, all
menu items throughout the transceiver system will
be displayed in only Japanese characters. There will
be no English item names. Unless you are fluent in
reading Japanese characters, use this feature with
extreme caution.
If you have change the transceiver’s language to
Japanese and do not understand the menu system
in the new setting, you will have to change the
language back to English by doing a partial reset
of the transceiver CPU. A partial reset will not clear
your call sign databases.

Display
Rainfall

(Default: inch)

[MENU] > SET > Display > Display Unit > Rainfall
Selects the format to display the amount of rainfall.
LLThe default value may differ, depending on the
transceiver version.

Wind Speed

(Default: mph)

[MENU] > SET > Display > Display Unit > Wind Speed
Selects the format to display the wind speed.
LLThe default value may differ, depending on the
transceiver version.

Display Language

To do a partial reset of the CPU, do the following
steps:
1.	 Push [MENU].
2.	 Select “SET.”

(Default: English)

[MENU] > SET > Display > Display Language
Sets the screen display language to English or
Japanese.

LLThis item is displayed only when “System Language” is
set to “Japanese.”

System Language

(Default: English)

3.	 Select the item (with the “etc” icon) shown below.

[MENU] > SET > Display > System Language
Sets the system language of the transceiver.
•• English:	The system language of the transceiver
is English. Only alphabetical characters
(A to Z, a to z, 0 to 9) and symbols (! “ #
$%&‘()*+,-./:;<=>?@[\]^_`
{ | } ~) can be displayed.
If Japanese characters (Kanji, Hiragana,
and Katakana) are included, the
display shows “=” or “_” instead of that
character. In that case, you can only
delete “=” or “_” in the transceiver’s edit
mode.
•• Japanese:	The system language of the transceiver
is Japanese. Kanji, Hiragana, and
Katakana characters, and the 2-bytes
symbols can be displayed. To display
such characters in the DR screen or
Menu mode, set “Display Language” to
“Japanese.”

4.	 Select the bottom item shown below.

5.	 Select the upper item shown below.

LLDO NOT select the lower item. The lower item is
for the All reset function, and the All reset clears all
entries and returns all settings to their factory defaults.

LLWhen this item is set to “English,” “Display Language” is
not displayed.

6.	 Select the upper option.

•• When the partial reset is completed, “PARTIAL
RESET” is displayed, then the display automatically
returns to the default screen.
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Sounds
Volume Select

Beep Level

(Default: All)

[MENU] > SET > Sounds > Volume Select

[MENU] > SET > Sounds > Beep Level

Select whether or not to adjust the audio output level
independently, according to the operating status.
•• All:	The audio output level for the FM Radio,
A band (VFO A), and B band (VFO B) are
adjusted at the same time.
•• FM Radio Separate:
			The audio output level for the FM Radio
is independently adjusted. The audio
output level for A band (VFO A) and B
band (VFO B) are adjusted at the same
time.
•• Separate:	The audio output level for the FM Radio,
A band (VFO A), and B band (VFO B) are
independently adjusted.

Sets the beep output level to 0 (OFF) or 1 (minimum)
~ 9 (maximum).
Beep/Vol Level Link

(Default: OFF)

[MENU] > SET > Sounds > Beep/Vol Level Link
Selects whether or not the beep output level can be
adjusted by rotating [VOL].
•• OFF:	The output level is fixed to the level set in
“Beep Level.”
•• ON:	The output level can be adjusted by rotating
[VOL].
Key-Touch Beep

NOTE: When an EMR signal is received, the audio
output level for A band and/or B band may be set to
the selected level in “EMR AF Level,” depending on
this setting.

(Default: ON)

[MENU] > SET > Sounds > Key-Touch Beep
Turns the confirmation beep ON or OFF.
•• OFF: No beep sounds.
•• ON: A beep sounds when you push a key.

LLThe audio output level for the FM Radio is not changed,
because the EMR function is for the DV mode
operation.

Home CH Beep

When “All” or “FM Radio Separate” is selected:
The audio output level for A band and B band is set
to the selected level in “EMR AF Level.”

(Default: ON)

[MENU] > SET > Sounds > Home CH Beep
Turns the Home CH Beep ON or OFF.
•• OFF: No beep sounds.
•• ON:	A beep sounds when you select the Home
Channel.

When “Separate” is selected:
Either the audio output level for A band or B band
that the signal is received on, is set to the selected
level in “EMR AF Level.”

FM Radio Level

(Default: 3)

LLIn the VFO or Memory mode, when the Home Channel
frequency or the Home Channel Memory is selected, the
Home CH Beep sounds.
LLIn the DR screen, when the Home Channel Access
repeater is set in FROM, the Home CH Beep sounds.

(Default: 0)

[MENU] > SET > Sounds > FM Radio Level
Band Edge Beep

Sets the initial audio output level difference between
the FM Radio and the A and B bands when “Volume
Select” is set to “All.”
•• +5 ~ +1:	The FM Radio audio output level is higher
than the VFO mode audio.
•• 0:		The FM Radio audio output level is the
same as the VFO mode audio.
•• –5 ~ –1:	The FM Radio audio output level is lower
than the VFO mode audio.
Earphone Mode

(Default: OFF)

[MENU] > SET > Sounds > Band Edge Beep
Turns the Band Edge Beep ON or OFF.
•• OFF: No beep sounds.
•• ON:	A beep sounds when you tune out of, or back
into the AIR, VHF, and UHF band’s frequency
range.
Scan Stop Beep

(Default: OFF)

(Default: OFF)

[MENU] > SET > Sounds > Scan Stop Beep

[MENU] > SET > Sounds > Earphone Mode

Turns the Scan Stop Beep ON or OFF.
•• OFF:	No beep sounds.
•• ON:	A beep sounds when a scan stops by
receiving a signal.

Turns the earphone mode ON or OFF.
While in the earphone mode, the audio volume level is
automatically adjusted to the comfortable level when
the optional earphone is connected to the [MIC/SP]
jack.
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Time Set

Standby Beep (Default: ON (to me:Alarm/High Tone))

DATE
[MENU] > SET > Time Set > Date/Time > DATE

[MENU] > SET > Sounds > Standby Beep

Manually set the date to between 2020/01/01 and
2099/12/31.

Turns the Standby Beep function ON or OFF.
This function sounds a beep after a received signal
disappears, in the DV mode.
•• OFF:	Does not sound a beep after a received signal
disappears.
•• ON:	Sounds a beep after a received signal
disappears.
•• ON (to me:High Tone):
			Sounds a high pitched beep when a received
signal that is addressed to your call sign (MY)
disappears. When any other received signal
disappears, a regular beep sounds.
•• ON (to me:Alarm/High Tone):
			Sounds alarm (PiRoPiRoPiRo) when a
received signal that is addressed to your
call sign (MY) disappears. When any other
received signal disappears, a regular beep
sounds.

LLThe day of the week is automatically set.

TIME
[MENU] > SET > Time Set > Date/Time > TIME
Manually set the time that is displayed at the top of the
screen. The time is displayed in the 24 hour format.
When “GPS Time Correct” is set to “Auto,” the GPS
receiver automatically sets the time by calculating the
received Universal Time of Coordinated (UTC) time
and “UTC Offset.”
GPS Time Correct

[MENU] > SET > Time Set > GPS Time Correct
Selects whether or not the time data is automatically
corrected by a received GPS sentence.
•• OFF: Does not correct the time.
•• Auto:	Automatically corrects the time by calculating
the received UTC time and the “UTC Offset”
setting.

LLThe standby beep sounds even when “Key-Touch Beep”
is set to “OFF.”
LLThe standby beep output level depends on the “Beep
Level” setting.

Sub Band Mute

(Default: Auto)

(Default: OFF)

[MENU] > SET > Sounds > Sub Band Mute

UTC Offset

Selects whether or not to mute the SUB band audio
signal while receiving on the MAIN band, and/or
sound a beep when a signal disappears on the SUB
band.
•• OFF:
Turns OFF the function.
•• Mute:	While receiving on the MAIN band,
the SUB band audio signal is muted.
•• Beep:	When a signal disappears on the
SUB band, a beep sounds.
•• Mute & Beep:	While receiving on the MAIN band,
the SUB band audio signal is muted.
When a signal disappears on the
SUB band, a beep sounds.

(Default: ±0:00)

[MENU] > SET > Time Set > UTC Offset
Sets the UTC offset time to between –14:00 and
+14:00.
Auto Power OFF

(Default: OFF)

[MENU] > SET > Time Set > Auto Power OFF
Selects whether or not to automatically turn OFF the
transceiver after inactivity for this set period of time.
LL“AUTO POWER OFF” is displayed and beeps sound
5 seconds before turning OFF the transceiver. If you
operate the transceiver during this period of time, the
Auto Power OFF timer is reset.

LLWhen you set this item to “Beep” or “Mute & Beep,” a
beep sounds, even if no signal is received on the MAIN
band.

•• OFF: Does not turn OFF the transceiver.
•• 30/60/90/120min:
			Turns OFF the transceiver after inactivity for
this set period of time.
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SD Card
Load Setting

Date

[MENU] > SET > SD Card > Load Setting

(Default: mm/dd/yyyy)

[MENU] > SET > SD Card > Import/Export >
CSV Format > Date

Selects the saved data file to load.

Selects the date format between “yyyy/mm/dd,”
“mm/dd/yyyy,” and “dd/mm/yyyy.”
(y: year, m: month, d: day)

Save Setting
[MENU] > SET > SD Card > Save Setting
Saves the setting data onto a microSD card.

LLThe default value may differ, depending on the
transceiver version.

Save Form

Opening Picture

(Default: Now Ver)

[MENU] > SET > SD Card > Opening Picture

[MENU] > SET > SD Card > Save Form

Selects the picture that is displayed at power ON.

Selects the format to save the settings to a microSD
card.
•• Now Ver:	Saves the settings in the current
version format.
•• Old Ver (x.xx - x.xx):
				Saves the settings in an older version
format indicated in the parenthesis
(x.xx = version).

LLSee page 15-15 for details.

SD Card Info
[MENU] > SET > SD Card > SD Card Info
Displays the microSD card capacity and the time
remaining for voice recording.

LLIf you select “Old Ver (x.xx - x.xx),” a function that is
added when the transceiver’s firmware format is updated
will not be saved.
LLYou cannot load a setting file that is saved in the current
version format to an earlier firmware version.

Screen Capture View
[MENU] > SET > SD Card > Screen Capture View
Displays the selected screen capture.

Import

TX/RX Picture View

[MENU] > SET > SD Card > Import/Export > Import

[MENU] > SET > SD Card > TX/RX Picture View

Import the Memory channel contents, Radio memory
contents, UR call sign, repeater list, or GPS memory
data in the CSV format file.

Displays the pictures that are saved on the microSD card.
LLThe transceiver cannot display the picture while
transmitting picture data.
LLThe transceiver can display up to 500 pictures.

Export

Firmware Update

[MENU] > SET > SD Card > Import/Export > Export

[MENU] > SET > SD Card > Firmware Update

Export the Memory channel contents, Radio memory
contents, UR call sign, repeater list, or GPS memory
data in the CSV format file.
Separator/Decimal

Displays the Firmware Update mode.
Format

(Default: Sep[,] Dec[.])

[MENU] > SET > SD Card > Format

[MENU] > SET > SD Card > Import/Export >
CSV Format > Separator/Decimal

Formats the microSD card.
If you use a brand new microSD card, be sure to
format it in the transceiver.

Selects the separator and the decimal character for
the CSV format.
LLThe default value may differ, depending on the
transceiver version.

Unmount

•• Sep [,] Dec [.]: Separator is “,” and Decimal is “.”
•• Sep [;] Dec [.]: Separator is “;” and Decimal is “.”
•• Sep [;] Dec [,]: Separator is “;” and Decimal is “,”

[MENU] > SET > SD Card > Unmount
Unmounts the microSD card.
Before you remove a card when the transceiver is ON,
be sure to electrically unmount it. Otherwise, the data
may be corrupted or deleted.
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Bluetooth Set
Bluetooth

Headset Function Select

(Default: OFF)

[MENU] > SET > Bluetooth Set > Bluetooth

[MENU] > SET > Bluetooth Set > Headset Set >
Headset Function Select

Turns the Bluetooth function ON or OFF.
Auto Connect

Selects the PTT and microphone combination when
both the Bluetooth headset and the transceiver
microphone are used.
•• Normal:	Transmits the audio from the Bluetooth
headset, or the transceiver microphone,
whichever [PTT] is pushed.
•• Microphone:
			Transmits the audio from the Bluetooth
headset.
Transmission is enabled by pushing either
the [PTT] on the Bluetooth headset, or the
transceiver microphone. The transceiver
microphone is only used for the PTT
control.
•• PTT:	Transmits the audio from the transceiver
microphone.
Transmission is enabled by pushing either
the [PTT] on the Bluetooth headset, or the
transceiver microphone. The Bluetooth
headset is only used for the PTT control.

(Default: ON)

[MENU] > SET > Bluetooth Set > Auto Connect
Selects whether or not to automatically connect to the
paired Bluetooth device when its power is turned ON.
•• OFF:	Does not connect to the paired device.
•• ON:	Automatically connects to the last connected
device.
Pairing/Connect
[MENU] > SET > Bluetooth Set > Pairing/Connect
Searches for the Bluetooth device to connect, or
display the paired Bluetooth devices in the list.
LLSee page 13-3 for details.

<<Pairing Reception>>
[MENU] > SET > Bluetooth Set > <<Pairing Reception>>

LLThe Bluetooth headset operation for each option is listed
below.

Enters the pairing reception mode.
LLSee page 17-7 for details.

AF Output

(Default: Normal)

(Default: Headset Only)

[MENU] > SET > Bluetooth Set > Headset Set >
AF Output
Selects the AF Output device when a Bluetooth
headset is connected.
•• Headset Only:	Outputs audio to only the connected
Bluetooth headset.
•• Headset & Speaker:
			Outputs audio to both the connected
Bluetooth headset and the
transceiver’s speaker.

Option

TX control

TX audio

Normal

Enabled

Enabled

Microphone

Enabled

Enabled

PTT

Enabled

Disabled
(Audio from the microphone is
transmitted.)

Auto Disconnect

(Default: OFF)

[MENU] > SET > Bluetooth Set > Headset Set >
Auto Disconnect
Sets the Disconnect Timer between 0 and 10
seconds, or OFF.
If there is no audio output from the Bluetooth headset,
and there is no key operation for this set period of
time, the Synchronous Connection-Oriented (SCO)
link* is automatically disconnected.
LLThe SCO link is connected when the signal is received, a
beep sounds, or there is a key operation.
* A Bluetooth link for voice communication
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RX Priority Setting (LE Device)

(Default: MAIN Band)

VOX Level

[MENU] > SET > Bluetooth Set > Headset Set >
VOX > VOX Level

[MENU] > SET > Bluetooth Set > Headset Set >
RX Priority Setting (LE Device)

Sets the VOX gain level to between 1 and 10, or OFF.
Higher values make the VOX function more sensitive
to your voice.
•• OFF: Turns OFF the VOX function.
•• 1 ~ 10:	1 (The minimum sensitivity)
10 (The maximum sensitivity)

Selects the communication priority for the DV Fast
Data and receive audio, when connecting an iOS
device (Bluetooth LE (Low Energy)) and a Bluetooth
headset. The Bluetooth LE communication cannot
be simultaneously used for both DV Fast Data and
Headset audio.

LLWhen connecting to an SPP (Serial Port Profile) device
such as a data device or PC, the Bluetooth device
functions according to the “Serialport Function” (p. 12-34)
setting.

VOX Delay

(Default: 0.5sec)

[MENU] > SET > Bluetooth Set > Headset Set >
VOX > VOX Delay

•• DV Fast Data:	Received audio is not output from
the headset, regardless of the band
(MAIN or SUB).
•• RX Audio:	DV Fast Data is not transferred
during the received audio is output
from the headset.
•• MAIN Band:	The audio received on the SUB band
is not output from the headset when
a DV Fast Data is received on the
MAIN band.
DV Fast Data that is received on the
SUB band is not transferred while a
signal is received on the MAIN band.

VOX

(Default: 5)

Sets the VOX Delay time to 0.5, 1.0, 1.5, 2.0, 2.5 or
3.0 seconds. The VOX Delay is the amount of time the
transmitter stays ON after you stop speaking, before
the VOX switches to receive.
VOX Time-Out Timer

(Default: 3min)

[MENU] > SET > Bluetooth Set > Headset Set >
VOX > VOX Time-Out Timer
Sets the VOX Time-Out Timer to prevent an accidental
prolonged transmission. To disable the function, set to
“OFF.”
•• OFF: Turns OFF the function.
•• 1, 2, 3, 4, 5, 10, or 15min:
			If a continuous transmission exceeds the set
period of time, the transmission is cut off.

(Default: OFF)

[MENU] > SET > Bluetooth Set > Headset Set >
VOX > VOX
Turns the Voice Operated Transmission (VOX)
function ON or OFF.
The VOX function starts transmission without pushing
[PTT] when you speak into the microphone, and
then, automatically returns to receive when you stop
speaking.

LLTo use the VOX function, the optional Bluetooth headset
is required.

•• OFF: Turns OFF the function.
•• ON:	Starts transmission without pushing [PTT]
when you speak into the microphone. Then
automatically returns to receive when you
stop speaking.
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Power Save

Custom Key
				
				

(Default: OFF)

[MENU] > SET > Bluetooth Set > Headset Set >
Icom Headset > Power Save

[MENU] > SET > Bluetooth Set > Headset Set >
Icom Headset > Custom Key

Selects whether or not to operate with the Power Save
mode while the optional VS-3 headset is connected.

Assigns the functions to the Custom Key ([PLAY]/
[FWD]/[RWD]) on the optional VS-3 headset.

LLWhen a headset (user supplied) or a data device is
connected, the Power Save mode is automatically turned
OFF, regardless of this setting.

LLSee page 12-35 about the functions.

•• OFF: Turns OFF the function.
•• ON:	The Power Save mode is enabled when no
communication or operation is performed for
120 seconds.

One-Touch PTT

Serialport Function

(Default: CI-V (Echo Back OFF))
[MENU] > SET > Bluetooth Set > Data Device Set >
Serialport Function

(Default: OFF)

Sets the serial port function for the Bluetooth SPP
(Serial Port Profile) connection to a data device, PC,
and so on.
•• CI-V (Echo Back OFF):
			Transmits or receives a CI-V command.
Does not send back the serial data
received from the SPP connection.
•• CI-V (Echo Back ON):
			Transmits or receives a CI-V command.
Sends back the serial data received from
the SPP connection.
•• DV Data:	Transmits or receives data in the DV
mode.
Does not input the cloning or weather
data entries, or output the GPS data.

[MENU] > SET > Bluetooth Set > Headset Set >
Icom Headset > One-Touch PTT
Sets the One-Touch PTT function when the optional
VS-3 headset is connected.
This function enables you to transmit without
continuously holding down [PTT].

LLWhen a headset (user supplied) is connected, this
function is automatically turned ON, regardless of this
setting.

•• OFF: Transmits while holding down [PTT].
•• ON:	Pushing [PTT] toggles between transmit and
receive.

PTT Beep

(Default: OFF)

[MENU] > SET > Bluetooth Set > Headset Set >
Icom Headset > PTT Beep

Bluetooth Device Information

Sets the beep sound when you push [PTT] on the
optional VS-3 headset.
•• OFF: No beep sounds.
•• ON: A beep sounds.
Custom Key Beep

(Default: [PLAY]: --[FWD]: UP
[RWD]: DOWN)

[MENU] > SET > Bluetooth Set >
Bluetooth Device Information
Displays the Bluetooth device information.
Initialize Bluetooth Device

(Default: OFF)

[MENU] > SET > Bluetooth Set >
Initialize Bluetooth Device

[MENU] > SET > Bluetooth Set > Headset Set >
Icom Headset > Custom Key Beep

Initializes the installed Bluetooth unit.

Sets the beep sound when you push the Custom Key
([PLAY]/[FWD]/[RWD]) on the optional VS-3 headset.
•• OFF: No beep sounds.
•• ON: A beep sounds.
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The assignable key functions
Function

Descriptions

---

No function

UP

Push to increase the frequency, Memory channel, repeater, or station call sign.

DOWN

Push to decrease the frequency, Memory channel, repeater, or station call sign.

VOL UP

Push to increase the volume level.

VOL DOWN

Push to decrease the volume level.

SQL UP

Push to increase the squelch level.

SQL DOWN

Push to decrease the squelch level.

Monitor (Push)

Hold down to open the squelch. Release to close the squelch.

Monitor (Hold)

Push to open or close the squelch.

CALL

Push to select a Call Channel mode.

MR (00-00 CH)

In the Memory mode, push to select Memory channel 00-00.

MR (00-01 CH)

In the Memory mode, push to select Memory channel 00-01.

VFO/MR

Push to select the VFO mode and the Memory mode.

DR

Push to turn the DR function ON or OFF.

FROM/TO (DR)

In the DR screen, push to select “FROM” and “TO.”

Home CH

Push to directly select the Home Channel that is set to the selected mode (VFO/Memory) or DR screen.
LLWhile in the Call Channel mode, or when no Home CH is set, an error beep sounds.

BAND

Push to select an operating band.

SCAN

Push to start the previously selected scan. While scanning, push to stop the scan.

Temporary Skip

Push to set the frequency to be skipped while scanning.
The selected frequencies are temporarily skipped for faster scanning.

RX>CS

Hold down for 1 second to set the last calling station’s call sign to “TO” (destination).
LLIf “[RX→CS] Key” is set to “RX > CS List,” the received call sign is not captured. The RX History list
is displayed instead.
LLTo select the call sign in the RX History using the optional remote control speaker microphone,
assign “UP”/“DOWN.”

SPEECH

•• In the VFO, Memory, or Call Channel mode, push to announce the frequency and operating mode.
•• In the DR screen, push to announce the call sign.
LLIf the Simplex mode is selected, the frequency is announced.
If the FM repeater is selected, the frequency and operating mode, or the call sign and operating
mode are announced.

MAIN/DUAL

•• Push to set the A or B band as the MAIN band.
•• Hold down for 1 second to turn the Dualwatch function ON or OFF.

MODE

Push to select the operating mode.

LOW

Push to select the transmit output power.

DUP

Push to turn the Duplex mode ON or OFF, and the shift direction to DUP+ or DUP–.

TONE/D.SQL

•• In the FM/FM-N mode, push to select the tone type.
•• In the DV mode, push to select the digital squelch type.

MW

In the VFO mode or on the DR screen, hold down for 1 second to enter the Memory channel contents
to a blank channel.

REC

•• Push to start recording.
•• While recording, hold down for 1 second to stop recording.

Voice TX

•• Push to transmit the voice audio recorded on the microSD card once.
•• Hold down for 1 second to repeatedly transmit the voice audio.

T-CALL

Push to transmit a 1750 Hz tone.
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Voltage
[MENU] > SET > Others > Information > Voltage
Displays the voltage of the battery pack and external
power source.
LLWhen you attach the Li-ion battery pack, the charge
status of the battery pack and the battery voltage are
displayed.
LLWhen you attach the optional battery case, the battery
case’s terminal voltage is displayed.

Version
[MENU] > SET > Others > Information > Version
Displays the transceiver firmware’s version number.
Clone Mode
[MENU] > SET > Others > Clone > Clone Mode
Enters the clone mode to read or write the CS-52 data
from or to the PC.
LLRestart the transceiver to cancel the clone mode.

Partial Reset
[MENU] > SET > Others > Reset > Partial Reset
Resets operating settings to their default values (VFO
frequency, VFO settings, menu contents).
LLSee page 15-18 for details.

All Reset
[MENU] > SET > Others > Reset > All Reset
Clears all data and returns all settings to their factory
defaults.
Memory channel contents, Repeater list, and so on
will all be cleared, so you will need to rewrite your
operating settings.
LLSee page 15-18 for details.
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Bluetooth® operations

Turning ON the Bluetooth®
function

You can connect Bluetooth devices to the transceiver
using the Bluetooth function.

[MENU] > SET > Bluetooth Set > Bluetooth

LLSee the Basic manual to pair, disconnect, or delete
devices.

1.	 Push [MENU].
2.	 Select “Bluetooth Set” in the “SET” menu.
3.	 Select “Bluetooth.”

Icom Headset
When you connect the VS-3 Bluetooth® headset to the
transceiver, you can wirelessly transmit and receive it.
The VS-3 has a [PTT] switch, so you can transmit in
the same way as using the transceiver’s [PTT] switch.
The VOX function can also be used to select transmit
and receive by using your voice through the headset
to switch between TX and RX.
You can assign a function to the keys on the side
panel of the VS-3 to remotely operate the transceiver.

4.	 Select “ON.”

Android™/iOS device
When you connect a mobile device to the transceiver
through Bluetooth and using the application, you can
use the extended D-STAR functions such as data
transmission and image transmission.
LLSee page 17-5 for the applications and how to pair the
transceiver with a mobile device.

LLTo exit the MENU screen, push [MENU].

IMPORTANT: The Bluetooth communication range
may vary, depending on the environment in which
the device operates. Microwave ovens or Wireless
LAN may cause interference.
In that case, stop using those devices or increase
the space between the Bluetooth device and the
other devices.
All Bluetooth devices have a range of use. If the
communication is unstable, use the device within the
range.

Headset device
Optional VS-3
(Bluetooth Headset)
Bluetooth

ID-52A/E
Mobile device
Data device
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Connecting to a Bluetooth® headset
You can connect an optional Bluetooth headset to the
transceiver.
Step 1. Selecting the pairing mode of the headset.
See the instruction manual of the headset to select
the pairing mode.
Step 2. Searching for the headset (Transceiver)
[MENU] > SET > Bluetooth Set > Pairing/Connect
1.	 Push [MENU].
2.	 Select “Bluetooth Set” in the “SET” menu.
3.	 Select “Pairing/Connect.”

7.	 Select “YES.”

4.	 Select “Device Search.”

•• After connecting to the headset,
the pairing list.

5.	 Select “Search Headset.”

is displayed in

8.	 To exit the MENU screen, push [MENU].

•• Displays the usable headsets in the pairing list.

LLWhile connected to a Bluetooth device, the Bluetooth
icon is displayed on the Standby screen.
LLWhen “AF Output” is set to “Headset Only” and the
Bluetooth connection is accidentally disconnected, a
dialog is displayed to select whether or not to output
the audio from the transceiver’s speaker. (p. 13-4)

6.	 Select a headset to pair.

•• The confirmation dialog is displayed.
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Headset Settings
DHeadset
D
Function Select

These are settings when using a Bluetooth headset.

You can select the PTT and microphone combination
when either a Bluetooth headset or the transceiver
microphone are used.

1.	 Push [MENU].
2.	 Select “Bluetooth Set” in the “SET” menu.
3.	 Select “Headset Set.”

LLSee page 12-32 for details.

[MENU] > SET > Bluetooth Set > Headset Set >
Headset Function Select
•• Normal:
Transmitting the voice from the Bluetooth headset
while pressing [PTT] or the internal microphone’s
voice.
•• Microphone:
Using the Bluetooth headset as a microphone.

LLThe audio from the internal microphone cannot be
transmitted.
LLYou can also transmit by pressing the Bluetooth
headset’s [PTT].

•• PTT:
Using the Bluetooth headset as a PTT switch.

DAF
D Output

LLThe audio from the internal microphone is transmitted.
The audio from the Bluetooth headset cannot be
transmitted.
LLYou can also transmit by pressing the transceiver’s
[PTT].

[MENU] > SET > Bluetooth Set > Headset Set >
AF Output
You can select the AF Output device.
If “AF Output” is set to “Headset & Speaker,” you can
hear audio from both a connected Bluetooth headset
and the transceiver’s speaker.

The operation of the Bluetooth headset for each
setting is shown in the table below.

LLSee page 12-32 for details.

Setting

TIP: When “AF Output” is set to “Headset Only,”
the following dialog is displayed if the Bluetooth
connection is accidentally disconnected.

•• YES:	The audio is output from the transceiver’s
speaker.
•• NO:	The transceiver’s volume level is automatically
set to 0, and the audio is not output from the
transceiver’s speaker.
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Transmit operation

Audio input

Normal

✔

✔

Microphone

✔

✔

PTT

✔

(Use internal microphone)
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DAuto
D
Disconnect

DVOX
D
function

The Voice Operated eXchange (VOX) function toggles
the transceiver between transmit and receive by your
voice. This function provides hands-free operation.
You can use the VOX function with the optional VS-3
or a third party’s Bluetooth headset.

[MENU] > SET > Bluetooth Set > Headset Set >
Auto Disconnect
You can set the disconnect timer between 0 and 10
seconds or OFF.
If there is no audio signal to the Bluetooth headset, or
no operation is performed for a set period of time, the
receiver automatically disconnects the Synchronous
Connection-Oriented (SCO) link.

Depending on the headset, the VOX function may be
disabled because of the differences in microphones.
NOTE:

LLWhen a signal is received, or an operation is performed
while the SCO link is disconnected, the receiver will
automatically reconnect the SCO link again.
LLSee page 12-32 for details.

•• If the transceiver does not connect to a Bluetooth
headset, you cannot use the VOX function through
Bluetooth, even if “VOX” is set to ON.
BE SURE to check the Bluetooth connection between
the transceiver and the headset before using the VOX
function.
•• This setting is used for when using the Bluetooth
microphone.
See page 15-10 for using the external microphone.

DRX
D Priority Setting (LE Device)
[MENU] > SET > Bluetooth Set > Headset Set >
RX Priority Setting (LE Device)
You can select the communication priority for the DV
Fast Data and receive audio, when connecting an iOS
device (Bluetooth LE (Low Energy)) and a Bluetooth
headset.
The Bluetooth LE communication cannot be
simultaneously used for both DV Fast Data and
Headset audio.

LLSee page 12-33 for details on the setting items and their
options.

[MENU] > SET > Bluetooth Set > Headset Set > VOX
VOX screen
You can turn the VOX function ON or OFF.

LLWhen connecting to a SPP (Serial Port Profile) device
such as data device or PC, the Bluetooth devise functions
according to the “Serialport Function” (p. 12-34) setting.
LLSee page 12-33 for details.

VOX Level screen
You can set the VOX gain level. Higher values make
the VOX function more sensitive to your voice.
VOX Delay screen
You can set the VOX Delay. The VOX Delay is the
amount of time the transmitter stays ON after you stop
speaking, before the VOX switches to receive.
VOX Time-Out Timer screen
You can set the VOX Time-Out Timer to prevent an
accidental prolonged transmission. To disable the
function, set to “OFF.”
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Headset Settings

DAbout
D
the Icom headset (VS-3)

You can set the detailed settings of the optional VS-3
Bluetooth® headset.
Also, you can assign a key function to [PLAY], [FWD],
and [RWD] on the “Custom Key” screen.
LLSee page 12-34 for details on the setting items and their
options.

[FWD]
[PLAY]

[MENU] > SET > Bluetooth Set > Headset Set >
Icom Headset

[RWD]
Optional VS-3
Bluetooth® headset

Power Save screen
The Power Save function temporarily disconnects the
Bluetooth connection if no communication or operation
is performed for 120 seconds.
The Power Save function is disabled when the VOX
function is ON.
One-Touch PTT screen
The One-Touch PTT function enables you to push
[PTT] to transmit, and then push again to return to
receive.
PTT Beep screen
You can set a beep to sound when you push [PTT] on
the VS-3.
Custom Key Beep screen
You can set a beep to sound when you push [PLAY],
[FWD], or [RWD] on the VS-3.
Custom key screen
You can assign a key function to [PLAY], [FWD], and
[RWD] on the VS-3.
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Editing the installed
Bluetooth® unit name

Initializing the installed
Bluetooth® unit

You can edit the transceiver Bluetooth unit’s name.

You can initialize the transceiver’s Bluetooth unit.
You should initialize the unit if you have trouble during
Bluetooth operation.

LLAfter initializing the unit, the edited name remains.

LLAfter initializing the unit, the pairing/connect list is deleted,
but the Bluetooth settings and the unit name remain.
The Bluetooth settings return to their factory defaults only
when you do a Partial Reset or All Reset. (p. 15-18)

[MENU] > SET > Bluetooth Set >
Bluetooth Device Information
1.	 Push [MENU].
2.	 Select “Bluetooth Set” in the “SET” menu.
3.	 Select “Bluetooth Device Information.”

[MENU] > SET > Bluetooth Set >
Initialize Bluetooth Device
1.	 Push [MENU].
2.	 Select “Bluetooth Set” in the “SET” menu.
3.	 Select “Initialize Bluetooth Device.”

4.	 Push [QUICK].
5.	 Select “Edit Name.”

4.	 Select “YES.”

6.	 Enter a name of up to 9 characters*, and then
push [ENT]. (Example: ICOM BT(ID-52)A)
*After “ICOM BT.”
•• The transceiver will automatically restart.

The maximum number of
paired devices
You can pair 2 types of Bluetooth devices: a Headset
and a Data device.
Number of maximum pairing devices

•• Up to 5 Bluetooth headset and data devices such as
Android device can be paired.
(Headset 1~4, Data device 1~4)
•• Up to 2 iOS devices (Bluetooth LE) can be paired.

LLTo exit the MENU screen, push [MENU].

Displays the paired
Bluetooth device.
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NOTE: See the Basic manual
Section 6 for details on how to
insert or remove a microSD card
and precautions.

About the Share Pictures function��������������������������������������������������������14-2
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About the Share Pictures function
With this function, you can send a picture that is saved
on a microSD card, and view a received picture.

About the free download software
With the ST-4001W (for Windows), ST-4001A (for
Android), or ST-4001I (for iOS), you can add text
and cut pictures down to size to send from the
transceiver. When using the ST-4001A or
ST-4001I, the edited picture can be transferred to the
transceiver through Bluetooth.

LLInformation

•• You must insert a microSD card into the transceiver.
•• To use this function, first format microSD card using the
transceiver.
•• You cannot use this function while operating in the Access
Point mode.

LLBefore using, read each manual, and use these
software according to the instructions.
LLIn this manual, ST-4001W, ST-4001A, and ST-4001I are
described as “Picture Utility software.”

NOTE:

•• Even if no microSD card is inserted into the transceiver,
a picture can be received, but the picture is not saved in
RX Picture History.
LLA picture received before inserting a microSD card
is deleted when you insert an SD card into the
transceiver.
•• DO NOT remove the microSD card from the transceiver
while using the Share Picture function. Otherwise, the
card data may be corrupted or deleted.
•• If the card data is not in a supported format, or it is
corrupted, an error dialog is displayed.
In that case, select “YES” to delete the data that is not
in a supported format or corrupted.

To transfer a picture to the transceiver
To transfer a picture to the transceiver through
Bluetooth, connect your mobile device and your
transceiver using the Bluetooth function. (p. 17-5)

About a picture file to use
•• File type*1:
JPEG (The file extension is “jpg.”)
•• Picture size*2: 640 x 480, 320 x 240, or 160 x 120 (px)
•• File size:
200 KB or less
•• File name:	up to 23 characters
(except a filename extension)

Mobile device

*1 The transceiver cannot read a file whose extension is
“jpeg,” or a file in the Progressive JPEG format.
*2 The transceiver cannot read a picture that is other than
the specified size, even if its aspect ratio is 4:3.
LLThe transceiver displays only 500 pictures, even if you
save more than 501 pictures onto the microSD card.
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Using the Picture screen
The RX PICTURE screen
zz Push [ENT] to display the RX PICTURE detail
screen.
zz Push D-pad() to display the RX Picture history.
(p. 14-7)

[MENU] > PICTURE
1.	 Push [MENU].
2.	 Select “PICTURE.”

•• The Picture screen is displayed.
LLTo close the Picture screen, push [QUICK], and then
select “<<Exit Picture Screen>>.”

Received band

TX block marker

RX Picture zone*
Select to display the
RX PICTURE screen.

TX Picture zone
Select to display the
TX PICTURE screen.

Current time
History number
Picture Size
Picture Quality

* When signals that contain picture data are received on the
MAIN and SUB bands at the same time, both pictures are
saved on a microSD card, but a picture is displayed on
only the MAIN band.

Received time

The TX PICTURE screen
zz Push [ENT] to display the TX PICTURE SET
screen.
zz Push D-pad() to display the TX Picture history.
(p. 14-7)

In the Quick Menu window, you can select the
following options.
Item

Picture TX

Action
OFF

Turns OFF the Share
Pictures function.

Single TX

Turns ON the Share
Pictures function.
LLThe picture is sent while
transmitting. After the
sending is completed, this
function is turned OFF.

TX block marker

Repeat TX The picture is repeatedly sent.
<<TX All>>

Sends the picture using the DV Fast
Data function.

<<Back To 1st>>

Moves the TX block marker back to the
1st block.

<<Exit Picture
Screen>>

Closes the Picture screen.

When a received signal contains picture data
When the received signal contains picture data, the
RX Picture icon is displayed.
RX Picture icon

LLYou can turn OFF the RX Picture icon.
([MENU] > SET > Display > RX Picture Indicator)

14-3

14 SHARE PICTURES FUNCTION
Preparing a TX picture
There are 2 ways to prepare a TX picture.

•• Transfer from a mobile device using the Picture Utility software, through Bluetooth.
•• Save on a microSD card using the PC or mobile device.

DTransfer
D
from the mobile device
through Bluetooth

DSave
D
on the microSD card using the
PC or mobile device

1.	 Insert a microSD card into the transceiver’s slot,
and then turn ON the transceiver.
2.	 In the mobile device, open the Picture Utility
software.

1.	 Turn OFF the transceiver, then remove the
microSD card from the transceiver.
2.	 Insert it into the microSD card drive or a memory
card reader* on your PC or mobile device.
* User supplied.
3.	 Copy a picture file, and paste it in the “Picture”
folder (“ID-52” > “Picture”) on the card.
4.	 Remove the card from your device, and insert it
into the transceiver’s slot.

LLWhen using an Android device for the first time, pair
the transceiver with your device. (p. 17-7)

3.	 Open the Transfer Settings screen.
4.	 Select “Using Bluetooth,” and then set “Transfer
Devices” to your transceiver.

LLWhen using an iOS device for the first time, pair the
transceiver with your device. (p. 17-9)
LLSee the ST-4001A or ST-4001I instruction manual
for details. They can be downloaded from the Icom
website.

NOTE: Before you remove the SD card, be sure to
electrically unmount it. Otherwise, the data may be
corrupted or deleted.
TIP:

5.	 Open a picture to transfer using the Picture Utility
software.
6.	 Touch the Transfer ( ) button.

•• When “USB Connect” is set to “SD Card Mode,” and the
transceiver is connected to the PC through a USB data
cable, you can directly access the microSD card that is
set in the transceiver from the PC.
([MENU] > SET > Function > USB Connect)
•• You can save a received picture in the “Picture” folder
on the SD card. (p. 14-7)

•• Starts transferring, and the transferred picture is
saved on the microSD card.
LLThe file name is automatically set in the following
format: yyyymmdd_hhmmss (yyyy: Year, mm: month,
dd: day, hh: hour, mm: minute, ss: second).

NOTE: If you cannot transfer the picture, check the
following:
On the transceiver

•• The transceiver is turned ON.
•• The Bluetooth function is ON.
•• The transceiver’s firmware is the latest version.
•• A microSD card is inserted into the transceiver.
•• The transceiver is in a normal operating mode.
LLThe transceiver cannot receive the picture in special
modes, such as the firmware update mode, clone
mode, setting save mode, and import or export mode.

On the device

•• The Bluetooth function is ON.
•• “Transfer Devices” is set to your transceiver.
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Sending the picture
Step 1. Selecting a picture to send

Step 2. Sending the picture
1.	 Push [QUICK].
2.	 Select “Picture TX.”

LLYou can retransmit the picture in the TX PICT HISTORY
screen. (p. 14-7)
LLWhen you transfer the picture through Bluetooth, it is
set to “TX Picture.” If it is not necessary to change, go to
“Step 2. Sending the picture.”

[MENU] > PICTURE
1.	 Push [MENU].
2.	 Select “PICTURE.”
3.	 Push D-pad() to select the TX Picture zone, and
then push [ENT].

3.	 Select “Single TX” or “Repeat TX.”

Displayed while the Share
Pictures function is ON.

4.	 Hold down [PTT] to transmit.

LLThe picture is sent while transmitting.

4.	 Push [ENT] again.
5.	 Select “TX Picture.”

5.	 Release [PTT] to receive.

Sending a picture using the DV Fast Data
function
Select “<<TX All>>” in step 2 to send a picture using
the DV Fast Data function.

6.	 Rotate [DIAL] to select a picture.

LLYou cannot view a picture if it is not in a supported
format (p. 14-2), or is corrupted.

7.	 Push [ENT].
8.	 Set “Picture Size,” “Picture Quality,” and
“Receiver.”

LLDO NOT select “<<TX All>>” when you send a picture
to other transceivers that can receive only slow speed
data.
LLWhile transmitting voice audio by holding down [PTT] on
the microphone, the transceiver automatically changes
to the Slow Speed Data mode.

LLSee page 14-6 about each setting item.

9.	 To close the TX PICTURE SET screen, push
[MENU].
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Sending the picture

DMoving
D
the TX block marker

DTX
D PICTURE SET

You can select the block to start sending.

This screen is used to set a picture, size, quality, and
its intended destination to send.

LLWhile sending a picture, you cannot move the TX block
marker.

LLWhile sending a picture, you cannot change the settings.

1.	 Push D-pad() to select the TX Picture zone, and
then push [ENT].
2.	 Push [QUICK].
3.	 Select “TX Picture Block Select.”

1.	 Push D-pad() to select the TX Picture zone, and
then push [ENT].
2.	 Push [ENT] again.
3.	 Select the setting item.

4.	 Rotate [DIAL] or push D-pad to move the TX block
marker.

4.	 Select an option.

5.	 To close the TX PICTURE SET screen, push
[MENU].

LLTo move the TX block marker back to 1st block, push
[QUICK], and then select “BACK TO 1ST.”

5.	 Push [ENT].
6.	 To close the TX PICTURE screen, push [MENU].

TIP: You can set each item to its default by pushing
[QUICK], and then selecting “Default” on the Quick
Menu window.
TX Picture
Select the picture to send, saved in the “Picture” folder
(“ID-52” > “Picture”) on the microSD card.
LLWhen you set the TX Picture in the TX PICT HISTORY
screen, “(RE TX)” is displayed before the file name.

Picture Size
(Default: 320 x 240)
Set the desired size of a picture to send to “160 x
120,” “320 x 240,” or “640 x 480.”
LLYou cannot select a size larger than the size of the
picture.

Picture Quality
(Default: Standard (50%))
Set the quality of a picture to send to “Low (25%),”
“Standard (50%),” or “High (75%).”
Receiver
(Default: -----)
Enter the receiver’s call sign to let all stations that receive
the picture know the picture’s intended destination.
NOTE: All stations that receive the signal can see
the picture, even if they are not set as the receiver.
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Viewing the pictures
DViewing
D
the RX Picture History

DViewing
D
the TX Picture History

When you receive a DV call that has picture data, a
received picture log is saved. Up to 50 history data
can be saved. When you receive the 51st picture, the
oldest history data is deleted.

When you send a picture, the picture log is saved. Up
to 50 history data can be saved. When you send the
51st picture, the oldest history data is deleted.
NOTE: Confirm a microSD card is in the card slot.

NOTE: Confirm a microSD card is in the card slot.

[MENU] > PICTURE

[MENU] > PICTURE

1.	 Push [MENU].
2.	 Select “PICTURE.”
3.	 Push D-pad() to select the TX Picture zone, and
then push [ENT].

1.	 Push [MENU].
2.	 Select “PICTURE.”
3.	 Push D-pad() to select the RX Picture zone, and
then push [ENT].

4.	 Rotate [DIAL] to select a TX picture history data.
5.	 Push [ENT].

4.	 Rotate [DIAL] to select an RX picture history data.
5.	 Push [ENT].

•• The TX picture history number, picture size, picture
quality, the caller’s call sign, receiver, and TX date
and time are displayed.

•• The RX picture history number, picture size, picture
quality, the caller’s call sign, receiver set by the caller,
and RX date and time are displayed.

TIP: In the Quick Menu window, you can select the
following options.

TIP: In the Quick Menu window, you can select the
following options.

•• Retransmit: Sets the picture to “TX Picture.”
•• Zoom Picture: Changes to enlarged display.
•• Delete:		Deletes the selected TX picture history data.
•• Delete All:		 Deletes all TX picture history data.
LLYou cannot delete when the selected TX picture
history data is set to “TX Picture” (RE TX).
LLYou cannot set the picture to “TX Picture” while
transmitting a picture.

•• Zoom Picture: Changes to enlarged display.
•• Save:		Saves the displayed picture onto the
microSD card.
 The file name is automatically set in
the following format:
Picyyyymmdd_callsign_xx
(yyyy: Year, mm: month, dd: day,
callsign: the caller’s call sign,
xx: serial number).
•• Delete:
	
Deletes the selected RX picture history data.
•• Delete All:
Deletes all RX picture history data.
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Viewing the pictures

DViewing
D
the pictures in the “Picture”
folder

You can view the pictures saved in the “Picture” folder
on the microSD card.
LLYou cannot view the pictures while sending a picture.
LLTo save the received picture onto the microSD card,
push [QUICK], and then select “Save” on the RX PICT
HISTORY screen. (p. 14-7) Otherwise, the received
picture is not saved in the “Picture” folder on the card.

[MENU] > SET > SD Card > TX/RX Picture View
1.	 Push [MENU].
2.	 Select “SD Card” in the “SET” menu.
3.	 Select “TX/RX Picture View.”

4.	 Select a picture to view.

LLYou cannot view a picture if it is not in a supported
format (p. 14-2) or it is corrupted.
LLTo exit the MENU screen, push [MENU].

TIP: In the Quick Menu window, you can select the
following options.
•• File Information: Displays the file name, size, and
saved date.
•• Delete:		Deletes the selected picture.
•• Delete All:
Deletes all pictures.
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OTHER FUNCTIONS

NOTE: See the Basic manual
Section 6 for details on how to
insert or remove a microSD card
and precautions.

Band Scope function����������������������������������������������������������������������������15-2
DD Using the Band Scope function����������������������������������������������������������������15-3
DD Using the Waterfall display�����������������������������������������������������������������������15-3

Home Channel function������������������������������������������������������������������������15-4

DD Setting a Home Channel��������������������������������������������������������������������������15-4
DD Home CH Beep function���������������������������������������������������������������������������15-4

Using the DTMF memory���������������������������������������������������������������������15-5

DD Entering DTMF code��������������������������������������������������������������������������������15-5
DD Monitoring the entered DTMF code����������������������������������������������������������15-5

Transmitting the DTMF code����������������������������������������������������������������15-6

DD Transmitting the entered DTMF code�������������������������������������������������������15-6
DD Transmitting a DTMF code (Direct Input)�������������������������������������������������15-6
DD Selecting the DTMF transmit speed���������������������������������������������������������15-7

Tone squelch operation������������������������������������������������������������������������15-8
DTCS code squelch operation�������������������������������������������������������������15-9
VOX function��������������������������������������������������������������������������������������15-10

DD Selecting the headset type���������������������������������������������������������������������15-10
DD Using the VOX function�������������������������������������������������������������������������� 15-11
DD Setting the VOX level����������������������������������������������������������������������������� 15-11
DD VOX-related settings������������������������������������������������������������������������������15-12

Weather channel operation (USA version only)����������������������������������15-13

DD Selecting a Weather channel�����������������������������������������������������������������15-13
DD Weather alert function����������������������������������������������������������������������������15-13

Screen Capture function���������������������������������������������������������������������15-14
DD Setting the Screen Capture function������������������������������������������������������15-14
DD Capturing a screen���������������������������������������������������������������������������������15-14
DD Viewing the captured screen������������������������������������������������������������������15-14

Setting the Opening picture����������������������������������������������������������������15-15
Cloning�����������������������������������������������������������������������������������������������15-16
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15 OTHER FUNCTIONS
Band Scope function
You can select the Band Scope display mode from
three modes, the Center mode, the FIX mode, and the
Scroll (FIX) mode.

Use the Band Scope function to visually search a
specified frequency range around the displayed
frequency. You can use this function to search for a
signal, and see the relative received signal strength
level.
On the single band display, you can confirm the signal
strengths over time by the waterfall function.
On the single band display within 137 ~ 174 MHz
and 375 ~ 479 MHz, you can hear the displayed
frequency’s audio during a sweep.

Center mode
Displays signals around the operating frequency
within the selected span.

The Band Scope function has 2 sweep types.
•• Single Sweep:	Searches the specified
frequency range only once.
The Single Sweep starts from
the lower frequency, and the
sweep stops after reaching the
upper frequency.
•• Continuous Sweep:	Repeatedly searches the
specified frequency range.

FIX mode
Displays signals within a specified frequency range.

LLSet the displayed frequency range on the MENU screen.
(p. 12-7)
([MENU] > SET > Scope > FIX Mode Center Frequency)

The transceiver’s sweep bandwidth is ± 15* × the
tuning step number, centered on the operating
frequency.

* You can change the displayed steps to ± 20 steps.
([MENU] > SET > Scope > Displayed Steps)

Edge
(Lower frequency)

During a sweep in the Center mode
Center frequency
(Example: 146.010 MHz)

Band Scope
display

Sweep marker

Weak level

Operating frequency
(moves)

When the operating frequency moves
outside the upper or lower Edge frequency,
“” or “” is displayed in the upper side
corners of the Band Scope screen.

When selecting a
Band Scope zone
(with a line in orange)

Strong level

Edge
(Upper frequency)

Mode icon
(FIX mode)

Scroll (FIX) mode
Displays signals within a specified frequency range.
When the operating frequency moves outside of the
screen, the displayed frequency range is automatically
shifted.
LLSet the displayed frequency range on the MENU screen.
(p. 12-7)
([MENU] > SET > Scope > FIX Mode Center Frequency)

While stopping a sweep

Mode icon
(Scroll (FIX) mode)
Operating frequency (moves)
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Operating frequency (moves)

15 OTHER FUNCTIONS
Band Scope function

DUsing
D
the Waterfall display

NOTE: During the continuous sweep, the noise may
occur if you bring your hand or body close to the
screen.

On the single band display, you can turn the waterfall
display ON or OFF.

DUsing
D
the Band Scope function
[MENU] > SCOPE
1.	 Push [MENU].
2.	 Select “SCOPE.”

When selecting a
Band Scope zone
(with a line in orange)

Waterfall
zone
Scale

Scale

LLInformation
3.	 Push [QUICK].
4.	 Select “Scope Mode.”

•• Higher signal levels are Red, Yellow, Green, Light-blue,
Blue, and Black (no signal), in that order.
•• During a sweep, the scales on both sides of the waterfall
zone are moved with the waterfall. While stopping a
sweep, the scales and the waterfall also freeze.
•• You can select the Waterfall speed.
([MENU] > SET > Scope > Waterfall Speed)

5.	 Select the Band Scope display mode.

TIP:

•• Returns to the standby screen, and starts the
continuous sweep.

•• If the tuning step is set too wide, the signals in the
sweep range may not be displayed (they may be
skipped), even if they are strong signals. Therefore,
we recommend that you set the tuning step to 20 kHz
or less to use the Band Scope function. See the Basic
manual Section 3 for details on how to set the tuning
step.
•• On the AIR band, you cannot hear the displayed
frequency’s audio during a sweep. When “AF Output
(DUAL/AIR Band)” is set to ON, the received audio is
momentarily output during a sweep, and you will know
that a signal is received without looking at the display.
- You can turn “AF Output (DUAL/AIR Band)” ON or
OFF on the MENU screen. (p. 12-30)
-T
 he FM Radio audio output may be interrupted due to
the AF Output (DUAL/AIR Band) function. In that case,
set “AF Output (DUAL/AIR Band)” to OFF, or set “Auto
Mute” to OFF.
([MENU] > SET > Scope > AF Output (DUAL/AIR Band))
([MENU] > FM RADIO > FM Radio Set > Auto Mute)

•• Displays the selected display mode, and starts the
continuous sweep.

6.	 Push [ENT].

•• Stops the sweep.
LLPush [ENT] again, to resume the sweep for the
Continuous Sweep function.

7.	 When the sweeping stops, rotate [DIAL] to move
the sweep marker to a detected signal.

•• You can hear the signal audio.
LLWhile the sweep is paused, push [CLR] to turn OFF
the Band Scope function.

Band Scope screen operation
Key
[DIAL]

Action
Rotate to select an operating frequency.

D-pad()

Push to cancel the Band Scope zone
selection.

D-pad()

Push to select the Band Scope zone (with a
line in orange).

[ENT]

Push to start or stop a sweep.

[QUICK]

Push to open the Quick Menu window.
LLWhen selecting the Band Scope zone,
only the Band Scope menu is displayed.

[CLR]

When selecting the Band Scope zone:
•• Push to stop the sweep during a sweep.
•• Push to turn OFF the Band Scope
function while stopping a sweep.
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15 OTHER FUNCTIONS
Home Channel function
You can set an often-used frequency, Memory
channel, or repeater as a Home Channel in VFO
mode, Memory mode, and DR screen.

DSetting
D
a Home Channel

DHome
D
CH Beep function

1.	 Select the VFO or Memory mode, or the DR
screen to set a Home Channel.
2.	 Select a frequency, Memory channel, or an access
repeater to be set as a Home Channel.
3.	 Push [QUICK].
4.	 Select “Home CH Set.”

When a Home CH is selected by rotating [DIAL], a
beep sounds. You will know the Home CH selection
without looking at the display.

Beep

5.	 Select “Set Frequency” (VFO mode), “Set
Channel” (Memory mode), or “Set Repeater” (DR
screen).

You can assign the [Home CH] key function to
an optional microphone key or optional Bluetooth
headset. (pp. 12-18, 12-34)

LLYou can turn OFF the Home CH Beep function on the
MENU screen.
([MENU] > SET > Sounds > Home CH Beep)

•• Sets a Home Channel, then returns to the standby
screen.

TIP: Selecting “Clear” in Step 4 clears the Home
channel setting.
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Using the DTMF memory
The transceiver can save up to 16 memories of a 24
digit DTMF code.

DEntering
D
DTMF code

DMonitoring
D
the entered DTMF code

You can check and hear the entered DTMF code.

[MENU] > SET > DTMF/T-CALL > DTMF Memory

[MENU] > SET > DTMF/T-CALL > DTMF Memory

1.	 Push [MENU].
2.	 Select “DTMF/T-CALL” in the “SET” menu.
3.	 Select “DTMF Memory.”

1.	
2.	
3.	
4.	

Push [MENU].
Select “DTMF/T-CALL” in the “SET” menu.
Select “DTMF Memory.”
Select a DTMF Memory to monitor.

4.	 Select a DTMF Memory to enter.
LLDO NOT push [ENT].

5.	 Push [SQL].

LLDO NOT push [ENT].

5.	 Push [QUICK].
6.	 Select “Edit.”

•• The DTMF code sounds.
•• After sounding, returns to the DTMF MEMORY
screen.
LLTo exit the MENU screen, push [MENU].

TIP: You can also check the DTMF code by pushing
[QUICK] and select “DTMF Monitor” on the DTMF
MEMORY screen in step 4.

7.	 Enter a DTMF code, then push [ENT].
(Example: 123456A)

•• Saves the Memory, and returns to the DTMF
MEMORY screen.
LLSee page iii on how to enter characters.
LLTo exit the MENU screen, push [MENU].

TIP: To clear the entered DTMF code, push [QUICK]
on the DTMF MEMORY screen, then select “Clear.”
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Transmitting the DTMF code
DTransmitting
D
the entered DTMF code

DDTransmitting a DTMF code (Direct Input)
1.	 Push [QUICK].
2.	 Select “DTMF TX.”

[MENU] > SET > DTMF/T-CALL > DTMF Memory
1.	 Push [MENU].
2.	 Select “DTMF/T-CALL” in the “SET” menu.
3.	 Select “DTMF Memory.”

3.	 Select “Direct Input.”
4.	 Select a DTMF Memory to transmit.

4.	 Enter a DTMF code, then push [ENT].
(Example: 012345#)
•• The selected DTMF channel is set to transmit.

5.	 Push [MENU].

•• Exits the MENU screen.

6.	 While holding down [PTT], push [SQL].

•• Transmits the entered DTMF code.
LLThe DTMF code scrolls during transmission.
LLSee page iii on how to enter characters.
•• The selected DTMF code in step 4 is transmitted.
•• Even if you release [PTT], the transceiver keeps
transmitting the code until all the code is transmitted.

TIP: About the 1750 Hz tone
When you select “T-CALL” on the DTMF MEMORY
screen, a 1750 Hz tone can be transmitted.

TIP: In the standby screen, you can transmit a
DTMF code by pushing [QUICK], selecting “DTMF
TX,” and selecting a code.

While holding down [PTT], push [SQL].

•• The 1750 Hz tone is transmitted.
LLYou can hear the 1750 Hz tone from a speaker.
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15 OTHER FUNCTIONS
Transmitting the DTMF code

DSelecting
D
the DTMF transmit speed
You can select the DTMF transmit speed.

The image of transmitting the DTMF code

[MENU] > SET > DTMF/T-CALL > DTMF Speed
1.	 Push [MENU].
2.	 Select “DTMF/T-CALL” in the “SET” menu.
3.	 Select “DTMF Speed.”

Pi, Po, Pa
When “100ms” is selected,
the DTMF transmit speed
is fast.

4.	 Select a transmit speed. (Default: 100ms)

LLTo exit the MENU screen, push [MENU].
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Pi–, Po–, Pa–
When “500ms” is selected,
the DTMF transmit speed
is slow.

15 OTHER FUNCTIONS
Tone squelch operation
Step 2. Using the tone squelch
1.	 Push [QUICK].
2.	 Select “TONE.”

The tone squelch opens only when you receive a
signal that includes a matching subaudible tone in the
FM or FM narrow (FM-N) mode. You can silently wait
for calls from other stations using the same tone.
Also, the reversed tone squelch function mutes
the squelch when a signal including a matching
subaudible tone.
Step 1. Setting the tone squelch frequency
[MENU] > SET > DUP/TONE... > TSQL Freq
1.	
2.	
3.	
4.	
5.	
6.	

3.	 Select the Tone Squelch type.

Push [VFO/MHz] to enter the VFO mode.
Push [MODE] to select the FM or FM-N mode.
Rotate [DIAL] to set an operating frequency.
Push [MENU].
Select “DUP/TONE...” in the “SET” menu.
Select “TSQL Freq.”

7.	 Rotate [DIAL] to set a Tone Squelch frequency,
then push [ENT].
4.	 Operate normally.

•• You will only hear the audio of stations that are using
the same Tone Squelch frequency. All other signals
will be muted.

LLSet to between 67.0 and 254.1 Hz.
LLTo exit the MENU screen, push [MENU].

About the Tone squelch types indication

•• TSQL: Enables the Tone Squelch function.
•• TSQL-R:	Enables the Reverse Tone Squelch function.
•• TONE(T)/DTCS(R)
(“T-DTCS” is displayed, “T” blinks.):
	When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the DTCS squelch opens
only for a signal that includes a matching
DTCS code and polarity. (Audio is heard)
•• DTCS(T)/TSQL(R)
(“D-TSQL” is displayed, “D” blinks.):
	When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching tone
frequency. (Audio is heard)
•• TONE(T)/TSQL(R)
(“T-TSQL” is displayed, “T” blinks.):
	When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching tone
frequency. (Audio is heard)
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DTCS code squelch operation
Step 2. Using the DTCS code squelch
1.	 Push [QUICK].
2.	 Select “TONE.”

The tone squelch opens only when you receive a
signal that includes a matching DTCS code in the
FM or FM narrow (FM-N) mode. You can silently
wait for calls from others using the same tone. Also,
a reversed tone squelch function mutes the squelch
when you receive a signal including a matching DTCS
code.
Step 1. Setting the DTCS code
[MENU] > SET > DUP/TONE... > DTCS Code
1.	
2.	
3.	
4.	
5.	
6.	

3.	 Select the DTCS code type.

Push [VFO/MHz] to enter the VFO mode.
Push [MODE] to select the FM or FM-N mode.
Rotate [DIAL] to set an operating frequency.
Push [MENU].
Select “DUP/TONE...” in the “SET” menu.
Select “DTCS Code.”

7.	 Rotate [DIAL] to set a DTCS code, then push
[ENT].
4.	 Operate normally.

•• You will only hear the audio of stations that are using
the same DTCS code. All other signals will be muted.

About the DTCS code types indication

•• DTCS: Enables the DTCS Squelch function.
•• DTCS-R:	Enables the Reverse DTCS Squelch function.
•• DTCS(T) (“DTCS” blinks):
	When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the function is OFF.
•• TONE(T)/DTCS(R)
(“T-DTCS” is displayed, “T” blinks.):
	When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the DTCS squelch opens
only for a signal that includes a matching
DTCS code and polarity. (Audio is heard)
•• DTCS(T)/TSQL(R)
(“D-TSQL” is displayed, “D” blinks.):
	When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching tone
frequency. (Audio is heard)

LLSet to between 023 and 754.
LLTo exit the MENU screen, push [MENU].
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VOX function
The Voice Operated eXchange (VOX) function toggles
the transceiver between transmit and receive by your
voice. This function provides hands-free operation.
You can use the VOX function with the optional
HS-94, HS-95, or HS-97 headset and the
OPC-2006LS plug adapter cable.

NOTE: BE SURE to turn OFF the transceiver when
plugging or unplugging the OPC-2006LS into or from
the [MIC/SP] jack.
TIP: You can also use the VOX function with the
Bluetooth headset.

([MENU] > SET > Bluetooth Set > Headset Set > VOX)

See page 13-5 for details.

DSelecting
D
the headset type
[MENU] > SET > Function > VOX > Headset Select

ID-52A/E

1.	 Push [MENU].
2.	 Select “Function” in the “SET” menu.
3.	 Select “VOX.”

OPC-2006LS
(Option)

To the
[MIC/SP] jack

HS-94*
(Option)

* You can also use this function with the optional HS-95 or HS-97.

4.	 Select “Headset Select.”

5.	 Select an option.

•• HS-95: Select when using the HS-95.
•• Other: Select when using the HS-94 or the HS-97.

LLTo exit the MENU screen, push [MENU].
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VOX function

DUsing
D
the VOX function

DSetting
D
the VOX level

[MENU] > SET > Function > VOX > VOX

NOTE: We recommend you set the Microphone
Gain level to 3, before setting the VOX level.
([MENU] > SET > Function > MIC Gain (External))

1.	 Push [MENU].
2.	 Select “Function” in the “SET” menu.
3.	 Select “VOX.”

[MENU] > SET > Function > VOX > VOX Level
1.	 Push [MENU].
2.	 Select “Function” in the “SET” menu.
3.	 Select “VOX.”

4.	 Select “VOX.”

4.	 Select “VOX Level.”

5.	 Select “ON.”

5.	 While speaking into the microphone, rotate [DIAL]
to adjust the VOX level.
6.	 To exit the MENU screen, push [MENU].

•• Displays “VOX” when the TX level audio is input.
LLThe VOX level can be adjusted between 1 (minimum)
and 10 (maximum), or turned OFF. (Default: 5)
LLHigher values make the VOX function more sensitive
to your voice.

•• When you connect the HS-94, HS-95, or HS-97
headset, “VOX” is displayed on the standby screen.

6.	 To exit the MENU screen, push [MENU].

LLIf the S-meter does not display the output power
level, and the transceiver does not transmit, adjust
the VOX delay time.
([MENU] > SET > Function > VOX > VOX Delay)
LLWhen the VOX function is ON, you can adjust the
VOX level by rotating [DIAL] while transmitting.

NOTE: While receiving a signal, or sounding a beep,
the transceiver does not switch to transmit by your
voice.

15-11

15 OTHER FUNCTIONS
VOX function

DVOX-related
D
settings

You can set the “VOX Delay” and “VOX Time-Out
Timer” on the MENU screen.
VOX Delay
[MENU] > SET > Function > VOX > VOX Delay
The VOX delay is the amount of time the transmitter
stays ON after you stop speaking. It enables normal
pauses in speaking. (p. 12-22)

VOX Time-Out Timer
[MENU] > SET > Function > VOX >
VOX Time-Out Timer
The VOX Time-Out Timer prevents prolonged
accidental transmission. (p. 12-22)
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Weather channel operation (USA version only)
DWeather
D
alert function

There are 10 weather channels for monitoring
the National Oceanographic and Atmospheric
Administration (NOAA) weather broadcasts.

NOAA broadcast stations transmit weather alert tones
before important weather announcements.
When the weather alert function is turned ON, the
selected weather channel is monitored every 5
seconds for an announcement.
When an alert signal is detected, the “ALT” and
the WX channel are alternately displayed, and a
beep sounds until you change the mode or weather
channel, turn OFF the Weather Alert function, or turn
OFF the transceiver.
The previously selected (used) weather channel
is checked periodically during standby, or while
scanning.

DSelecting
D
a Weather channel

1.	 Push [MR] to enter the Weather Channel mode.
LLPushing [MR] each time selects the Memory and
Weather Channel modes.

		

1.	 Push [QUICK].
2.	 Select “Weather Alert.”

2.	 Rotate [DIAL] to select a weather channel.

•• Displays the selected weather channel number
(“WX-01” ~ “WX-10”).

3.	 Select “ON.”

•• Turns ON the Weather Alert function, and “WX” is
displayed.

15-13

15 OTHER FUNCTIONS
Screen Capture function
DViewing
D
the captured screen

You can capture the transceiver display onto a
microSD card. Most of the screens used in this
manual are captured using this function.
However, some displays cannot be captured.

[MENU] > SET > SD Card > Screen Capture View
1.	 Push [MENU].
2.	 Select “SD Card” in the “SET” menu.
3.	 Select “Screen Capture View.”

DSetting
D
the Screen Capture function
[MENU] > SET > Function >
Screen Capture [PWR] Key
1.	 Push [MENU].
2.	 Select “Function” in the “SET” menu.
3.	 Select “Screen Capture [PWR] Key.”

•• The capture list is displayed.
•• The latest screen capture is at the bottom of the list.

4.	 Select the desired screen capture to display it.

4.	 Select “ON.”
•• The screen capture is displayed.
LLWhile a screen capture is displayed, you can scroll
through all the screen captures by rotating [DIAL].
LLTo exit the MENU screen, push [MENU].
LLTo exit the MENU screen, push [MENU].

Checking the file information and deleting a file
1.	 Select the screen capture that you want to view
or delete.

DCapturing
D
a screen

LLDO NOT push [ENT].

1.	 Display the desired screen to capture.
2.	 Push [ ] to capture the screen.

2.	 Push [QUICK].
3.	 Select an item from “File Information,” “Delete,”
and “Delete All.”

•• The captured screen is saved onto the card.

[ ]

•• File Information: Displays the file name, size,
and date of the selected screen
capture.
•• Delete:
Deletes the selected file.
•• Delete All:
Deletes all files.
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Setting the Opening picture
Step 2. Setting the displayed picture
(Transceiver)

You can set a picture that is displayed at power ON.
NOTE: To set the displayed picture, a microSD card
(user supplied) is required.

[MENU] > SET > SD Card > Opening Picture
1.	 Push [MENU].
2.	 Select “SD Card” in the “SET” menu.
3.	 Select “Opening Picture.”

About a picture file to use
•• File type:	24 bit bitmap
(The file extension is “bmp.”)
•• Picture size: 320 x 280 (px)
•• File name:	Up to 23 characters
(except the filename extension)
Step 1. Saving a picture on the microSD card
(PC)
1.	 Copy a picture file into the “OpeningPicture” folder
(“ID-52” > “OpeningPicture”) on the microSD card.

4.	 Select a picture to display.

LLSee page 2-5 for detail.

2.	 Insert the microSD card into the transceiver.

•• The selected picture is displayed.

5.	 Push [ENT].

LLTo select the picture again, push [CLR].
•• The confirmation dialog is displayed.

6.	 Select “YES.”

•• The transceiver will automatically restart, and the
selected picture is displayed.

To hide the picture at power ON
Select “<<Cancel Opening Picture Setting>>” in step 4.

LLThe selected picture can be displayed even if:
•• No microSD card is inserted.
•• You do a Partial Reset or All Reset.
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Cloning
The transceiver has a data cloning capability. This
function is useful when you want to copy all of the
settings and entered contents from one
ID-52A/ID-52E to another. This section describes the
cloning method using a microSD card.

LLRecorded voice memories are not included in the cloning
data. To play back the master transceiver’s voice memory,
insert the microSD card into a sub transceiver, or make a
copy onto the sub transceiver’s microSD card using a PC.
LLAssumes that the microSD card has already been
inserted into the transceiver.

Step 1. S
 aving the master transceiver’s setting
data onto the microSD card.

Step 2. Remove the microSD card from the master
transceiver, then insert it into the sub
transceiver.
1.	 Turn OFF the master transceiver.
2.	 Remove the microSD card from the master
transceiver.
3.	 Insert the card into the sub transceiver, then turn
ON the sub transceiver.

[MENU] > SET > SD Card > Save Setting
1.	 Push [MENU].
2.	 Select “SD Card” in the “SET” menu.
3.	 Select “Save Setting.”

Master

Sub

4.	 Select “<<New File>>.”
NOTE:

•• Turn OFF the transceiver before you insert or remove
the microSD card.
•• DO NOT turn OFF the transceiver while saving or
loading the setting data. Otherwise, the data may be
corrupted or deleted.

TIP: The setting data is saved in the “icf” file format
that is used in the CS-52 programming software.
When the saved data on a card is copied to a PC,
you can edit it with the programming software.
For details, refer to the CS-52 instructions that can
be downloaded from the Icom website.
(Continue the steps on the next page.)

LLThe file name is automatically set in the following
format: Setyyyymmdd_xx
(yyyy: Year, mm: month, dd: day, xx: serial number).

5.	 Push [ENT] to save the file with the displayed name.
•• The confirmation dialog is displayed.

6.	 Select “YES.”

•• While saving, a progress bar is displayed, then
returns to the SD CARD screen after the saving is
completed.
LLTo exit the MENU screen, push [MENU].
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Cloning
Step 3. L
 oading the setting data into the sub
transceiver.
[MENU] > SET > SD Card > Load Setting
7.	 Select “YES.”

1.	 Push [MENU].
2.	 Select “SD Card” in the “SET” menu.
3.	 Select “Load Setting.”

•• Starts checking and loading the data file.
•• After loading, “COMPLETED!” is displayed.

8.	 Restart the transceiver to operate with the new
setting.

4.	 Select a data file to load into the transceiver.

5.	 Select the loading content.

•• ALL:
Loads all Memory channels, settings on the MENU
screen, and the Repeater List into the transceiver.
•• Except My Station:
Loads all Memory channels, setting on the MENU
screen except MY call signs, and the Repeater List
into the transceiver.
•• Repeater List Only:
Loads only the Repeater List into the transceiver.

6.	 Select “YES” or “NO.”

•• YES:
The skip settings of the Repeater List are retained.
(p. 5-39)
•• NO:
The skip settings of the Repeater List are cleared.
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Resetting
Occasionally, erroneous information may be
displayed. This may be caused by static electricity or
by other factors.
If this problem occurs, turn OFF the transceiver. After
waiting a few seconds, turn ON the transceiver again.
If the problem still exists, perform a Partial reset.
If the problem still exists after performing a Partial
reset, perform an All reset.

NOTE for the All reset: After performing an All
reset, you cannot use the DR function because
the Repeater List contents are also cleared. We
recommend you save the setting data onto a
microSD card, or to your PC using the CS-52
programming software before performing an All
reset. After the All reset is finished, load or write the
saved data into your transceiver.

DPartial
D
Reset

DAll
D Reset

A Partial Reset resets the operating settings to their
defaults without clearing the following:

An All reset clears all data and returns all settings to
their factory defaults. Memory channel contents, filter
settings, and so on will all be cleared, so you will need
to rewrite your operating settings unless you have a
backup.

•• Memory Channel contents
•• Call Channel contents
•• Radio Memory contents
•• Scan Edge contents
•• Message data
•• GPS memory contents
•• Call sign memories
•• DTMF memory contents
•• Repeater list
•• Bluetooth pairing list
•• Opening picture

LLThe Bluetooth pairing list and opening picture are not
deleted.

[MENU] > SET > Others > Reset > All Reset
1.	 Push [MENU].
2.	 Select “Others” in the “SET” menu.
3.	 Select “Reset.”

[MENU] > SET > Others > Reset > Partial Reset
1.	 Push [MENU].
2.	 Select “Others” in the “SET” menu.
3.	 Select “Reset.”
4.	 Select “All Reset.”

4.	 Select “Partial Reset.”
•• The confirmation dialog is displayed.

5.	 Select “YES.”

•• The confirmation dialog is displayed.

5.	 Select “YES.”

•• “ALL RESET” is displayed, and then the display
automatically returns to the default screen.

•• “PARTIAL RESET” is displayed, and then the display
automatically returns to the default screen.
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16 UPDATING THE FIRMWARE
General
DAbout
D
updating the firmware

DChecking
D
the firmware version

You can update the ID-52A/E’s firmware using a
microSD card. Updating the firmware adds new
functions and/or improves performance parameters.
You can download the latest firmware from the Icom
website.
https://www.icomjapan.com/support/

Check the firmware version on the VERSION screen.
[MENU] > SET > Others > Information > Version
1.	 Push [MENU].
2.	 Select “Others” in the “SET” menu.
3.	 Select “Information.”

IMPORTANT: To update the firmware, first format
your microSD card using the ID-52A/E.
Then copy the downloaded firmware data from your
PC into the “ID-52” folder on the card.
4.	 Select “Version.”

•• The VERSION screen is displayed.
LLTo exit the VERSION screen, push [MENU].

TIP: You can also check the firmware version when
you turn ON the transceiver.

The firmware version is displayed.

16-2

16 UPDATING THE FIRMWARE
General

DPreparation
D

6.	 Select the location where you want to save the
firmware, and then click [Save] in the displayed
File Download dialog.

Access the following URL and download the firmware
file.
https://www.icomjapan.com/support/

LLThese instructions are based on Microsoft® Windows® 10.

1.	 Click the “Firmware/Software” link.
Click

2.	 Enter “ID-52” into the Search box, and then click
[Search].
1 Enter

Click

2 Click

•• The file starts downloading.
•• The firmware and the firm utility are compressed in a
“zip” format folder. Unzip it before use.

3.	 Click the desired firmware file link.
4.	 Carefully read “Regarding this Download Service.”
Click “Agree,” and then click [Download].

DUnzipping
D
the firmware folder

1.	 Right-click the downloaded firmware folder (zip
format).
•• The right-click menu is displayed.

1 Click
2 Click

2.	 Click “Extract All...”

Click

5.	 Click “Save as” in the displayed File Download
dialog.

•• After unzipping, a folder is created in the same
location as the downloaded folder.
LLIn the “52*” folder, “52*.dat” is created.
* Represents the release number.
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Updating the firmware
5.	 After you read and agree with all the precautions,
select “YES.”

CAUTION: NEVER turn OFF the transceiver
while updating the firmware. If you turn OFF the
transceiver, or if a power failure occurs while
updating, the transceiver firmware may be damaged,
and, if so, you will have to send the transceiver back
to the nearest Icom distributor for repair. This type
of repair is out of warranty, even if the transceiver
warranty period is still valid.
Recommendation!
Fully charging of battery pack before starting the
firmware update is strongly recommended.
This is to avoid failure during the update, caused by
an unexpected power failure.
TIP: BE SURE to unzip the downloaded file.
See the previous page for details.

•• Scroll the screen and read all the precautions.
•• The confirmation dialog is displayed.
When you select “YES,” the backup file is made on
the microSD card, and then the Firmware selection
screen is displayed.

1.	 Copy the downloaded firmware data into the
“ID-52” folder on to a microSD card.

6.	 Select the Firmware (Example: 52*).
* Represents the release number.

•• The final confirmation screen is displayed.
LLCarefully read all the displayed precautions.

7.	 After you read and agree with all the precautions,
select “YES.”
Copy
2.	 Insert the microSD card into the transceiver.
3.	 Display the SD CARD screen.
[MENU] > SET > SD Card
4.	 Select “Firmware Update.”

•• The updating starts.

8.	 When the update is completed, “Firmware
updating has completed.” is displayed in the
dialog.

•• The transceiver will automatically restart.
LLAfter the updating finishes, the operating screen is
displayed.

TIP: When “USB Connect” is set to “SD Card Mode,”
and the transceiver is connected to the PC through a
USB data cable, you can directly access the microSD
card that is set in the transceiver from the PC.
([MENU] > SET > Function > USB Connect)
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17 OPTIONS
Option list
You can find information for these options on the Icom
website.
https://www.icomjapan.com/support/

Speaker microphones
HM-75LS remote control speaker microphone

LLSome options may not be available, depending on the
transceiver version.

HM-183LS speaker microphone

Meets IPX7 requirements for waterproof protection
(1 meter, 3.3 ft depth for 30 minutes).

HM-186LS speaker microphone

Batteries/Chargers

Meets IPX4 requirements for waterproof protection
(Splashing water from any direction).

BC-167SA/BC-167SD battery charger

The same as supplied.
The shape may be different, depending on the charger
version.

Cables

BC-202IP2 rapid charger
+ BC-123SA/BC-123SE (L-shaped type plug)
ac adapter

CP-12L cigarette lighter cable
With noise filter.
Fuse Coding:
FUSE 125V 3A
Fuse Voltage Rating: 125 Volts
Fuse Current Rating: 3 Amperes

BC-202IP3L rapid charger
+ BC-123SA/BC-123SE (Straight type plug)
ac adapter (For single unit)
+ BC-228 ac adapter (For multiple units)

OPC-254L dc power cable

Directly connects to a DC power source.
Fuse Coding:
FUSE 250V 3A
Fuse Voltage Rating: 250 Volts
Fuse Current Rating: 3 Amperes

BP-271 Li-ion battery pack

Voltage:
7.4 V
Discharge capacity: 1150 mAh (minimum), 1200 mAh (typical)
Battery life:
Approximately 4.25 hours (FM)

CP-23L cigarette lighter cable

BP-272 Li-ion battery pack

For BC-202IP2, 12 V
LLYou cannot connect to the transceiver’s [DC IN] jack.

The same as supplied.
Voltage:
7.4 V
Discharge capacity: 1880 mAh (minimum), 2000 mAh (typical)
Battery life:
Approximately 7.25 hours (FM)

OPC-515L dc power cable

For BC-202IP2
LLYou cannot connect to the transceiver’s [DC IN] jack.

BP-273 battery case

CP-25H cigarette lighter cable

Uses 3 LR6 (AA) alkaline batteries.

For BC-202IP3L, 12 V
LLYou cannot connect to the transceiver’s [DC IN] jack.

BP-307 Li-ion battery pack

Voltage:
7.2 V
Discharge capacity:	3050 mAh (minimum), 3150 mAh (typical)
Battery life:	Approximately 12 hours (FM)

OPC-2417 data cable (USB micro-B/USB micro-B)
OPC-2418 data cable (USB micro-B/USB Type-C)

Headsets/Earphones

Others

HS-94/HS-95/HS-97 headset
+ OPC-2006LS plug adapter cable

AD-92SMA antenna connector adapter

Connects an antenna or antenna cable that has a BNC
connector.

HS-94:		
Ear hook type
HS-95:		
Neck and arm type
HS-97		
Throat microphone
OPC-2006LS:	Connects the HS-94/HS-95/HS-97 to the
transceiver for the VOX function.

FA-S270C vhf/uhf antenna
The same as supplied.

LC-193 carrying case

HM-153LS earphone microphone

LLYou cannot use when the BP-307 is attached to the
transceiver.

HM-166LS earphone microphone
Smaller than the HM-153LS.

MB-127 belt clip

SP-40 earphone
+ OPC-2144 plug adapter cable

VS-3 Bluetooth® headset

The same as supplied.

When using the SP-40, you need the OPC-2144 slim L type
conversion cable.
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Option List
About the free download software
CS-52
RS-MS1A (For Android devices)
RS-MS1I (For iOS™ devices)
RS-MS3A (For Android devices)
RS-MS3W (For Windows)
ST-4001A (For Android devices)
ST-4001I (For iOS devices)
ST-4001W (For Windows)

programming software
Android application
iOS™ application
terminal mode/access point mode software
terminal mode/access point mode software
picture utility software
picture utility software
picture utility software

You can download each manual and guide from the Icom website.
https://www.icomjapan.com/support/

LLBefore using, read each manual and guide, and use it according to the instructions.
To add or expand a function, or to improve the performance, the software version may be upgraded.
Before you update your software version, see the instructions and cautions described on the Icom website.
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Optional HM-75LS remote control speaker microphone
The optional HM-75LS enables you to remotely select
operating frequencies, Memory channels, and other
functions.
You can assign some functions to the keys on the
HM-75LS for simple remote control operation.
(p. 12-18)

[A] []

Microphone
TX indicator
[PTT]

The HM-75LS has a lock switch on the back to
prevent accidental frequency changes.

A
A
B

Speaker

B

[B] []

NOTE:

•• BE SURE to turn OFF the transceiver when plugging or
unplugging the HM-75LS into or from the [MIC/SP] jack.
•• Firmly plug the HM-75LS into the transceiver.

OFF

ON
LOCK

Lock switch

DAssigning
D
a Remote Control function

Earphone jack

Example: Assigning the “TO (DR)” function to the [A]
key.
[MENU] > SET > Function > Remote MIC Key
1.	 Push [MENU].
2.	 Select “Function” in the “SET” menu.
3.	 Select “Remote MIC Key.”

6.	 Select “TO (DR).”

4.	 Select “During RX/Standby.”

•• The “TO (DR)” function is assigned.
LLTo exit the MENU screen, push [MENU].

5.	 Select “[A].”

TIP: To return to the default settings

•• On the “During RX/Standby” screen or “During TX”
screen, push [QUICK] and select “Default All.”
•• On the each key screen, push [QUICK] and select
“Default.”

•• The Assignable function list is displayed.
LLAbout the functions, see pages 12-19 and 12-20.
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When using an application
The following applications are compatible with the Android or iOS device.
See each application’s manual for details.
Download the applications from your device.

DAbout
D
compatible applications

The following applications are compatible with ID-52A/
ID-52E.
(As of November 2021)
Android device
RS-MS1A:	You can use the extended D-STAR
functions to exchange pictures or
messages or display the received
D-PRS station data on a map
application.
RS-MS3A:
You can use the DV Gateway function.
ST-4001A:	You can make an image to be used
for the Share Picture function, and
transfer it to the transceiver.

When using a USB cable
•• Android device
Android 5.0 or later with the USB host function.
•• Cable (purchase separately)
OPC-2417 data cable (USB micro-B/USB micro-B)
or
OPC-2418 data cable (USB micro-B/USB Type-C)
TIP: The USB host function is needed to use a USB
device with an Android device. To check whether or
not your Android device has the USB host system,
ask the Android device’s manufacturer.

iOS device
RS-MS1I:	You can use the extended D-STAR
functions to exchange pictures or
messages or display the received
D-PRS station data on a map
application.
ST-4001I:	You can make an image to be used
for the Share Picture function, and
transfer it to the transceiver.

When using the Bluetooth function
•• Android device or iOS device
Android 5.0 or later with the Bluetooth function.
or
iOS version 12 or later, iPadOS version 13 or later
with the Bluetooth function.

DRequired
D
items

LLWhen using the RS-MS3A, you cannot connect an
Android device to the transceiver through Bluetooth.

Android device
You can use the RS-MS1A/RS-MS3A/ST-4001A with
devices that have Android 5.0 or later installed.

NOTE: Some functions may not work correctly,

LLThe applications have been tested with the Android 5.x.x,
6.x.x, 7.x.x, 8.x.x, 9.0, and 10.0. (As of November 2021)

•• depending on other applications installed in the Android
device.
•• depending on the memory capacity.

iOS device
You can use the RS-MS1I/ST-4001I with devices that
have iOS version 12 or later, iPadOS version 13 or
later installed.
LLThe ST-4001I has been tested with iOS 12 and 13, and
iPadOS 13. (As of November 2021)

Disclaimer

•• The application may not work properly, depending on the
OS version, installed applications, or other reasons.
•• The indications or items may differ, depending on the OS
version or settings.
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When using an application

DDDownload procedures (Android device)

DWhen
D
using a USB cable

1.	 Turn ON your Android device.
2.	 Touch “Play Store.”
3.	 Enter the application’s name in the search field.

ID-52A/E
Android device
with the USB
host function

LLDo not abbreviate the application name to be sure to
find it.

4.	 Touch “

.”

•• The application’s name will be displayed as the
search result.
LLIf your Android device does not support the
application, its name may not appear on the search
result.

USB cable

To the [USB] port

5.	 Touch the application to install.

•• Displays the introduction screen of the application.

LLConnect the USB micro-B connector (for the OPC-2417:
with the white tube) to the transceiver and the other
connector to an Android device.

6.	 Touch <INSTALL>.

•• Installation starts.
•• After finishing the installation, the icon is displayed on
the screen.

NOTE:

DDownload
D
procedures (iOS device)

•• Turn OFF the transceiver before connecting or removing
the cable.
•• When an Android device is connected, the USB
connection indicator ( ) is displayed on the
transceiver. If the indicator is not displayed, enable your
Android device to detect the USB device.
LLNo operation is required on a mobile device that
support automatic detection of the USB devices.
•• When using RS-MS1A, confirm the following items are set.
([MENU] > SET > Function > CI-V)
Set “CI-V Address” to the value same as the RS-MS1A
side. (Default: A6)
LLRS-MS1A side: Application Settings → CI-V settings
(Default: Transceiver[A6])
Set “CI-V Transceive” to “ON.”

1.	 Turn ON your iOS device.
2.	 Touch “App Store.”
3.	 Enter the application’s name in the search field.

LLDo not abbreviate the application name to be sure to
find it.

4.	 Touch “

To a USB port

.”

•• The application’s name will be displayed as the
search result.
LLIf your iOS device does not support the application,
its name may not appear on the search result.

5.	 Touch the application to install.

•• Displays the introduction screen of the application.

6.	 Touch <GET>.

•• Installation starts.
•• After finishing the installation, the icon is displayed on
the screen.

([MENU] > SET > Function > USB Serialport Function)
Set “USB SerialPort Function” to “CI-V (Echo Back OFF).”
([MENU] > SET > Function > USB Connect)
Set “USB Connect” to “Serialport.”
•• When using Access Point mode, RS-MS1A cannot be
used.
•• Remove the USB cable when you do not use the cable.
Otherwise, the battery will be quickly exhausted.
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Connecting an Android™ device to the transceiver through Bluetooth®
Step 3. Sending a pairing request to the
transceiver
(Android device)
Select the displayed transceiver Bluetooth unit’s name
to send a pairing request.

Before connecting to an Android device, you must
pair with it. See the next page about connecting to
the transceiver with an Android device using the
RS-MS1A application.

•• The Android device starts to send a pairing request.
•• The Android device displays, “To pair with: ICOM
BT(ID-52). Make sure it is showing this passkey:
MMMMM.”

DPairing
D
with an Android device

This section describes how to pair with an Android
device.

Step 4. Receiving a pairing request (Transceiver)
1.	 When the transceiver receives a pairing request,
confirm the displayed passkey is the same as
yours, and then select “CONFIRM.”

NOTE: You may not be able to pair with it,
depending on the Bluetooth device.
Step 1. Entering the Pairing Reception mode
(Transceiver)
[MENU] > SET > Bluetooth Set >
<<Pairing Reception>>
1.	 Push [MENU].
2.	 Select “Bluetooth Set” in the “SET” menu.
3.	 Select “<<Pairing Reception>>.”

•• Pairing starts.

2.	 Select “Pairing/Connect.”

Turn ON Bluetooth with your Android device
within the displayed period.
When the time runs out, the transceiver exits
the Pairing Reception mode.
Step 2. Turning ON Bluetooth
(Android device)
Turn ON Bluetooth with your Android device.

Pairing list

•• The Android device displays the transceiver Bluetooth
unit’s name.
LLYou can confirm the transceiver Bluetooth unit’s name on
the BLUETOOTH DEVICE INFO screen.
(Default: ICOM BT(ID-52)) (p. 13-7)
LLSee the instruction manual of the Android device for
details.

After the pairing is complete, the
Android device name is displayed
on the pairing list.
NOTE: When you pair with a third party’s data
device, entering a PIN code or passkey may be
required. See the instruction manual of the data
device for details on how to enter a PIN code or
passkey.
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Connecting an Android™ device to the transceiver through Bluetooth®

DConnection
D

This section describes how to connect an Android
device to the transceiver, using the RS-MS1A
application.
Before connecting, pair the transceiver with the
Android device. (p. 17-7)

TIP: To connect to the Android device from the
transceiver
When the RS-MS1A is started on the Android device,
you can connect to the device from the transceiver.
[MENU] > SET > Bluetooth Set > Pairing/Connect

LLWhen using the ST-4001A application, the transceiver
and Android device are automatically connected while
transferring a picture.

1.	
2.	
3.	
4.	

Push [MENU].
Select “Bluetooth Set” in the SET menu.
Select “Pairing/Connect.”
Select the Android device name displayed in the
pairing list.
5.	 Select “YES.”
•• Displays “MMM Connecting...”
( “MMM” is the Bluetooth name of the Android

Step 1. Preparing for the connection (Transceiver)
[MENU] > SET > Function > CI-V > CI-V Transceive
Set “CI-V Transceive” to ON to control the transceiver
and the RS-MS1A with CI-V commands.
Step 2. Starting the RS-MS1A
Touch the RS-MS1A to start.

device.)
LLOn the PAIRING/CONNECT screen, “
displayed on the data device icon.

(Android device)

NOTE: If you cannot connect, check that the same
CI-V address is set in the transceiver and the RSMS1A.
You can see the CI-V setting as described below:
Transceiver
“CI-V Address” in the MENU screen.
([MENU] > SET > Function > CI-V > CI-V Address)
(Default: A6)
RS-MS1A:
“Application Settings” → “CI-V settings”
(Default: Transceiver[A6])

LLSee page 17-6 for details on downloading the RS-MS1A.

Step 3. C
 onnecting to the transceiver

(Android device)
Touch the transceiver’s Bluetooth unit name displayed
on the RS-MS1A.

•• Starts to connect.
LLWhen your call sign has not been entered in the
transceiver, you should enter it before you connect.
LLAfter the connection has been made, the transceiver
displays “MMM Connected.,” and the Bluetooth icon is
displayed.

Displayed

LLOn the PAIRING/CONNECT screen, “

” is

” is displayed.

Device name
Displayed while connecting
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Connecting an iOS device to the transceiver through Bluetooth®
Step 3. Sending a pairing request to the transceiver

(iOS device)
1.	 On the application, touch “Scan.”

Before connecting to an iOS device, you must pair with it.

DPairing
D
with an iOS device

This section describes how to pair with an iOS device.

•• For the RS-MS1I, the item is displayed in “Other” >
“Bluetooth Connection.”
•• For the ST-4001I, the item is displayed in “Transfer
Device List.”
(“...” > Transfer Settings > Using Bluetooth >
Transfer Device List)
•• The iOS device displays the transceiver Bluetooth
unit’s name.
LLYou can confirm the transceiver Bluetooth unit’s
name on the BLUETOOTH DEVICE INFO screen.
(Default: ICOM BT(ID-52)) (p. 13-7)

NOTE:

•• You cannot pair with an iOS device in its Settings app.
To pair with an iOS device, use Icom application.
•• You may not be able to pair with it, depending on the
Bluetooth device.

NOTE: When using the RS-MS1I
Before connecting, check that the following items are
correctly set.
•• Set “CI-V Transceive” to ON in the transceiver.
([MENU] > SET > Function > CI-V > CI-V Transceive)
•• Set the same CI-V address in the transceiver and the
RS-MS1I.
Transceiver:
“CI-V Address” in the MENU screen.
([MENU] > SET > Function > CI-V > CI-V Address)
(Default: A6)
RS-MS1I:
•• “Application Settings” → “Select the default”
(Default: Auto Select)
•• “Application Settings” → “CI-V address”
(Default: Auto Setting)

2.	 Select the displayed transceiver Bluetooth unit’s
name to send a pairing request.
•• The iOS device starts to send a pairing request.
•• After the pairing has succeeded, “Pairing is
complete.” is displayed.

About the transceiver’s display
After the connection has been made, the transceiver
displays “MMM Connected.” and the Bluetooth icon
is displayed.
(“MMM” is the Bluetooth name of the iOS device.)
Displayed

Step 1. Starting the application 
(iOS device)
1.	 Turn ON Bluetooth in your iOS device.
LLSee the instruction manual of the iOS device for details.

2.	 Touch the application’s icon to start.

Step 2. Entering the pairing reception mode
(Transceiver)

LLOn the PAIRING/CONNECT screen, “

[MENU] > SET > Bluetooth Set > <<Pairing Reception>>
1.	 Push [MENU].
2.	 Select “Bluetooth Set” in the “SET” menu.
3.	 Select “<<Pairing Reception>>.”
Device name
Displayed while connecting

Send a pairing request to the transceiver (step. 3) within the
displayed period. When the time runs out, the transceiver
exits the Pairing Reception mode.
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Connecting an iOS device to the transceiver through Bluetooth®

DConnection
D

This section describes how to connect to a paired
transceiver from an iOS device.
Before connecting, pair the transceiver with the iOS
device. (p. 17-7)

TIP: To connect to the iOS device from the
transceiver
When the RS-MS1I is started on the iOS device, you
can connect to the device from the transceiver.

LLWhen using the ST-4001I application, the transceiver
and Android device are automatically connected while
transferring a picture.

Step 1. Starting the RS-MS1I
Touch the RS-MS1I to start.

[MENU] > SET > Bluetooth Set > Pairing/Connect
1.	
2.	
3.	
4.	

Push [MENU].
Select “Bluetooth Set” in the SET menu.
Select “Pairing/Connect.”
Select the iOS device name displayed in the
pairing list.
5.	 Select “YES.”
•• Displays “MMM Connecting...”
(“MMM” is the Bluetooth name of the iOS device.)

(iOS device)

LLSee page 17-6 for details on downloading the RS-MS1I.

Step 2. C
 onnecting to the transceiver

(iOS device)
1.	 Touch “Other.”
2.	 Touch “Bluetooth Connection.”
3.	 Touch the displayed transceiver Bluetooth unit’s
name to connect.

LLOn the PAIRING/CONNECT screen, “
displayed on the data device icon.

•• Starts to connect.
LLWhen your call sign has not been entered in the
transceiver, enter it before you connect.
LLIf the connection has been made, the transceiver
displays “MMM Connected.,” and the Bluetooth icon
is displayed.

Displayed

LLOn the PAIRING/CONNECT screen, “

” is displayed.

Device name
Displayed while connecting
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